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Welcome

This chapter provides information about the TX3 suite of building access system
panels. It introduces these systems, describes typical user and administrator
sessions and presents the requirements on how to begin configuring each system
for the entire TX3 suite.
Note:

Mircom periodically updates panel firmware and software to add
features and correct any minor inconsistencies. For information
about the latest firmware or software visit the Mircom website at
www.mircom.com.

This chapter explains
•

Introducing the TX3 Suite

•

TCP/IP Ports

•

TX3 Features

•

Touch Screen Features

•

Physical Architecture

•

Administrator’s Responsibilities

•

Firmware and Software Compatibility

•

About This Manual

•

Contact Us
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1.1

Introducing the TX3 Suite
The TX3 product suite consists of access control panels (Telephone Access,
Card Access, Aperio Door Controller and Touch Screen) and the TX3
Configurator software. The Telephone and Card Access Systems are the
traditional keypad and card access type of entry systems. The Aperio Door
Controller System interfaces with Aperio wireless hubs and locksets to provide
card and keypad access.
The Mircom Touch Screen (also referred to as Touch Screen) is part of the
Mircom suite of products that provide building-ready monitoring, control and
software management solutions for use in the high end multi-tenant residential
market.
The Touch Screen system addresses the need within today’s multi-tenant
residential market for an easy-to-use tenant access system. Touch Screen creates
an aesthetically pleasing high quality personalized communication system
between residents and their visitors in a multi-unit dwelling establishment.

1.1.1

Configurator Software
The Configurator is a PC based user friendly graphical application that lets you
configure the Telephone Access, Card Access and Touch Screen Systems.
This manual provides the administrator with information about the use and
configuration of the TX3 product suite, and explains how to configure various
components for a new system, including the modification of an existing system.
This manual describes the operation and configuration for the following TX3
Telephone Access, Card Access, and Touch Screen Systems:
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•

TX3-120C (Paper directory telephone entry system)

•

TX3-120U (Paper directory telephone entry system, universal series)

•

TX3-200-8C (8x20 LCD Telephone Access Panel, 200 names)

•

TX3-1000-8C (8x20 LCD Telephone Access Panel, 1000 names)

•

TX3-2000-8C (8x20 LCD Telephone Access Panel, 2000 names)

•

TX3-200-8U (8x20 LCD Telephone Access Panel, universal series, 200
names)

•

TX3-1000-8U (8x20 LCD Telephone Access Panel, universal series,
1000 names)

•

TX3-2000-8U (8x20 LCD Telephone Access Panel, universal series,
2000 names)

•

TX3-200-4U (4x20 LCD Telephone Access Panel, 200 names)

•

TX3-1000-4U (4x20 LCD Telephone Access Panel, 1000 names)

TX3 Configuration and Administrator Manual
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•

TX3-2000-4U (4x20 LCD Telephone Access Panel, 2000 names)

•

TX3-120C-A/C (IP capable paper directory telephone entry system)

•

TX3-120U-A/C (IP capable paper directory telephone entry system,
universal series)

•

TX3-200-8C-A/B/C (IP capable 8x20 LCD Telephone Access Panel, 200
names)

•

TX3-1000-8C-A/B/C (IP capable 8x20 LCD Telephone Access Panel,
1000 names)

•

TX3-2000-8C-A/B/C (IP capable 8x20 LCD Telephone Access Panel,
2000 names)

•

TX3-200-8U-A/B/C (IP capable 8x20 LCD Telephone Access Panel,
universal series, 200 names)

•

TX3-1000-8U-A/B/C (IP capable 8x20 LCD Telephone Access Panel,
universal series, 1000 names)

•

TX3-2000-8U-A/B/C (IP capable 8x20 LCD Telephone Access Panel,
universal series, 2000 names)

•

TX3-200-4U-A/B/C (IP capable 4x20 LCD Telephone Access Panel, 200
names)

•

TX3-1000-4U-A/B/C (IP capable 4x20 LCD Telephone Access Panel,
1000 names)

•

TX3-2000-4U-A/B/C (IP capable 4x20 LCD Telephone Access Panel,
2000 names)

•

TX3-CX (Dual Card Reader)

•

TX3-CX-2(K)-A (IP capable Dual Card Reader)

•

TX3-CX-1 and TX3-CX-1NP (IP capable Single Door Controller)

•

TX3-ER-8 (Elevator Restriction Unit)

•

TX3-ER-8-A/B (IP capable Elevator Restriction Unit)

•

TX3-TOUCH-F15, TX3-TOUCH-S15, TX3-TOUCH-K15 (15 Inch
Touch Screen Terminal)

•

TX3-TOUCH-F15-A/B/C/D, TX3-TOUCH-S15-A/B/C/D (IP capable
15 Inch Touch Screen Terminal)

•

TX3-TOUCH-F22(-C/D) and TX3-TOUCH-S22(-C/D) (IP capable 22
inch Touch Screen Terminal)

•

TX3-CX-A8 (Aperio Door Controller Panel)

•

TX3-2000-8K-A: 8 line Voice Entry panel, Kiosk style mount for 2000
names

TX3 Configuration and Administrator Manual
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1.1.2

ADC and NSL Capability
Touch Screen and the Telephone Access System support full ADC and NSL
telephone connectivity for a single panel or a networked system of panels. A
single panel supports up to five ADC and/or NSL telephone lines.
An ADC connection requires a dedicated subscriber telephone line service
connected to an outside telephone line. This connection lets the visitor call the
tenant and access their voice mail.
An NSL type connection uses the existing building telephone lines for
communication and does not require an outside telephone line. The NSL units
intercept all telephone lines into the building’s suites and communicate directly
to the resident phone. This connection lets the visitor call the tenant and access
their voice mail and call waiting.

1.1.3

1.1.4

Card Formats Supported by the Card Access and Aperio Systems
•

26-bit Wiegand SIA

•

32-bit CSN

•

34-bit Awid

•

35-bit HID corporate 1000

•

35-bit Indala

•

36-bit HID Simplex

•

36-bit Keyscan C15001

•

37-bit Cansec

•

37-bit HID 10304

•

37-bit Mircom

•

39-bit Kantech XSF

•

50-bit RBH

Other Controllers
Mircom devices such as the Card Access Controller, the Lobby Control Unit, and
the Touch Screen can be networked with the TX3 system through a peer-to-peer
RS-485 network, an Ethernet TCP/IP network, or a combination of Ethernet and
RS-485 networks.
The TX3 Configurator software can connect to any of these network
configurations. How you connect to the network (that is, through TCP/IP, USB,
a modem, or the COM port) determines what devices you can configure on the
network using the TX3 Configurator. The different network configurations are
explained in the rest of this section.
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Figure 1 shows a configuration with TX3 controllers connected on an RS-485
network. Each controller has to have a unique network address on the RS-485
network. Up to 63 unique network addresses can be assigned. If you connect to
any device on the RS-485 network (using USB, a modem, or the COM port), you
can also connect to and configure any other device on the RS-485 network using
the TX3 Configurator.
Lobby Control Unit

Elevator Restriction Unit

Card Access Controller
Card Reader A

1

4

GHI

7

2

ABC

5

JKL

8

3

DEF

6

MNO

9

PQRS

TUV

WXYZ

*

0

#

Card Reader B

RS-485 Network

Figure 1.

TX3 devices on an RS-485 network

Figure 2 shows a configuration with TX3 devices connected to an Ethernet TCP/
IP network. This configuration removes the 63 device limitation that you have on
an RS-485 network. The devices connected to an Ethernet TCP/IP network are
called Main Nodes. If you connect to the TCP/IP network with the TX3
Configurator, you can connect to and configure any of the Main Nodes on the
Ethernet TCP/IP network. If you connect directly to one of the Main Nodes using
USB, a modem, or a COM port, you will be able to configure that device but not
any other device.
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Lobby Control Unit
(Main Node)

Lobby Control Unit
(Main Node)

1
1

2

ABC

3

5

JKL

GHI

6

8

2

5

JKL

3

DEF

6

MNO

MNO

7

7

ABC

DEF

4

4

GHI

9

PQRS

TUV

WXYZ

*

0

#

8

9

PQRS

TUV

WXYZ

*

0

#

Ethernet Network

Card Reader A

Card Access Controller
(Main Node)

Figure 2.

Notes:

TX3 devices connected to an Ethernet TCP/IP network

In order for a panel to be a Main Node it must satisfy the following
conditions.
•
It must be IP capable. Panels that are IP capable are usually
denoted by a letter such as -A, -B, -C or -D at the end of their
model names.
•

16

Card Reader B

If the panel is not a Touch Screen, it must have a TX3-IP IP
Module installed.
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Figure 3 shows a configuration with TX3 devices connected on both an Ethernet
TCP/IP network and on RS-485 subnetworks. Devices connected to a Main
Node’s RS-485 subnetwork are Secondary Nodes to the Main Node. Each RS485 subnetwork can have up to 63 devices connected to it; you can still have
more than 63 Main Nodes connected to the Ethernet network.

Lobby Control Unit
(Main Node)

1

4

GHI

7

2

Touch Screen
(Secondary Node)

Card Access Controller
(Secondary Node)

Card Reader A

3

ABC

DEF

5

6

JKL

MNO

8

9

PQRS

TUV

WXYZ

*

0

#

Card Reader B

RS-485 Subnetwork
Ethernet Network
Lobby Control Unit
(Main Node)

1

4

GHI

7

2

Card Access Controller
(Secondary Node)

Card Reader A

3

ABC

DEF

5

6

JKL

8

Elevator Restriction Unit
(Secondary Node)

MNO

9

PQRS

TUV

WXYZ

*

0

#

Card Reader B

RS-485 Subnetwork

Figure 3.

TX3 devices connected to a combination Ethernet TCP/
IP network with RS-485 subnetworks

If you connect to the Ethernet TCP/IP network with the TX3 Configurator, you
can configure any of the nodes in this configuration. If you connect directly to a
device using USB, a modem, or a COM port, you will only be able to configure
devices that are on the same RS-485 subnetwork as that device.
Note:

There can only be one Main Node on an RS-485 subnetwork. That
is, you cannot connect one RS-485 subnetwork to another RS-485
subnetwork. However, if you want to connect to a Touch Screen
panel remotely over the Internet (for instance, to enable the
advertising module), the Touch Screen panel must be set as a Main
Node even if there is no Secondary panel connected to it.
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1.2

TCP/IP Ports
Section 1.1.4 on page 14 describes the options available for networking together
more than one TX3 panel, which include TCP/IP networks. In order for your
TX3 system to communicate over a TCP/IP network, the following ports must
be available for the TX3 system.
Touch Screens: 8080
Non-Touch Screens:
•

14000

•

14001

•

14002

•

14003

If you are using a TCP/IP network and your TX3 system is not communicating
properly, there may be another program on the network using ports 8080 or
14000-14003. In this case, configure the other program to use a different range of
ports.

1.3

TX3 Features
Features of the TX3 product suite include:
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•

An aesthetically pleasing high quality personalized communication
system between residents and their visitors

•

Building ready access control system with full software management in a
user friendly graphical touch enabled interface

•

Easy configuration and customization of tenant access

•

Provisions for postal lock and camera

•

Multilingual Display and Voice Greeting (English, French-Canadian and
Spanish) that provides instructions on how to use the Touch Screen

•

Concierge/Security Desk/Call Reception capability

•

Supports both Auto Dialer (ADC) and NSL

•

Ability to network panels together (peer-to-peer) through RS485,
Ethernet TCP/IP, or both

•

Hands free, full duplex communication

•

Flexible one to four digit resident dial codes

•

Dials up to 18 digit telephone numbers

•

Schedule based call restrictions provide more security and flexibility

TX3 Configuration and Administrator Manual
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1.4

•

System can be configured locally using the Configurator

•

Remote desktop configuration from any location using the Configurator

•

Upload/download configuration files without taking the whole system
off-line

•

Records a maximum of 5000 event logs

Touch Screen Features
The Touch Screen includes the following additional features:

1.4.1

•

Full color Touch Screen display

•

Stainless steel front panel

•

150 Watt stereo sound system

•

Ability to play advertisements

•

Ability for visitors to email residents

Touch Screen Applications
The Touch Screen is a user friendly graphical application that provides one-toone customization of tenant access by enhancing the building entry experience
and creating a truly personalized session. The Touch Screen graphical interface
includes the ability to provide tenants and guests with specific advertisements
and messages, making it an extremely valuable marketing and notification tool.
As part of Mircom’s design theme and strategy for the high rise building market,
a visitor at the Touch Screen sees a series of institution defined advertisement
and promotional messages. These messages form the basis for the personalized
visitor session.
The entire building experience is personalized at the Touch Screen based on
preferences and marketing campaigns defined by the building management. The
personalization includes:

1.5

•

Setting eligible functions and tenant accessibility codes

•

Permitting user access and options

•

Changing the look and feel of the user interface

Physical Architecture
The TX3 Configurator lets you connect a single panel or an entire network of
panels, displaying images of every panel on your site in the Job tree.
You are able to assign additional panels using the Configurator to recognize

TX3 Configuration and Administrator Manual
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and receive data from other panels on your network.
The modular architecture of the TX3 system allows for a flexible, scalable and
customized application, and is determined by the number of building access
points, expected traffic, number of residents, volume of communications,
concurrent connections and Touch Screen placement.
The network architecture is determined by the expected resident traffic, number
of residents, volume of transactions, concurrent connections and network
capacity. The components of TX3 system, networked together, allows
communication and interaction with the building infrastructure.
By default, Touch Screen is configured with the Telephone Access System
Panel.

1.6

Administrator’s Responsibilities
Warning! In order to keep the TX3 system secure,
follow these precautions:
Change the default password on the Touch Screen to
prevent strangers from accessing the configuration. See
section 2.6 on page 32.
Perform a virus scan on all picture and video files before
importing them into the Touch Screen.
Secure the TCP/IP network to prevent unauthorized access
to the Touch Screen.
Do not forward the Remote Desktop port of the Touch
Screen to the Internet.
The software lets you configure and monitor activities of all controllers
connected to the TX3 network. The administrator is responsible for the
configuration of the TX3 system, Touch Screen, Configurator and all of the
related components.
When logged in as an administrator all of the following configurable functions
are available:
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•

User interface appearance

•

Advertisement content

•

Support for panel functionality with the capability to interface to other
devices - the software fully integrates with the TX3 line of products
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The administrator accesses the administrator mode from the TX3 Configurator
software and has full rights to every function within the software. The
administrator performs many of the administrative tasks required for installing
and managing the software, including assigning permissions for each level of
user. Touch Screen personalization depends on preferences defined by the
building management. Additional responsibilities may be provided by the
building manager.
The Configurator software has five password protected user levels. The system
administrator accesses and configures all panels and devices connected to the
panels, and sets up user levels. Users are limited to specific responsibilities such
as adding or removing resident names or defining schedules.
The administrator is responsible for:

1.7

•

modifying user interface appearance

•

providing advertisement content

•

adding new tenants

•

system configuration

•

monitoring the operational health of the system

•

assigning user privileges

Firmware and Software Compatibility
•

The job can have a mix of panels with 3.4.x and 2.4.x versions of firmware
as long as the Configurator is 2.8.13 or higher. (Firmware versions 3.4.x
and 2.4.x introduced floor groups.)

•

A panel with version 3.5.x is compatible with other panels with version
3.5.x as long as the Configurator is version 2.9.11 or higher. (Firmware
version 3.5.x introduced enhanced correlations.)

•

If the job has a card access panel with version 3.6.x, then the other panels
can have either version 3.6.x or version 3.5.x as long as the Configurator is
version 2.10.3 or higher. (Firmware version 3.6.x introduced custom card
formats.)

•

If the job has no Elevator Restriction Units, then it can have a mix of
versions 3.7.x, 3.6.x, and 3.5.x, as long as the Configurator is version
2.12.12 or higher.

•

If the job has Elevator Restriction Units, and one panel in the job has
version 3.7.x or higher, then all panels in the job must have version 3.7.x
or higher, and the Configurator must be version 2.12.12 or higher.

•

TX3-ER-8-A can be upgraded to 3.7.x firmware, but ERU 2.0 features
such as schedules are not available.
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1.8

About This Manual
This manual provides comprehensive information on the use of the TX3
Configurator by the administrator and explains how you may add additional
components and modify and delete existing ones.
This manual assumes that all TX3 system components are setup and operational.
Chapters 1 to 2 provide general information about the TX3 systems.
Chapters 3 to 13 provide comprehensive information on the use of the Touch
Screen and Configurator software.

1.8.1

Additional Documentation
For a description on how to install the Configurator software see LT-973
Configurator Quick Start manual.
For additional documentation, see the following Mircom literature:
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•

LT-968 TX3 Telephone Access System User’s Guide

•

LT-969 TX3 Telephone Access System Installation and Operation
Manual

•

LT-996 TX3 Touch Screen Installation Manual

•

LT-6906 UL Listed TX3-CX Card Access System Installation Manual

•

LT-1160 TX3-CX-A8 Aperio Interface Panel Installation and Operation
Manual

•

LT-6618 TX3-CX-1 Installation Manual

•

LT-5997 TX3-CX-1NP Installation Manual

•

LT-9940 TX3 Elevator Restriction Installation Manual

•

LT-6616 Elevator Restriction Migration for Firmware Version 3

•

LT-6615 Elevator Restriction Migration for Firmware Version 2

•

LT-600213 IP Telephony Guide

•

LT-6638 MiEntry Manual

•

LT-6082 Unified Building Solution Administration Guide

•

LT-1194 TX3 Nano Configuration Manual
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1.9

Contact Us

1.9.1

Canada and USA
Phone: 905-660-4655
Toll Free: 1-888-660-4655
Fax: 905-660-4113

1.9.2

International
Phone: 905-660-4655

1.9.3

Website
http://www.mircom.com
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2

Getting Started

This chapter explains
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•

PC System Requirements

•

Installation

•

Logging into the TX3 Configurator in Administrator Mode

•

Changing the Language

•

Main Window Components

•

Changing the Touch Screen Administrator Password

•

Changing the TX3 Configurator Password

•

Resetting your Password

•

Assigning Configurator User Privileges

•

Job Tree

•

Configuring a Job

•

Importing Residents and Cards

•

Upgrading Firmware

•

Logging into the Touch Screen Terminal

•

Saving Touch Screen Log Files

•

Upgrading the Touch Screen Software

•

Shutting Down the TX3 Touch Screen
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2.1

PC System Requirements
For the PC based Configurator version 2.10.3 and higher, the minimum system
requirements are:

2.2

•

Windows 10 Pro (32-bit and 64-bit)

•

Windows 10 Home (64-bit)

•

Windows Server 2016 (64-bit)

•

Windows 8.1 Pro (64-bit)

•

Windows 7 Pro (32-bit and 64-bit)

•

1 GB RAM

•

1.8 GHz CPU

•

600 MB disk space

•

1 USB port

Installation
To install the Configurator
1.

From the USB flash drive root directory run TX3-Config and follow the
instructions.
The TX3 Configurator icon appears on the desktop.

2.3

Logging into the TX3 Configurator in
Administrator Mode
The PC connects to the Telephone Access and Card Access Systems with one of
the following methods:
•

a USB cable from the computer to the TX3 controller board

•

an Ethernet TCP/IP connection (the controller must have an IP module)

•

a modem connection (the controller must have a modem module)

As an alternative, the PC also connects to the controller board modem. The TX3
system is compatible with the following modems.
•

TrendNet TFM-560U High Speed USB 2.0 Fax Modem

•

TrendNet TFM-561U High Speed USB 2.0 Fax Modem

•

Hiro H50113 56K V.92 USB Fax Modem
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•

StarTech USB56KEM2 56k V.92 USB Fax Modem

•

Zoom 56K V.92 56K USB Mini External Fax Modem

•

USRobotics USR5639 56K USB Softmodem

See Chapter 5 for a description of the Telephone Access System and Chapter 6
for a description of the Card Access System.
To log in to a controller
1.

2.

Establish a connection from the PC to the controller using one of the
following methods:
•

a USB connection

•

COM port connection

•

a modem connection

•

a connection to the controller’s Ethernet TCP/IP network

Double click the TX3 Configurator icon.
The administrator access code window appears.

Figure 4.

3.

User Login window

Enter your username and password to log in to the system and click
Login (by default the user name is administrator and with no password).
If you forgot your password, see section 2.8 on page 34.

2.4

4.

The Main Window appears.

5.

Proceed with the rest of the configuration or click Send and Exit
from the Tool Bar to apply the settings and exit the session.

Changing the Language
1.
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Click Tools. then click Select Language.
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2.

In the Select Language window, choose the new language, then click OK.

3.

Click Yes.
The TX3 Configurator restarts.

2.5

Main Window Components
The Configurator Main Window lets you access all configurable functions and
consists of the following major areas:
A.

Menu Bar

B.

Tool Bar

C.

Left Pane

D.

Mode Selection

E.

Right Pane

F.

Status Bar

G.

Lower Pane

A
B

F
C

G
D
E
A. Menu Bar B. Tool Bar C. Left Pane D. Mode Selection E. Status Bar F. Right Pane G. Lower Pane

Figure 5.

Main Window Administrator Workspace
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2.5.1

Menu Bar
The Menu Bar lets you access all major Configurator features and consists of the
following six menus:
File Menu
The File Menu lets you setup and define Jobs using the following commands:
New Job. Creates a new Job by selecting a template, copying a current Job or
reading panels from the network. From the template you can select the basic
Touch Screen, Telephone Access or Card Access system.
Open Job. Opens or deletes an existing Job from the database.
Validate Job. Checks if the current Job has any configuration errors. This
operation is done automatically before a Job is sent to the panels.
Backup. Defines the location of the backup folder for a Job. The Backup button
in the Tool Bar uses this location for backing up files.
Restore. Restores user specified Jobs from a folder.
Import. Imports a spreadsheet of names or cards.
Send and Exit. Sends the Job to the TX3 Unit and exits out from the
Configurator.
Exit without Send. Does not send any changes made to the Job and exits out
from the Configurator.
Shut Down.
Shut Down. Exits from the Configurator and shuts down the entire TX3
Unit
Restart. Logs out the current user and restarts the PC.
Exit to Windows. Closes the TX3 software and exits to the Windows
environment.
Edit Menu
The Edit menu lets you add, edit and delete panels and components using the
following commands:
Add Panel. Adds panels to the network.
Add Residents. Adds one or more residents to the Job.
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Add Cards. Adds one or more cards to the Job.
Edit Residents. Edits the currently selected residents.
Edit Cards. Edits the currently selected cards.
Delete. Deletes the currently selected items. It could be a panel item on the Job
tree, a resident record, or a card record.
Panels Menu
The Panels menu lets you activate panel functionality using the following
commands:
Connect. Connects to the communication port specified on the Network View as
well as establish connections with the panels currently configured on the
network.
Send Job. Sends the current Job to all panels currently configured on the
network.
Get Job. Gets the Jobs from all panels currently configured on the network.
Firmware Upgrade. Upgrades the firmware of the selected panel.
Network Firmware Upgrade. Upgrades the firmware of multiple panels
connected in a network from a connection to any panel on that network.
Reports Menu
The Reports menu lets you generate reports on events, residents and access cards
using the following commands:
Event Log. Generates an event log report from the database. This report shows in
a preview window and can be printed or exported to files in either Excel or PDF
format.
Residents. Generates a resident report from the database. This report shows in a
preview window and can be printed or exported to files in either Excel or PDF
format.
Access Cards. Generates an access card report from the database. This report
shows in a preview window and can be printed or exported to files in either Excel
or PDF format.
Paper Directory Report. You can a paper directory that you can display on a
panel (for instance TX3-120C-A).
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Advertising Report. This option is available for the TX3 Touch. Generates an
advertising report from the database. This report can be previewed, printed or
exported to either Excel or PDF formats.
Tools Menu
Tools menu lets you change passwords and set user privileges using the
following commands:
Change Password. This option allows the user to change the password for the
current user.
User Management. This menu item is available only on the Configurator
software to users who have the User Administration access right. Selecting it
launches the User Management dialog. Use this dialog to add or remove system
users, reset their passwords, and modify access rights. A system user is the
person who uses this software application, not a resident or card holder.
Select Language. Allows you to change the language of the Configurator.
Purchase Advertising Module. This option is available for the TX3 Touch. To
activate the advertising module select this option. For more information refer to
section 4.6 on page 106.
IP Change Tool. See section 3.2 on page 73.
Alert Setup. See section 12.2 on page 276.
Firmware Upgrade Wizard. See section 2.13.2 on page 49.
Help Menu
Help menu provides you with information about the Configurator using the
following commands:
Help Topics. Displays the help content. Pressing the F1 key displays context
sensitive help.
About. Displays the About box of the software. The about box displays
information such as version number of the software and copyright notice.

2.5.2

Tool Bar
A list of ten buttons are available below the Menu Bar for quick access.

Figure 6.
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Tool Bar
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New. Opens the Create New Job Form to create a new Job.
Open. Opens or deletes an existing Job from the database.
Backup. Backs up the current Job to a file in the pre-defined backup folder. The
backup folder location is defined in the Backup File Menu in the Menu Bar.
Add Residents. Opens the Add Residents Form to add one or more resident
records to the system.
Add Cards. Add Cards lets you add one or more cards to the system
Connect. Connects to the panels on the network.
Send. Sends the current Job to the panels on the network.
Get. Retrieves the Job from panels on the network.
Send and Exit. Saves the system information and sends it to the panel, and exists
from the configuration mode to display the Touch Screen user interface. This
button is available only on the Touch Screen Configurator software.
Help. Opens help file.

2.5.3

Left Pane and Mode Selection
The Left Pane displays the currently selected function from one of the following:

2.5.4

•

Configuration

•

Monitoring

Right Pane
The Right Pane displays the view associated with the selected Job tree item.

2.5.5

Lower Pane Online Events
The Lower Pane online events displays all events received by the software.
Events may be initiated by the panels or by the software. Only user activity is
logged to the event log.
The view has the following columns:
Time. Time stamp of the event.
Event Description. Description of the event.
Panel. Panel name this event applies to.
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2.5.6

Status Bar
The Status Bar displays status information such as the operation progress and
username.

2.6

Changing the Touch Screen Administrator
Password
The Touch Screen administrator password lets you access the Touch Screen
configuration if required, and prevents others from making changes to the Touch
Screen. By default this password is blank.
Note:

With Touch Screen software 2.9.10 and above, when you change
the Touch Screen administrator password, the system uses the same
password for Remote Desktop (section 4.2 on page 89).

To change the Touch Screen administrator password
Note:

Whenever you change the Touch Screen administrator password on
a Touch Screen Main Node, you must make the same change to
Admin Password for that Touch Screen Main Node in the TX3
Configurator. See section 4.7.5 on page 124.

1.

Log in as administrator at the Touch Screen either at the Touch Screen
terminal (section 2.14 on page 59) or by using Remote Desktop (section
4.9 on page 133).

2.

Select Tools > Change Password.
The Change User Password window appears.

Figure 7.
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Change User Password
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2.7

3.

Enter your old password into the Old password text box. If you have
not changed the password before, then leave this box empty (there is no
default password).

4.

Enter a password of 16 characters or less into the New password text
box.

5.

Enter the same password into the Verify new password text box.

6.

Click OK.

Changing the TX3 Configurator Password
You can create multiple user accounts with different privileges for the TX3
Configurator (see section 2.9 on page 35). The name of the current user appears
in the lower right corner of the Configurator window.

Figure 8.

Note:

Lower right corner of Configurator window showing
current user

This password is not the same as the Touch Screen administrator
password (section 2.6 on page 32).

To change the password for the current user in the TX3 Configurator
1.

In the TX3 Configurator, select Tools > Change Password.
The Change User Password window appears.

Figure 9.

2.

Change User Password

Type your old password into the Old password text box.
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2.8

3.

Type a password of 16 characters or less into the New password text
box.

4.

Type the same password into the Verify new password text box.

5.

Click OK.

Resetting your Password
1.

On the User Login window, click Forgot Password.

Figure 10.

User Login window

The Forgot Password window appears.

Figure 11.

2.
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Forgot Password

Contact Mircom Support and provide the information shown. Mircom
Support will give you a temporary password. This password is valid only
for the day on which it is generated. You can log in with this temporary
password, and then change your password.
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Assigning Configurator User Privileges
Assigning User Privileges is a Configurator feature that lets you define different
user levels. Once users are defined, system administrators can further organize
them to effectively manage the building.
The system administrator assigns privileges to a particular subordinating level of
user using the User Management window. Only the system administrator is able
to set user levels, add or remove various system users, reset their passwords and
modify access rights.
The various user levels consist of the following:
Operator. An operator has read access only. An operator can monitor live events
and accept access point requests.
User. A user has all of the rights of the operator plus additional reading and
writing card and resident records privileges.
Advanced User. An advanced user has all of the rights of user plus the ability to
read and write schedules, holidays and access levels.
Manager. A manager has all of the rights of an advanced user plus user
management privileges.
System Administrator. The system administrator can access and configure all
panels and devices connected to the panels, and set up security levels.
Note:

When logging in to a particular user level, only information
relevant to your assigned role will be available.

To assign a user
1.

From the Menu Bar click Tools > User Management.
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The User Management window appears.

Figure 12.

2.10

User Management Window

2.

Enter a User name and Password for the user.

3.

Click Active to enable access rights for the user.

4.

Select a user level from the User Level drop down list.

5.

Click OK to save the information and return to the previous window, or
click Cancel to exit without saving the changes.

Job Tree
The Job tree lists all networked components, such the Telephone Access and
Card Access Systems, and provides a list of options to let you add, modify and
delete these configurable components and their characteristics. Job is the
industry-standard term for this type of system.
The Configurator uses a centralized approach to continuously assess the state of
every panel and connected components. This avoids the need for continuous
administrator supervision and facilitates the task of complex configuration of
every system component. The Job tree further simplifies configuration by
providing an overview of the system by listing each configurable item.
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Start the configuration by getting familiar with all of the existing networked
components. Selecting a Job tree node displays its corresponding details on the
Right Pane.

Figure 13.

2.10.1

Job Tree

Job Tree Elements
When Telephone Access and Card Access Systems are on the network, the Job
tree contains the following elements:
Note:

Right clicking anywhere in the Left Pane lets you add, delete or
send configuration changes to a single panel.

Job. Displays the Job Detail Configuration view. A Job consists of networks and
their components, such as Telephone Access Systems and Card Access Systems.
Network. Displays the Network Configuration view and consists of networked
components, such as Telephone Access Systems and Card Access Systems. All
connected panels are listed by their network address.
Panel. Displays the Panel Configuration view.
Panel/Access Points. When card access panels are added to the Job file, the
panel access points and card readers are displayed.
Panel/Inputs Outputs. Displays the input and output points of the panel. Inputs
and outputs are labelled, assigned and defined.
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Panel/Correlations. Displays the panel Correlation view. Correlations let you
establish an action with an event.
Residents. Displays the Resident List view. Adding a Telephone Access System
panel for the first time to the network establishes the Resident List view.
Cards. Displays the Card List view. Adding a card access panel for the first time
to the network establishes the Card List view.
Access Levels. Displays the Access Levels view. Adding a card access panel for
the first time to the network establishes the Access Levels view.
Schedules. Displays the system and user defined timetables.
Holidays. Displays the Holiday schedules.

2.11

Configuring a Job
The Configurator lets you change panel and device properties. Configure items
individually or sequentially by going through each item from the top to the
bottom of the Job tree.
Configured Jobs may be manually validated for any errors, or automatically
validated when sending a Job to the panels.
Configuration information can be sent to individual or multiple panels.
Selecting an item displays that item’s properties in the Right Pane.
By default the Configurator displays the most recently opened Job and network
configuration.

2.11.1

Creating a new Job
Creating a new Job may be done by directly adding components, by making
modifications to templates or by using information read from the network.
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To create a new Job
1.

Select File/New Job from the Menu Bar or New from the Tool bar. The
Create New Job window appears.

Figure 14.

2.

Create New Job

Enter the following parameters about the Job:
Job name. Enter the Job name. This entry must be unique.
Description. Provide a description about the Job. This field is mandatory.
Created by. This field is read only and is set to the user when they log in.
Create from a template. Select from an existing template. From this
template you may add or modify components.
Copy from current Job. Select this option to copy information from the
current Job. From the copy you may add or modify components.
Create by reading panels on the network. Select this option to have the
Configurator automatically retrieve information from all of the networked
panels and components. To use this option you must be connected to the
network.

3.

Click OK to create the new Job and return to the configuration window, or
click Cancel to exit without saving the changes.
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To provide details about Job modifications
1.

Select Job from the Left Pane. The Job Details appears on the Right Pane.

Figure 15.

2.

Provide a description about the Job in the Description text area.

3.

If you have the Configurator version 2.0.0 or later, select Enable long
names to allow TX3 Touch Screens to display names up to 60 characters
long.

4.

Enter a location for the job under Location.

5.

Under Time Zone, select your time zone and select Use daylight
saving time if necessary. When you send the job to the panels, the
panels’ clocks will be adjusted according to this time zone.

Note:

2.11.2

Job Detail Configuration

If the job has Enable long names selected (see section 2.11.1
on page 38), then the names are shortened to the first 15 characters
when you get the job. If you want to preserve the long names, do not
use Get Job.

Opening an existing Job
You may open a stored Job and can change existing configurations. These
changes are immediately saved to the database.
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To open an existing Job
1.

To open an existing Job, select File/Open Job from the Menu Bar. The
Open Job window appears.

Figure 16.

2.

Open Job

Select a Job and click OK, or click Close to exit without saving the
changes.

To delete an existing Job

2.11.3

1.

To delete a Job permanently from the database, select the Job from the list
and click Delete. A confirmation window appears.

2.

Click Yes to confirm the deletion or No to exit and return to the previous
window.

Backing up a Job
To backup a Job you must first define the location of the backup folder. You may
back up Jobs and event logs to this folder. Backup files have the extension .t3.
To backup a Job
1.

Select File/Backup from the Menu Bar.
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The Backup Jobs window appears.

Figure 17.

2.

Backup Jobs

Enter the following parameters about the Job:
Backup all jobs. Select this option to back up all Jobs in the database to
the backup folder.
Backup current Job only. Select this option to back up only the current
Job to the backup folder.
Include event logs. Select this option if the event logs are to be backed up
as well.
Folder to store backup files. Select a folder to store the backup files.

3.

Click Backup Now to back up all jobs or the current job, depending on
which option you selected.

To set up an automatic backup
If you enable automatic backups, the Configurator automatically backs up all
jobs ever day at the time that you specify. The backups are deleted after the
number of days that you specify.
Note:

1.
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Automatic backups are saved in the same directory that the
Configurator is installed in. By default the location is:
C:\Program Files (x86)\Mircom
Technologies\TX3 Configurator\Backup
This location cannot be changed.
Select File/Backup from the Menu Bar.
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2.

Click Auto Backup to set up an automatic backup.

Figure 18.

3.

Auto Backup

Enter the following parameters:
Auto Backup. Select this option to enable an automatic backup.
Daily. Select the number of days that the backup will be stored for. For
example, if you select 10, then the Configurator keeps back ups for the
past 10 days. Backups older than 10 days are deleted.
Starting Time. Specify the time of day when the Configurator should
make the backup.

4.

Click OK.
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2.11.4

Restoring a Job
You can restore previously saved Jobs.
To restore Jobs
1.

Disconnect from the network and select File/Restore from the Menu
Bar. The Job Restore window appears.

Figure 19.

2.

Note:

Select Job File to Restore

Select one or more backup files to restore. Backup files have the .t3
extension.
Restore will overwrite open Jobs with the same name.
Consequently, saving this Job will overwrite the Job with the same
name in the database.
The main Job file has the extension .t3, and other associated files
have the extension .tx3. These .tx3 files must be in the same
folder as the .t3 file.

3.

2.11.5

Click Open to restore the Job or Cancel to exit and return to the previous
window.

Validating a Job
The Configurator automatically validates a Job when it is sent to the panels, but
you have the option to manually validate a Job before sending it to the panels.
To validate a Job
1.
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Click File > Validate Job. If there are any errors, an error message
will appear.
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2.

2.11.6

If there are no errors, click Send and Exit from the Tool Bar to apply
the settings and exit the session.

Sending Jobs to Panels
There are two ways to send a Job to a panel. Once panel connectivity is
established, you can send the current Job configuration to an individual panel by
clicking Send to Single Panel or to all panels by clicking Send Job to
Panels.
To reduce programming time, the Configurator determines the minimal set of
configuration changes to send. Sending a Job to all panels only sends the
individual changes. For example, modifying a resident record sends only that
record to the panel.
Sending a Job to a single panel sends all of the configuration information to that
panel including any modifications.
The Configurator does not send the entire configuration to a panel unless:
•

the user has modified the configuration from the front panel or

•

a new panel is added to the Job

To send to all panels
1.

Click Send from the Menu Bar.

2.

Proceed with another configuration or click Send and Exit from the
Tool Bar to apply the settings and exit the session.

To send to a single panel

2.11.7

1.

Right click on a panel in the Job tree and select Send to Single
Panel.

2.

Proceed with another configuration or click Send and Exit from the
Tool Bar to apply the settings and exit the session.

Getting Jobs
When retrieving a Job, the Job tree reads information directly from the panels
currently connected to the network and adds panels to the Job automatically.
Panels do not store the user profile information. In these cases panels use default
information. For a description of user profiles see section 5.5 on page 160 and
section 6.7 on page 192.
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To get a Job
Note:

If the job has Enable long names selected (see section 2.11.1
on page 38), then the names are shortened to the first 15 characters
when you get the job. If you want to preserve the long names, do not
use Get Job.

Note:

After you get a job, residents’ email addresses will be blank. If you
want to preserve email addresses, do not use Get Job.

1.

Select Get from the Tool Bar. The Get Job from Panels window appears.

Figure 20.

2.

Get Job From Panel

Select the following parameters:
Create a new job by reading from panels. Scans the network for panels
and uses their configuration information to create a new Job. The Scan
network to detect new panels check box is automatically
checked.
Create a new job by reading from panels defined in current job.
Copies the current Job and creates a new Job based on the existing Job. If
Scan network to detect new panels is checked, new panels
information is also retrieved.
Update current job by reading from panels defined in current job.
Overwrites the existing information with the retrieved panel information.
Scan network to detect new panels. If selected the software scans the
network for any new panels and reads their configurations.

3.
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Click OK.
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2.12

Importing Residents and Cards
You can import resident and card information from a JSON file or a Microsoft
Excel (version 97 and above) spreadsheet. The file can contain resident
information, card information, or both.
Note:

The first row in the spreadsheet must be the row header. Delete any
blank rows above the header.
In order to import residents, the job must contain at least one
telephone access panel. In order to import cards, the job must
contain at least one card access panel.

To import residents and cards
1.

Click File, then click Import.

2.

Navigate to the Excel or JSON file that you want to import, then click OK.
The Import window appears.

A

B

C

D
A. Source File B. Column Mappings C. Import Preview D. Validation Errors

Figure 21.

Import
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The left pane shows the source file. The middle pane shows the column
mappings, and the right pane shows how the data will be structured after it
is imported.
3.

In the Column Mappings pane, click the menu beside each category,
and select the column in the spreadsheet that contains the data for that
category.
For example, if the phone numbers are in a column called Telephone, then
select Telephone in the menu beside Phone Number.

4.

After you have associated the columns in the spreadsheet with the correct
categories, click OK.
The card and resident information is imported.
Errors appear in at the bottom of the middle pane, in the section labelled
Validation Errors. Cells containing errors are highlighted in the
right pane.

To correct errors

2.13

1.

Move the mouse over the highlighted cell in the right pane to see the
details of the error.

2.

Click the highlighted cell, then enter the correct information.

3.

Click OK.

Upgrading Firmware
There are 2 ways to upgrade firmware:
•

Use the Firmware Upgrade Wizard (section 2.13.2) to install firmware on
1 panel over USB. Use this method if the firmware is corrupted.
•

•
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Use the boot loader firmware file with the Firmware Upgrade
Wizard. The boot loader version has BL in the file name, for
instance TX3_IP_CA_BL_v3-4-15.bin.

Use the Network Firmware Upgrade (section 2.13.4 on page 57) to
upgrade many panels on the same network at once.
•

Use the firmware files without BL in the file names with the
Network Firmware Upgrade.

•

At least one panel on the network must have firmware version 2.0.0
or higher installed.

•

The new firmware files must be version 2.0.0 or higher.
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2.13.1

Back up the Job before Upgrading the Firmware
The firmware version number consists of three digits, for instance 3.1.26. The
first digit (3 in this case) is the major revision, and the second digit (1 in this case)
is the minor revision. When the major or minor revision changes (for instance
3.1.26 to 3.4.0), then the configuration is deleted on all the panels that are
upgraded. For this reason, back up the job before upgrading the firmware.

2.13.2

Firmware Upgrade Wizard
Use the Firmware Upgrade Wizard to install firmware on 1 panel over USB.
Go to the Mircom web site for the latest firmware.
Note:

The Firmware Upgrade Wizard does not work with TX3-CX-1
or TX3-CX-1NP. Use the Network Firmware Upgrade option in
section 2.13.4 on page 57.
Ensure the USB cable is directly connected to the USB port on the
controller.

To upgrade the firmware with the Firmware Upgrade Wizard
1.

Click Connect on the Tool Bar to connect to the panel, then click Get on
the Tool Bar to get the Job.

2.

Click the Disconnect icon in the Tool Bar.
The Configurator is disconnected from the panel.

3.

Click Tools/Firmware Upgrade Wizard from the Menu Bar.
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The Firmware Upgrade Wizard window appears.

Figure 22.

4.
Note:

5.
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Firmware Upgrade Wizard

Browse to the firmware file and select it.
The firmware file must be the boot loader version. The boot loader
version has BL in the file name, for instance
TX3_IP_CA_BL_v3-4-15.bin.
Click Next.
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6.

Follow the instructions in the Firmware Upgrade Wizard window.

Figure 23.

7.

Firmware Upgrade - Erasing Current firmware

Complete the procedure and click Next. The Program new firmware
window appears.

Figure 24.

Firmware Upgrade - Program new firmware
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8.

Click Send to send the firmware to the panel.

9.

Click Next to complete the upgrade.

10.

Follow the instructions in the Firmware Upgrade Wizard window.

Figure 25.

2.13.3

Firmware Upgrade - Running new firmware

11.

Disconnect the USB cable from the controller and connect it again.

12.

Click Connect on the Tool Bar to connect to the panel.

13.

Click Send on the Tool Bar to send the Job back to the panel.

Troubleshooting the Firmware Upgrade on a 64-bit Computer
If you have a 64-bit computer and Windows 7, 8, or 10, and the Next button on
the firmware upgrade window is greyed out, follow the instructions below.
To troubleshoot the firmware upgrade
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1.

Ensure that the TX3 controller is powered on and connected directly to the
computer with a USB cable.

2.

On the local PC, click Start, then click Control Panel, then click
Device Manager.

3.

Click the arrow to expand Ports.
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If you see a driver called Bossa, then Windows has picked the wrong
USB driver. Follow the instructions below to upgrade the driver.

Figure 26.

Device Manager showing Bossa driver

To upgrade the USB driver
1.

Right-click Bossa and click Update Driver Software.

2.

In the Update Driver Software window, click Browse my
computer for driver software.

Figure 27.

Browse my computer for driver software
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3.

Click Browse.

Figure 28.

Browse for driver software

4.

Navigate to this folder:
C:\Program Files (x86)\Mircom Technologies\
TX3 USB Drivers 64-bit\SAM-BA Firmware Upgrade

5.

Select SAM-BA Firmware Upgrade and click OK.

Figure 29.

Browse For Folder

Do you see a window saying that the best driver software is already
installed (Figure 30)?
If yes, click Close and go to step 6.
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If no, Windows installs the software. Go to step 8.

Figure 30.

6.

The best driver software is already installed

Go back to step 1 under To upgrade the USB driver on page 53 and
follow the instructions. At step 3, do not click Browse. Instead, click
Let me pick from a list of device drivers on my
computer.

Figure 31.

Let me pick from a list of device drivers
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7.

Select AT91 USB to Serial Converter and click Next.

Figure 32.

Select the device driver you want to install

Windows installs the driver software.
8.

Click Close.

Figure 33.
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Windows has successfully updated your driver
software
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9.

Verify that AT91 USB to Serial Converter appears under
Ports in the Device Manager.

Figure 34.

10.

2.13.4

Device Manager

Follow the steps in section 2.13.2 on page 49 to upgrade the firmware.

Network Firmware Upgrade
The Network Firmware Upgrade allows you to upgrade the firmware on many
panels simultaneously. Which panels can be upgraded over the network depends
on the network configuration of your TX3 system and how you connect to the
TX3 system (see section 1.1.4 on page 14).
Go to the Mircom web site for the latest firmware.
Notes:

In order to use the Network Firmware Upgrade tool:
•
At least one panel on the network must have firmware
version 2.0.0 or higher installed.
•

Note:

The new firmware files must be version 2.0.0 or higher.

If the panel’s firmware is corrupted, use the Firmware Upgrade
Wizard instead (section 2.13.2 on page 49).

To perform a network firmware upgrade
1.

Establish a connection from the PC to the TX3 system using one of the
following methods:
•

a USB connection to a panel
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•

COM port connection to a panel

•

a modem connection to a panel

•

a connection to the system’s Ethernet TCP/IP network

2.

Ensure that all of the panels to be updated in the network are powered on.

3.

Click the Connect icon in the Tool Bar.
The Configurator is connected to the panel network.

4.

Click Get on the Tool Bar to get the Job.

5.

Click Panels > Network Firmware Upgrade from the Menu
Bar.
The Network Firmware Upgrade window appears.

Figure 35.
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Network Firmware Upgrade Screen

6.

Select the panels on the network to upgrade with new firmware by
selecting the corresponding check boxes on the left.

7.

Once the panels on the network have been selected, click Select
Firmware Files.
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The Select Firmware Files window appears.

Figure 36.

Select Firmware Files

Each type of panel on the network uses a different firmware file.
8.

Click Browse for one of the panel types being upgraded and in the new
window that appears select the firmware file to use.

9.

Repeat step 8 for each type of panel being upgraded on the network.

10.

Once completed click OK.

11.

In the Network Firmware Upgrade window click Upgrade to begin
upgrading the selected panels.
The firmware upgrade process takes several minutes to complete. A
progress of each upgrade is shown next to each panel. Once the firmware
has been upgraded, the panel automatically restarts. Wait until all panels
have finished restarting before continuing.

12.

2.14

Once the upgrade completes, click Send on the Tool Bar to send the Job
back to the panel.

Logging into the Touch Screen Terminal
Use the PC TX3 Configurator to perform all configurations on the TX3 system,
except for the features listed below. In order to access the features below, you
must log into the Touch Screen itself.
•

Set the Touch Screen administrator password (section 2.6 on page 32)
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•

Save Touch Screen log files (section 2.15 on page 61)

•

Change the appearance of a Touch Screen Secondary Node (a Touch
Screen Secondary Node is a Touch Screen connected by RS-485). This
includes all the settings in Chapter 4. You can only change the appearance
of a Touch Screen Secondary Node by logging in to the Touch Screen
either at the terminal or by using Remote Desktop (section 4.9 on
page 133).

•

Test themes (page 93)

•

Enable the Advertising Module (page 106)

•

Print an advertising report (page 115)

•

Calibrate the Touch Screen (section 4.8 on page 125)

If you need to access one of these features, log into the Touch Screen as described
below. For all other configurations, use the PC Configurator.
To log in to the Touch Screen terminal
At the Touch Screen terminal, enter 9999. The administrator password window
appears.

Figure 37.

1.

Enter your administrator password, and then click OK (by default, there is
no password). The Main Window appears. You are now ready to begin
configuration.

2.

Proceed with your configuration or click Send and Exit from the
Tool Bar to apply the settings and exit the session.

Note:
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TX3 Touch Admin Access

You can log into the Touch Screen remotely using Remote Desktop
(section 4.9 on page 133).
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2.15

Saving Touch Screen Log Files

2.15.1

For TX3 Touch Software Versions Prior to 1.2.7
1.

From the main touch screen display enter “9999”. The administrator
access code window appears.

Figure 38.

TX3 Touch Admin Access

2.

Enter the Touch Screen administrator password to log in to the system and
press OK (by default the there is no password). The main configuration
window appears.

3.

In the main configuration window, click Get.

4.

After the Configurator has retrieved the job, click Disconnect.

5.

Navigate to the File menu and select Exit to Windows.

Figure 39.

6.
7.
8.
9.

Configurator Exit Screen

Navigate to C:\Program Files\Mircom Technologies\TX3
Touch.
Open the DataFiles folder and copy all files with the .log extension
and save them to a USB flash drive.
Open the Database folder and copy all files inside and save them to a
USB flash drive.
Restart the TX3 software.
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2.15.2

For TX3 Touch Software Version 1.2.7 or Later
1.

From the main touch screen display enter “9999”.
The administrator access code window appears.

Figure 40.

2.

TX3 Touch Admin Access

Enter the Touch Screen administrator password to log in to the system and
press OK (by default there is no password).
The main configuration window appears.

3.

In the main configuration window, click Get.

4.

Navigate to the Help menu and select About. The About window
appears.

Figure 41.

5.

In the About window select Save Log Files and save them to a USB
flash drive.

Figure 42.

6.
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Help Menu Navigation

Log Files Save Screen

To return to the main touch screen display, click Send and Exit.
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2.16

Upgrading the Touch Screen Software
1.

Contact Mircom customer service to obtain the latest Touch Screen
software.

2.

Copy the Touch Screen software installer to a USB flash drive.

3.

Insert the USB flash drive into the USB port on the Touch Screen.

4.

From the main touch screen display enter “9999”. The administrator
access code window appears.

Figure 43.

TX3 Touch Admin Access

5.

Enter the Touch Screen administrator password to log in to the system and
press OK (by default the there is no password). The main configuration
window appears.

6.

Navigate to the File menu and select Exit to windows.

7.

Navigate to the Control Panel.

Figure 44.

Control Panel
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8.

Select Uninstall a Program.

Figure 45.

9.

Double-click TX3 Touch Entry Phone System.

Figure 46.

10.

TX3 Touch Entry Phone System

Click Yes to remove the existing software.

Figure 47.
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Uninstall a Program

Uninstall TX3 Touch Entry Phone System
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11.

After the software is removed, click the back arrow
Desktop.

12.

Navigate to the USB flash drive, and drag the new Touch Screen software
installer to the desktop.

13.

Double click the new Touch Screen software and follow the instructions
to install it.

Figure 48.

to go back to the

The first window of the TX3 Touch Screen software
Installer

14.

After the new software is installed, the Configurator software starts.

15.

Verify that the job is complete, and click Connect to test the connection
to the Touch Screen.

16.

Quit the Configurator software.
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17.

Double-click the Restart icon on the desktop to restart the Touch
Screen.

Figure 49.

2.17

Restart the Touch Screen

Shutting Down the TX3 Touch Screen
To shut down the TX3 unit from the touch screen
1.

From the main touch screen display enter “9999”. The administrator
access code window appears.

Figure 50.
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2.

Enter the Touch Screen administrator password to log in to the system and
press OK (by default the there is no password). The main configuration
window appears.

3.

Navigate to the menu bar along the top and select the File menu.
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4.

In the menu that appears select Shut Down and select Shut Down
again.

5.

Confirm your selection when the pop-up window appears.
The Configurator software shuts down followed by the Windows
environment and the hardware.

Note:

Do not disconnect the power until the full shut down process has
been completed.
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3

Adding and Connecting to a Panel

The TX3 Configurator lets you connect to any panel on the network. Once you
connect to a panel, you can monitor and configure activities of all controllers
connected to the TX3 network and add resident and card information.
This chapter explains
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•

Adding a Panel

•

Changing a Main Node’s IP Address

•

Connecting to a Panel
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3.1

Adding a Panel
The first step in setting up the panel is to add the panel to the network. Once a
Touch Screen, Card Access or Telephone Access panel is added to the network,
access configuration information can be entered.
Note:

When adding additional panels ensure the selected panel matches
the panel and model you wish to connect to.

For information about the installation of the Telephone Access and Card Access
Systems, refer to the manuals shipped with the system and on the Mircom
website (www.mircom.com).
The procedure for adding panels differs slightly depending on how you are
connecting to your TX3 system. If you are connecting directly to a panel (using
a modem, the USB port, or a COM port), follow the instructions in section 3.1.1
on page 69. If you are connecting to a TX3 system with Main Nodes and
Secondary Nodes on an Ethernet TCP/IP network, see section 3.1.2 on page 70.
General information on how TX3 devices can be connected together (RS-485,
Ethernet, or both) can be found in section 1.1.4 on page 14.

3.1.1

Adding Panels Using a Modem, USB, or COM Connection
When you connect to a panel using a modem, USB, or COM connection, you can
add that panel as well as any other panel connected to the same RS-485 network
to your job. In order to add a panel to your job, you need to know both the RS-485
network address and model of the panel.
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To add a panel to the network
1.

Right click anywhere on the tree and select Add Panel. The Add Panel
window appears.

Figure 51.

2.

Add Panel

Provide the following information:
Panel model. Click the drop down list and select a panel.
Address. This field displays the remaining available panel addresses.
Click the drop down list and select the panel address. Ensure that this
address matches the panel address.
Label. Provide a name for the panel.

3.

3.1.2

Click Add to add the panel and return to the configuration window, or
click Close to exit without saving the changes.

Adding Panels Using a TCP/IP Connection
If you connect to your TX3 system using a TCP/IP network connection, you can
add any of the panels in the TX3 system to your Job, whether they are connected
directly to the Ethernet TCP/IP network (Main Node) or they are connected to an
RS-485 network (Secondary Node). You can also use the TX3 Configurator to
change the IP address of Main Nodes once they have been added to your Job.
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3.1.2.1

Adding a Main Node
Note:

If you are having problems adding nodes to your Job, there may be
another program using the TCP/IP ports that the TX3 system
communicates on. See section 1.8 on page 22 for information on
what ports the TX3 system uses.

Note:

If you cannot find the panel, then it might have a static IP and be on
a different subnet. Follow the instructions in section 3.2 on page 73.

To add a Main Node panel to your job
1.

Connect your PC to the TX3 system’s Ethernet TCP/IP network.

2.

Right click anywhere on the tree and select Add Panel. The Add Panel
window appears.

Figure 52.

3.
Note:

Add Main

Select (This is a Master) from the Master Node list.
In the Configurator, the terms Master and Main are equivalent.
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4.

Click Find. The Find IP Panel window opens. This window shows all the
Main Nodes on the TCP/IP network.

Figure 53.

5.

Select the Main Node you want to add to your job, and then click OK.

6.

In the Add Panel window, click Add.

Note:

3.1.2.2

Find IP Panel

If you cannot find the panel, then it might have a static IP and be on
a different subnet. Follow the instructions in section 3.2 on page 73.

Adding a Secondary Node
Notes:

Before you can add a Secondary Node to a job, you must first do the
following:
•
Add the Secondary Node’s Main Node to the job.
•

Record the RS-485 address and model of the Secondary
Node.

To add a Secondary Node panel to your job
1.
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Right click anywhere on the tree and select Add Panel. The Add Panel
window appears.
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2.

From the Master Node list, select the panel that is the Main Node of the
panel you want to add.

3.

Provide the following information:
Panel model. Click the drop down list and select a panel.
Address. This field displays the remaining available panel addresses.
Click the drop down list and select the panel address. Ensure that this
address matches the panel address.
Label. Provide a name for the panel.

4.

3.1.3

Click Add to add the panel and return to the configuration window, or
click Close to exit without saving the changes.

Deleting a Panel from the Network
Deleting a panel from the network removes it entirely from the system.
Configuration information inside the panel remains unchanged.
To delete a panel from the network

3.2

1.

Select the panel, and then select Edit > Delete. The Delete Panel
window appears.

2.

Click Yes to confirm the deletion or No to exit and return to the main
window.

Changing a Main Node’s IP Address
You might need to change a non-Touch Screen Main Node’s IP address when
you are adding the panel to a new network, or when the panel was turned on for
the first time with DIP switch 8 on.
Notes:

Before you change a Main Node’s IP address:
•
If you are having problems changing IP addresses, there may
be another program using the TCP/IP ports that the TX3
system communicates on. See section 1.8 on page 22 for
information on what ports the TX3 system uses.
•

You cannot change the IP address for a Touch Screen panel
using the TX3 Configurator. Touch Screens are configured
to use DHCP to get their IP addresses.
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3.2.1

Static or Dynamic IP Address
For non-Touch Screen units with an IP Module installed, DIP switch 8
determines how the IP address is assigned. (See LT-969 TX3 Telephone Access
System Installation and Operation Manual for details.)
•

DIP switch 8 OFF: The IP address is assigned using a DHCP server. This
is the default factory setting.

•

DIP switch 8 ON when it was previously OFF: The IP address is static
and is set to the last IP address that was assigned to the panel.

•

DIP switch 8 ON when the panel is turned on for the first time: The IP
address is static and is set to:
• 0.0.0.0 (for card access firmware lower than 3.1.26, lobby firmware
lower than 3.0.45, and elevator restriction firmware lower than 3.1.14)
• 192.168.3.1 (for card access firmware 3.1.26, lobby firmware 3.0.45,
elevator restriction firmware 3.1.14)
• 192.168.1.74 (for card access, lobby, and elevator restriction firmware
version 3.4.x or higher)

If the panel is turned on for the first time with DIP switch 8 on, then follow the
instructions below to change the IP address.

3.2.2

Try to Discover the Panel
1.

Select Tools > IP Change Tool.
The IP Change Tool window appears.

Figure 54.
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IP Change Tool
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If you can see the panel, go to section section 3.2.4 on page 77.
If you cannot see the panel, go to section 3.2.3 on page 75.

3.2.3

Configure your PC so that it is on the Same Subnet
If you cannot see the panel in the IP Change Tool, then you must configure your
PC so that it is on the same subnet as the panel.
1.

Connect your PC to the TX3 system’s Ethernet TCP/IP network.

2.

Click Start, then Control Panel, then open the Network and
Sharing Center.

3.

Click Local Area Connection.

4.

Click Properties.

Figure 55.

Local Area Connection
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5.

Double-click Internet Protocol Version 4.

Figure 56.
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Local Area Connection Properties
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The Internet Protocol Version 4 window appears.

Figure 57.

Internet Protocol Version 4

6.

Make a note of the settings in the window. You will need this information
to set the PC back to its default settings later.

7.

Select Use the following IP address and enter the following
information:
IP address: 192.168.1.10 (firmware version 3.4.x) or 192.168.3.10
(firmware version 3.1.26)
Subnet mask: 255.255.255.0

8.

3.2.4

Click OK and continue to section 3.2.4 below.

Change the Panel’s IP Address
1.

In the Configurator, click the Network node.

2.

Enter the following information in order to configure the panel for the
destination network (the network that the panel should be on).
Mask: The subnet mask of the destination network. Consult the network
administrator.
Gateway IP: The IP address of the gateway for the destination network.
Consult the network administrator.
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This information will be sent to the panel when you change the IP address
in the steps below.

Figure 58.

3.

Network Configuration

Select Tools > IP Change Tool.
The IP Change Tool window appears.

Figure 59.
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IP Change Tool
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3.2.5

4.

Select the panel that you want to change the IP address for.

5.

Enter the new IP address in the New IP Address box.

6.

Click OK.

7.

If you have firmware version 3.1.26 or higher:
a.

If an error message appears saying Unable to assign new
IP address. Not responding to ping, click OK. This
message appears because the PC was configured to the panel’s
subnet mask, and that subnet mask has now changed.

b.

Follow the instruction in section 3.2.3 on page 75 to restore the
PC’s TCP/IP information to the default. Consult your system
administrator for assistance.

8.

In the IP Change Tool, click Scan Again and make sure that the panel
appears.

9.

Click Connect from the Tool Bar.

10.

Click Send.

Change the IP Address in the Job File
If the panel is already in your Job, you must also change its IP address in your Job
file by doing the following.
1.

Open your Job file.

2.

Select the Main Node whose IP address you changed using the IP Change
Tool.
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3.

Enter the Main Node’s new IP address in the IP address box.

Figure 60.

3.3

IP address

4.

Click Connect from the Tool Bar.

5.

Click Send.

Connecting to a Panel
The network configuration option lets you set the parameters required for the PC
to communicate with a single panel or a network of panels using a COM port,
Modem, USB, or TCP/IP connection. By default, the Touch Screen is connected
to the internal Telephone Access System Panel.
Note:

Whenever configuring a network, first disconnect from that
network.

Each controller must be set with a level 3 passcode. By default this passcode is
3333.
Note:

The level 3 panel passcode must match the network passcode in
order to connect to that panel. The level 3 passcode is initially set at
the panel.

When a panel is successfully connected, a message displays in the Lower Pane
Online Events indicating it is currently online. If unsuccessful an error message
appears.
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Once connected, the Connect toolbar button shows the ‘connected’ icon and
you can begin adding resident and card information.
To establish a network connection
1.

If connected, Click Disconnect from the toolbar.

2.

Establish the USB, COM, modem, or TCP/IP connection from the PC to
the controller (USB or COM port), telephone line (modem), or Ethernet
network (TCP/IP).

Note:

3.

When using an RS-485 connection select COM Port from the PC
connection list.
Click Network. The Network Configuration window appears.

Figure 61.

Network Configuration
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4.

Select the type of connection you are using from the PC Connection
list.

5.

Click Advanced. The Advanced Network Setup window appears.

Figure 62.

6.

Advanced Network Setup

Enter the following parameters:
Network passcode. The network passcode is used for logging into each
panel. All panels on the network must use this passcode as their highest
level passcodes.
Network timeout. The timeout is the time the software will wait for each
panel to respond to a communication command. Increasing this value may
help when there are many communication errors.

7.
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Proceed with a COM port, modem, USB, or TCP/IP configuration as
described in the following sections.
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3.3.1

Connecting Through the COM Port
To connect to a panel using the COM port
1.

Select COM Port from the PC connection list. The Port Details window
appears.

Figure 63.

Network Configuration - COM Port

2.

Select the COM port number. The speed is fixed set at 115200 baud. Data
bit settings are fixed at no parity, 8 data bits and 1 stop bit.

3.

Click Connect from the Tool Bar. Once connected the connection icon
appears.

Figure 64.

Connection Status Icon - Connected
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3.3.2

Connecting Though a Modem
To connect to a panel using the modem
1.

Select Modem from the PC connection list. The Modem window appears.

Figure 65.

2.

Network Configuration - Modem

Enter the following parameters:
Modem. Select a modem currently configured into the PC.
Phone #. Provide the telephone number the panel is connected to. If
necessary use a comma for a pause.

Note:

The pause length depends on the type of modem.
Extra initialization commands. Provide any extra modem initialization
commands. The characters "AT" are automatically added before the
initialization commands. Refer to the manufacturer’s modem
documentation for additional information.

3.

84

Click Connect from the Tool Bar to connect.
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3.3.3

Connecting Through USB
To connect to a panel using the USB port
1.

Select USB from the PC connection list. The USB window appears. The
connection automatically establishes and no settings are required. The
software looks for the USB to the serial virtual COM port configured on
the PC. The speed and data bit settings are the same as the COM port
option.

Figure 66.

2.

3.3.4

Network Configuration - USB

Click Connect from the Tool Bar.

Connecting Through TCP/IP
Note:

If you are having problems connecting through TCP/IP, there may
be another program using the TCP/IP ports that the TX3 system
communicates on. See section section 1.8 on page 22 for
information on what ports the TX3 system uses.
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To connect to a panel using a TCP/IP network
1.

Select TCP/IP from the PC connection list. The TCP/IP window
appears.

Figure 67.

2.

Network Configuration - TCP/IP

Enter the following parameters:
Mask. The subnet mask of the network that the job is connecting to.
Gateway IP. The IP address of the gateway on the network.

3.

If you are using a range of IP addresses in your network, in the New IP
Range section, enter the following parameters:
Start. Starting IP address of your network.
End. Ending IP address of your network.

4.

3.3.5

Click Connect from the Tool Bar.

Disconnecting from a Network
The disconnection process, by pressing the Disconnect icon, is opposite to that of
connection process. The software logs out each panel and disconnects from the
communication port.
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The disconnection process is also automatically invoked when closing a Job or
closing the software.
Note:

Some configuration functions, such as changing the panel address
or model, require you to disconnect from the network. Whenever
you are doing any kind of configuration ensure whether
disconnection from the network is required.

To disconnect from the panel network
1.

Click the Disconnect button. The Disconnect icon disappears,
indicating that it is ready to connect.

Figure 68.

2.

Connection Status Icon - Disconnected

Proceed with the configuration.

TX3 Configuration and Administrator Manual

87

4

Configuring the Touch Screen
Appearance

The TX3 Configurator lets you easily change the appearance of the user interface
by setting the system parameters and options.
This chapter explains
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•

Overview

•

Configuring the Touch Screen Appearance

•

Modifying Layouts

•

Creating and Modifying Themes

•

Modifying Videos and Banners

•

Configuring the Advertising Module

•

Modifying More Options

•

Calibrating the Touch Screen

•

Logging into the Touch Screen Terminal Using Remote Desktop for
Troubleshooting
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4.1

Overview
You must be logged in to the TX3 Configurator as an administrator in order to
configure the Touch Screen appearance. In addition to logging in as an
administrator, you must connect using one of the following methods.

4.2

•

Connecting to Touch Screen Main Nodes on a TCP/IP network with the
TX3 Configurator (see section 3.3 on page 80)

•

Connecting to a Main Node over the Internet with the TX3 Configurator
(see Chapter 8 on page 213)

Configuring the Touch Screen Appearance
Touch Screen customization lets you set the layout, theme, videos and banners,
and specific user options. If the preset appearance is not to your liking, you can
change it.
The appearance of all Touch Screen screen elements are configurable and may
be saved and re-applied. Figure 69 shows the user interface configurable screen
elements.
Note:

If your network connection type is TCP/IP, you can configure the
appearance of Main Node Touch Screens in your job, but not
Secondary Node Touch Screens. The appearance of a Secondary
Node Touch Screen can only be changed at the Touch Screen
(section 2.14 on page 59) or by connecting to it using Remote
Desktop (section 4.9 on page 133).
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A
I

B

G, H

C

F
D
E

A. Main Video B. Help Button C. Call Reception D. Keyboard E. Bottom Banner F. Clock/Language
Selection G. Call Resident H. Disconnect I. Resident Scroll Buttons

Figure 69.

User Interface Screen Elements

To configure the Touch Screen appearance
1.

Note:
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Log in to the TX3 Configurator as administrator, then connect to the
Touch Screen.
In order to connect to a Touch Screen Main Node using the TX3
Configurator, the Admin Password setting in the TX3 Configurator
must match the Touch Screen administrator password. See section
4.7.5 on page 124 for instructions on how to enter the Admin
password in the TX3 Configurator.

2.

From the Left Pane, select Job > Network.

3.

Expand the Network tree.

4.

Expand the panel entry for your Touch Screen, and then select Touch
Screen.
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The Touch Screen Options window appears in the Right Pane.

Figure 70.

5.

4.3

Touch Screen Appearance

Proceed with the configuration of Layouts, Themes, Videos and
Banners or More Options as described in the following sections.

Modifying Layouts
Layouts lets you determine how each of the major screen areas are arranged
and portrayed, and may be selected from existing templates or customized.
To change the current Layout
1.

From the Left Pane, select Job > Network.

2.

Expand the Network tree.

3.

Expand the panel entry for your Touch Screen, and then select Touch
Screen.
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4.

In the Right Pane, select Layouts. The Layouts menu appears.

Figure 71.

Touch Screen Layouts

5.

From the Screen Layouts select one of the four available layouts.

6.

From the Virtual Keyboards select from one of the following
options:
Full size. Displays the keyboard in full size.
Full + Num. Displays the keyboard in full size with numbers.
Simple. Displays the keyboard in basic formatted lettering.
Accessible. Displays a keyboard, selection button, and resident scroll
buttons at the bottom of the screen.
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7.

To show the dial codes on the residential directory select Show dial
codes box.

8.

If you have a Configurator version lower than 2.0.0: to enable resident
names to exceed 15 characters in length select the Enable long
names box.

9.

Proceed with another configuration or press Send and Exit from the
Tool Bar to apply the settings and exit the session.

TX3 Configuration and Administrator Manual

Configuring the Touch Screen Appearance

4.4

Creating and Modifying Themes
Themes lets you set the screen font size, color and element attributes. Selections
may be saved as.thm files and existing themes may be imported. You can
accept an existing customized theme or modify it as necessary. Preset themes are
fixed and cannot be modified.
The option to test themes is available only if you log into the Touch Screen
terminal (section 2.14 on page 59).
See the Appendix for a detailed description of the user interface elements.
To create or modify themes
1.

From the Left Pane, select Job > Network.

2.

Expand the Network tree.

3.

Expand the panel entry for your Touch Screen, and then select Touch
Screen.

4.

In the Right Pane, select Themes. The Themes menu appears.

Figure 72.

Note:

Touch Screen Themes

Preset themes can not be modified, only exported.
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5.

Select a custom theme and press Customize. The Customize Theme
window appears showing the font and color selections.

Figure 73.

4.5

Touch Screen Customize Theme

6.

Select the font size and color for the user interface elements. For a
complete list of all the configurable user interface elements see section 14
on page 294.

7.

Press Import to retrieve an existing theme or press Export to save the
theme to a file.

8.

Press OK to apply the settings and return to the previous window.

9.

Proceed with another configuration or press Send and Exit from the
Tool Bar to apply the settings and exit the session.

Modifying Videos and Banners
Videos and Banners lets you define and select the multi media options for the
Touch Screen user interface. There are four different locations where media can
be displayed. Figure 74 shows the customizable Touch Screen user interface
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areas. Table 1 gives the dimensions for these areas. Media can be in any of the
following video or still image formats: .avi, .wmv, .swf, .jpg, .jpeg,
.bmp, or .png.

A. Top Banner B. Main Video C. Help Video D. Bottom Banner E. Screen Saver

Figure 74.

Touch Screen Videos and Banners

Table 1: Banner Dimensions

Banner

Banner Dimensions in Pixels (Width x Height)
15” Touch Screen Models

22” and Larger Touch
Screen Models

A. Top Banner

1024 x 100

1080 x 100

B. Main Video

238 x 230

250 x 227

C. Help Video

238 x 230

250 x 227

D. Bottom Banner

911 x 230

960 x 374

1024 x 768

1080 x 1920

E. Screen Saver
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To set videos, screen saver and banners
1.

From the Left Pane, select Job > Network.

2.

Expand the Network tree.

3.

Expand the panel entry for your Touch Screen, and then select Touch
Screen.

4.

In the Right Pane, select Videos and Banners. The Videos and
Banners window appears.

Figure 75.

5.
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Touch Screen Videos and Banners

Configure the Main Video, Help Video, Top Banner, Bottom
Banner and Screen Saver as described in the following sections.
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To set the Main Video
1.

Select Main Video. The Media Selection window appears.

Figure 76.

2.

Touch Screen Main Video

To determine how you want the video to display, define the following
parameters:
Single Video. To show a single media file on the main video display select
this option.
Advertising. To show multiple media files on the main video display
select this option. Refer to section 4.6 on page 106.
Select File. Press Select File to select a media file from a directory.
Original Size. This option appears when image or flash file formats are
selected. Selecting this option displays the image in its original size. The
dimensions of the image depend on the size of your Touch Screen:
•

15” Touch Screens: 238 pixels wide by 230 pixels high.
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•

22” and larger Touch Screens: 250 pixels wide by 227 pixels
high.

Resize to fit. This option appears when image or flash file formats are
selected. Selecting this option resizes the image to fit within the display
area. For best results, the dimensions of the image should be proportional
to the banner’s original size (see the preceding parameter, Original Size).
3.

To preview the selected media file use the video control buttons to play,
stop, pause, rewind or fast forward.

4.

To adjust the volume use the volume control buttons to the right of the
media preview window.

5.

Press OK to apply the settings and exit the Media Selection window
session or press Cancel to exit without selecting the media file.

6.

Proceed with another configuration or press Send and Exit from the
Tool Bar to apply the settings and exit the session.

Note:
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To disable the Main Video select a layout that does not include it.
Refer to section 4.3 on page 91.
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To set the Help Video
1.

Select Help Video. The Media Selection window appears.

Figure 77.

2.

Touch Screen Help Video

To determine how you want the video to display, define the following
parameters:
Single Video. To show a single media file on the help video display select
this option. For the help video this is the only option available and it is
automatically selected.
Advertising. This option is disabled for help videos.
Select File. Press Select File to select a media file from a directory.
Original Size. This option appears when image or flash file formats are
selected. Selecting this option displays the image in its original size. The
dimensions of the image depend on the size of your Touch Screen:
•

15” Touch Screens: 238 pixels wide by 230 pixels high.

•

22” and larger Touch Screens: 250 pixels wide by 227 pixels
high.
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Resize to fit. This option appears when image or flash file formats are
selected. Selecting this option resizes the image to fit within the display
area. For best results, the dimensions of the image should be proportional
to the banner’s original size (see the preceding parameter, Original Size).
3.

To preview the selected media file use the video control buttons to play,
stop, pause, rewind or fast forward.

4.

To adjust the volume use the volume control buttons to the right of the
media preview window.

5.

Press OK to apply the settings and exit the Media Selection window
session or press Cancel to exit without selecting the media file.

6.

Proceed with another configuration or press Send and Exit from the
Tool Bar to apply the settings and exit the session.

Note:
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To disable the Help Video select a layout that does not include it.
Refer to section 4.3 on page 91.
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To set the Top Banner
1.

Select Top Banner. The Media Selection window appears.

Figure 78.

2.

Touch Screen Top Banner

To determine how you want the video to display, define the following
parameters:
Single Video. To show a single media file on the top banner display select
this option. Only image or flash file formats can be used for the top banner.
Advertising. This option is disabled for the top banner.
Disable. To disable the top banner select this option.
Select File. Press Select File to select a media file from a directory.
Show Text. To display customized text select this option and enter the
desired text into the text field on the right. When this option is selected
only text appearing in the text field will be displayed and any previously
selected media files will not be displayed in the top banner. The text
format can be edited as described in section 4.4 on page 93.
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Original Size. Selecting this option displays the image or flash object in
its original size. The dimensions of the image depend on the size of your
Touch Screen:
•

15” Touch Screens: 1024 pixels wide by 100 pixels high.

•

22” and larger Touch Screens: 1080 pixels wide by 100 pixels
high.

Resize to fit. Selecting this option resizes the image or flash object to fit
within the display area. For best results, the dimensions of the image
should be proportional to the banner’s original size (see the preceding
parameter, Original Size).

102

3.

Press OK to apply the settings and exit the Media Selection window
session or press Cancel to exit without selecting the media file.

4.

Proceed with another configuration or press Send and Exit from the
Tool Bar to apply the settings and exit the session.
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To set the Bottom Banner
1.

Select Bottom Banner. The Media Selection window appears.

Figure 79.

2.

Touch Screen Bottom Banner

To determine how you want the video to display, define the following
parameters:
Single Video. To show a single media file on the bottom banner display
select this option.
Advertising. To show multiple media files on the bottom banner display
select this option. Refer to section 4.6 on page 106.
Disable. To disable the bottom banner select this option.
Select File. Press Select File to select a media file from a directory.
Original Size. This option appears when image or flash file formats are
selected. Selecting this option displays the image in its original size. The
dimensions of the image depend on the size of your Touch Screen:
•

15” Touch Screens: 911 pixels wide by 230 pixels high.
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•

22” and larger Touch Screens: 960 pixels wide by 374 pixels
high.

Resize to fit. This option appears when image or flash file formats are
selected. Selecting this option resizes the image to fit within the display
area. For best results, the dimensions of the image should be proportional
to the banner’s original size (see the preceding parameter, Original Size).
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3.

To preview the selected media file use the video control buttons to play,
stop, pause, rewind or fast forward.

4.

To adjust the volume use the volume control buttons to the right of the
media preview window.

5.

Press OK to apply the settings and exit the Media Selection window
session or press Cancel to exit without selecting the media file.

6.

Proceed with another configuration or press Send and Exit from the
Tool Bar to apply the settings and exit the session.
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To set the Screen Saver
1.

Select Screen Saver. The Media Selection window appears.

Figure 80.

2.

Screen Saver Options

To determine how you want the video to display, define the following
parameters:
Single Video. To show a single media file over the entire display while the
screen saver is active select this option.
Advertising. To show multiple media files on the over the entire display
while the screen saver is active select this option. Refer to section 4.6 on
page 106.
Disable. To disable the screen saver select this option.
Select File. Press Select File to select a media file from a directory.
Wait. Specify the amount of time before the screen saver begins playing.
Original Size. This option appears when image or flash file formats are
selected. Selecting this option displays the image in its original size. The
dimensions of the image depend on the size of your Touch Screen:

TX3 Configuration and Administrator Manual

105

Configuring the Touch Screen Appearance

•

15” Touch Screens: 1024 pixels wide by 768 pixels high.

•

22” and larger Touch Screens: 1080 pixels wide by 1920 pixels
high.

Resize to fit. This option appears when image or flash file formats are
selected. Selecting this option resizes the image to fit within the display
area. For best results, the dimensions of the image should be proportional
to the banner’s original size (see the preceding parameter, Original Size).

4.6

3.

To preview the selected media file use the video control buttons to play,
stop, pause, rewind or fast forward.

4.

To adjust the volume use the volume control buttons to the right of the
media preview window.

5.

Press OK to apply the settings and exit the Media Selection window
session or press Cancel to exit without selecting the media file.

6.

Proceed with another configuration or press Send and Exit from the
Tool Bar to apply the settings and exit the session.

Configuring the Advertising Module
Note:

In order to enable the advertising module, you must log into the
Touch Screen terminal (section 2.14 on page 59). To configure the
advertising module, use the PC Configurator.

The advertising module is an optional addition to the TX3 Touch. It allows
advertisements in the form of videos, images or animations to be displayed on the
touch screen. Advertising media can play on the Main Video display, the Bottom
Banner display and as a Screen Saver over the entire display.
The advertising module allows property managers to recoup the costs of their
telephone entry and card access security system by selling advertising time on
their Touch Screens in high traffic lobbies and entrance ways.
The subsequent sections explain the following configuration options:
•
•
•
•
•
•
•
•

106

Enabling the Advertising Module
Advertising Module Configuration
Adding an Advertisement
Editing an Advertisement
Deleting an Advertisement
Advertisement Priority Settings
Advanced Advertisement Options
Setting the Screen Saver Timer (Screen Saver selection only)
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To enable the Advertising Module
To activate the software for the advertising module follow the steps below.
1.

Log into the Touch Screen terminal (section 2.14 on page 59).

2.

From the menu at the top of the screen press Help > Purchase
Advertising Module. The Purchase TX3 Touch Advertising
Module window appears.

Figure 81.

Activate Advertising Module

3.

Press Generate Licensing File. The Save Advertising Licensing
File window will appear.

4.

Select a location to save the file and press Save.

Note:

Remember where the licensing file is saved.

5.

Once the licensing file has been saved contact customer support at the
number provided on the Purchase TX3 Touch Advertising Module
window or from the information provided in section 1.9 on page 23.

6.

Once customer support has been contacted a license key will be generated
and provided to you. Enter the provided key into the Purchase TX3 Touch
Advertising Module window. Press Activate to activate the
advertising module.

Note:

The key is only valid for the unit for which the licensing file was
generated. Each unit requires a separate key to activate its
advertising module.
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To configure the advertising Module
Note:

To configure the advertising module, use the PC Configurator.

From the Videos and Banners tab the advertising module can be activated for the
following selections: Main Video, Bottom Banner and Screen Saver.
All media files are listed in the Video Files list. The files in this list are played
based on each file’s associated schedule.

A. Video Location Tabs B. Video Files List C. Configuration Buttons

Figure 82.

Advertising Module Configuration Screen

The advertising module configuration screen has several components:
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A.

Video Location Tabs. Advertisements can be played on three screen
locations: Main Video, Bottom Banner and Screen Saver. Select a
tab to configure advertisement options for each screen location.

B.

Video Files List. Media files are listed here. The files in this list are
played during the three hour time slots that they have been assigned
to in the scheduling window. See Scheduling Window.
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C.

Configuration Buttons. These buttons allow video files to be added,
removed and configured.

D.

Screen Saver Timeout. Determines how long the TX3 Touch
software will idle before it enters Screen Saver mode.

E.

Playlist Editing Buttons. These buttons configure the schedule by
specifying the video rotation for each of the 3 hour time slots.

F.

Scheduling Window. The Scheduling display screen lists the 7 days
of the week, with each day consisting of 8 three hour time slots. Each
cell shows the number of videos that will play during each of the 56
time slots. Once all of the videos in a time slot have played they will
be looped until the time slot is over.

Once advertisements have been configured for each of the three selections, Main
Video, Bottom Banner and Screen Saver, press OK to apply the settings and exit
the Media Selection window session or press Cancel to exit without saving any
changes.
To add an Advertisement
To add a media file to video files list follow the steps below.
1.

Press Add and the Add New Advertising Media File Wizard appears.

Figure 83.

Adding a Media File Part 1
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2.

Press Select File to select a media file from the directory. If an image
or flash file format is chosen then options to keep the original size or resize
the image or object to fit within the display will appear. Select the
appropriate option.

Note:

In addition to the other file formats, audio file formats .wav and
.mp3 are enabled for screensaver media file selection.

Note:

If the dimensions for your image or flash file are not the same as the
dimensions for the Main Video banner, the Bottom Banner or the
Screen Saver, there may be some distortion when the image or flash
file are displayed. See Table 1 on page 95 for the dimensions of
these areas.

3.

To preview the selected media file use the video control buttons to play,
stop, pause, rewind or fast forward.

4.

To adjust the volume use the volume control buttons to the right of the
preview file window.

5.

Press Next to confirm the media file selection and continue to the next
stage of the wizard or press Cancel to exit without confirming a
selection.

Figure 84.
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Adding a Media File Part 2
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6.

The schedule for the advertisement can be set to one of several preset
times by using the Advertising Scheme drop down menu. The Start Date
and End Date indicate when the advertisement will be added to and
removed from the schedule rotation. Select the corresponding drop down
menus to set them. The default setting will keep the file in the rotation for
5 years.

7.

Press Finish to confirm the selection and exit the wizard, press Back to
change settings or press Cancel to exit without confirming a selection.

To edit an Advertisement
Editing video file entries allows changes and updates to existing entries without
having to create new entries. All the settings selected for the initial addition of the
media file are saved including the associated scheduling settings. This is useful
for quickly replacing an old advertisement with an updated version.
1.

To edit an existing media file select the media file you would like to edit
from the Video Files list then press Edit. The Edit an Media File window
appears.

Figure 85.

Edit an Advertising Video
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2.

The Start Date and End Date indicate when the advertisement will be
added to and removed from the schedule rotation. Select the
corresponding drop down menus to set them. The default setting will keep
the file in the rotation for 5 years.

3.

Press Select File to replace the current media file with another file
from the directory. If an image or flash file format is chosen then options
to keep the original image size or resize the image to fit within the display
appear. Select the appropriate option.

4.

To preview the selected media file use the video control buttons to play,
stop, pause, rewind or fast forward.

5.

To adjust the volume use the volume control buttons to the right of the
preview file window.

6.

Press OK to apply the selected settings and exit the Edit an Advertising
Video window session or press Cancel to exit without saving any
modifications.

To delete an Advertisement
1.

To remove a media file from the video file rotation select the media file
from the Video Files list and press Delete. A Delete File Confirmation
box appears.

2.

Press Yes to confirm the deletion or press No to cancel.

To set Advertisement Scheduling

Figure 86.
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Advertisement Scheduling Settings
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For each time slot media files play in a repeating rotation for the duration
of the time slot. Each time slot displays a number that represents the
number of files currently in its rotation.
Each time slot requires separate configuration. To select a time slot press
on the time slot. To configure the selected time slot press the Edit
Playlist button. The Playlist Scheduling window appears.

Figure 87.

Playlist Scheduling

In the Playlist Scheduling window press Add to add an entry to the playlist
for the timeslot. Once an entry has been added select the entry and use the
drop down menu to set a specific media file for the entry. The media files
available for selection are the same as the ones in the video files list in the
Media Selection window. The same media file can be added multiple
times in the playlist. An entry can be removed by selecting it and pressing
the Delete button.
Press OK to apply the playlist schedule and exit the Playlist Scheduling
window or press Cancel to exit without saving any modifications.
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A playlist schedule can be copied from one time slot to another for quicker
configuration. To copy a playlist schedule select the timeslot that contains
the playlist then press Copy. Then select the timeslot that you wish to
copy the play list to and press Paste. The Playlist Copy Options window
appears.

Figure 88.

Playlist Copy Options

Press Overwrite if you wish to replace the schedule in the destination
time slot with the schedule being copied. Press Add if you wish to include
the schedule being copied to the schedule in the destination time slot.
Press Cancel to return to the Media Selection window without copying.
To set the Screen Saver Timer
In the Screen Saver Timeout box press on the time that the TX3
Touch will idle for before entering Screen Saver mode. This option is only
available in the Screen Saver tab.
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To print an Advertising Report
1.

Log into the Touch Screen terminal (section 2.14 on page 59).

2.

From the menu bar press Reports > Advertising Report. The
Advertising Report Options window appears.

Figure 89.

3.

Advertising Report Options

Provide the following information:
Panel. Select the panel that the advertisement plays on.
Video window. Select the video window that the advertisement plays on.
Video file. Select the advertisement you want to print the report for.
Report Period. Define the reporting period. Select from one of the four
predefined periods: the Current Week, the Current Month, the
Last Week and the Last Month. Once any of these four options are
selected the date range will be defined in the greyed out From and To
boxes. To define a custom date select Custom. Select the desired dates in
the From and To boxes.

4.

To delete the advertising record of the selected advertisement press
Delete. A Delete Current Advertising Records box will appear. Press
Yes to confirm the deletion or press No to cancel.

5.

To delete the advertising records of all of the advertisements press
Delete All. A Delete All Advertising Records dialogue box will
appear. Press Yes to confirm the deletion or press No to cancel.

6.

Press OK to generate an advertising report with the selected settings or
press Cancel to exit. If OK is selected an Advertising Report preview
window appears.
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A. Browse or Select Pages B. Refresh C. Print D. Print Layout
E. Page Setup F. Export
Figure 90.

7.

116

Advertising Report Preview Screen

The Advertising Report preview window shows how the report will
appear. There are several options on the toolbar:
A.

Browse or Select Pages. Use these buttons to browse through each
page of the advertising report.

B.

Refresh. Refresh the report preview.

C.

Print. If the TX3 touch is on the same network as a printer then the
report can be printed directly from the touch screen.

D.

Print Layout. This option previews how the report will look when it
is printed
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4.7

E.

Page Setup. If the TX3 touch is on the same network as a printer then
page setup options can be customized.

F.

Export. The advertising report can be saved as either a Microsoft
Excel spreadsheet document format, .xls, or as an Adobe Acrobat
portable document format, .pdf.

7.

Once the advertising report has been printed or saved exit from the
Advertising Report window by pressing the Close button at the top right
and then exit from the Advertising Report Options window by pressing
the Close button at top right again or by pressing Cancel.

8.

Press File, then press Exit without Send to exit the session.

Modifying More Options
More Options lets you specify more specific screen characteristics such as
screen contrast, volume and other various user options, such as clock and email
settings.
To configure More Options
1.

From the Left Pane, select Job > Network.

2.

Expand the Network tree.

3.

Expand the panel entry for your Touch Screen, and then select Touch
Screen.

4.

In the Right Pane, select More Options.
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The More Options window appears.

Figure 91.

5.

Touch Screen More Options

Define the following parameters:
Screen Contrast. Defines the brightness ratio of the lightest to the darkest
part of the Touch Screen interface.
Master Volume. Defines the volume of the speakers for videos, event
prompts, and VOIP calls.
VOIP, Event, Voice. Defines the volume of all notifications and VOIP
calls as a percentage of the Master Volume. Select the play button to
preview the volume level.

Note:

If the Touch Screen has telephone access controller board model
MD-1086, use these two volume controls only for notifications and
VOIP calls (not telephone calls). Telephone call volume is
controlled from Panel Configuration (section 3. on
page 145).
If the Touch Screen has telephone access controller board model
MD-1245, use these two volume controls for notifications, VOIP
calls, and telephone calls.
To determine which model of telephone access controller board
you have, see section 12.1.2 on page 272.
Voice prompt. Enables voice prompting for every selection.
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Show clock. Enables the clock display.
Scroll by page. Enables page scrolling.
Keyboard voice. Enables the audible keystrokes.
Show date. Enables date display.
Scroll by line. Enables line scrolling.
Auto Get Job. This option applies to Touch Screens that are either
Secondary Nodes or nodes on an RS-485 network and ensures that the
Touch Screen database is up-to-date. When you select this option, the
Touch Screen monitors its internal lobby board for any changes. When a
change is made to the internal lobby board database, the Touch Screen
automatically updates its own database. This option can only be enabled at
the Touch Screen unit (section 2.14 on page 59) or by connecting to the
Touch Screen by Remote Desktop (section 4.9 on page 133).
Note:

4.7.1

Ensure the selected panel is configured, connected and assigned
with a unique panel address.

6.

Proceed with configuring the date and time, resident groups, email
messages, language options, and the Admin password. For details on how
to set these options, see sections 4.7.2, 4.7.2, 4.7.3, 4.7.4, and 4.7.5.

7.

Press Send and Exit from the Tool Bar to apply the settings and exit
the session.

Setting the Date and Time
Set the Touch Screen date and time in the Monitoring section of the
Configurator. See section 12.1.1 on page 269.

4.7.2

Configuring Resident Groups
You may configure residents into specific groups by their dial codes using
designated text and logos. This feature allows visitors to easily make a selection
using the Group Buttons at the top of the user interface. Up to five groups may be
created.
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To configure resident groups
1.

On the More Options tab, click Resident Groups. The Resident
Groups window appears.

Figure 92.

Group Configuration

2.

Press Add to create a resident group. The default Group Name appears.
Press Delete to delete an existing resident group.

3.

Provide the following information:
Enable Groups. Select this check box to enable resident grouping.
Group name. Provide a group name.
Dial Code Range Start. Enter the start value for the group dial code.
Dial Code Range End. Enter the end value for the group dial code.
Text Only. Select Text Only to display only the Group Name.
Logo Only. Select Logo Only to display only the Logo.
Logo and Text. Select Logo and Text to display both the Logo and Text.
Group Logo. Select a logo for the group from a file.
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4.7.3

4.

Press OK to apply the settings and exit the Group Configuration window
session or press Cancel to exit without saving the information.

5.

Proceed with another configuration or press Send and Exit from the
Tool Bar to apply the settings and exit the session.

Configuring Email Messages
You may configure the email addressing feature and send a test message to verify
the connection.
To configure email messages
1.

On the More Options tab, click Email Messages.
The Email Messages window appears.

Figure 93.

2.

Touch Screen Email Messages

Provide the following information:
Enable Email Messages. Select this check box to enable email
messaging.
Server type. (Version 2.3 and higher.) Select the server type: custom
SMTP, Live (Hotmail), or Gmail.
Email server (SMTP). Enter the email service provider IP address.
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Username. Enter the user name.
Password. Enter the password.
From address. Provide the email address of the sender. This email
address tells the receiver and the ISP provider who is sending the email.
Note:

The From address is required.
To address. Enter the email address of the person you wish to send a test
message to.

4.7.4

3.

To verify that all of the email service parameters are correct, send a sample
email message by pressing the Send Sample Email Message Now button.

4.

Press OK to apply the settings and exit the Email Message Options
window session or press Cancel to exit without saving the information.

5.

Proceed with another configuration or press Send and Exit from the
Tool Bar to apply the settings and exit the session.

Setting Language Options
1.

On the More Options tab, click Languages. The Language Editor
window appears.

Figure 94.

2.
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Language Editor

Select the language to edit using the drop down menu.
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3.

Once a language has been chosen it can be set as Available for
selection using the check box. At least one language must always be
set as Available for selection and by default this is English. If
more than one language is set as Available for selection an
option appears on the main Touch Screen display to choose between
languages.

4.

A list of messages are listed for each language. A message can be altered
by pressing on the text once to select the message and then pressing on the
text again to edit it.

Note:

If you erase the message, then the associated element on the user
interface screen is hidden.

5.

Press Reset to default to restore all messages to their original
content.

6.

Press OK to apply the selected settings and exit the Language Editor
window or press Cancel to exit without saving any modifications.

Figure 95.

7.

Note:

Language Selection

If multiple languages are enabled the main Touch Screen display will have
a button to select between languages. This will replace the clock as shown
in Figure 95. Press the language button and buttons appear for each
language enabled then press the button corresponding to the language you
wish to select.
With multiple languages enabled the Touch Screen will prompt for
a language choice each time the screen saver clears.
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4.7.5

Setting the Admin Password
The value stored in Admin Password is used by the TX3 Configurator to
connect to a Touch Screen Main Node. This value must match the Touch Screen
administrator password. Specifically, whenever you change the administrator
password on a Touch Screen Main Node (section 2.6 on page 32), you must make
the same change to Admin Password for that Touch Screen Main Node in the
TX3 Configurator.
To set the Admin Password

4.7.6

1.

In the TX3 Configurator, on the More Options tab for the Touch
Screen, click Admin Password.

2.

Enter the administrator password for the Touch Screen in the box.

3.

Click OK.

Customizing Buttons
The functions of the Call Reception and Leave Message buttons on the
Touch Screen main interface (Figure 69) are customizable. By default, the Call
Reception button calls the guard phone. By default, the Leave Message
button opens a window where the visitor can enter a message that is sent to the
resident if Email Messages is configured (section 4.7.3 on page 121).
You can configure these buttons to call a specific dial code instead.
Note:

To change the text on these buttons, see section 4.7.4 on page 122.

To customize buttons
1.

On the More Options tab, click Customize Buttons.

Figure 96.
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Customize Buttons
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2.

On the Call Reception tab, click Customize, then enter the dial
code to call when a visitor presses the Call Reception button.
Click Default to set the Call Reception button to call the guard
phone.

3.

Click the Leave Message tab, then click Customize, then enter the
dial code to call when a visitor presses the Leave Message button.
Click Default to set the Leave Message button to leave an email
message.

4.

4.8

Click OK.

Calibrating the Touch Screen
The TX3 Touch Screen does not require calibration for the initial setup.
However, over time and with continued use it may require re-calibration. The
resistive Touch Screen hardware is controlled by third party software from
PenMount. Calibration cannot be performed remotely and must be performed
locally at each terminal. This section explains how to calibrate the Touch Screen
using the PenMount software.

4.8.1

Calibrating the 15” Touch Screen
The resistive Touch Screen hardware is controlled by third party software from
PenMount. Calibration cannot be performed remotely and must be performed
locally at each terminal. This section explains how to calibrate the Touch Screen
using the PenMount software.
To enter the PenMount Control Panel
To log in to the Touch Screen
1.

At the Touch Screen terminal, enter 9999. The administrator password
window appears.

2.

Enter your administrator password, and then click OK (by default, there is
no password).

3.

From the menu bar select File > Shut Down > Exit to
Windows. Press Yes to confirm.

4.

Press twice on the Desktop icon in the upper left corner of the window.

Figure 97.

Desktop Icon
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5.

Press twice on the PenMount Control Panel icon.

Figure 98.

PenMount Control Panel Icon

The PenMount Control Panel appears.
To calibrate the Touch Screen

Figure 99.

1.
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PenMount Control Panel

From the PenMount Control Panel select the device to configure in the
Device tab. If the device does not appear ensure that it is connected and
turned on, then press Refresh.
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2.

Once the device is selected press Configure. The Device Calibration
window will appear.

Figure 100. PenMount Device Calibration

There are two types of calibration options. For most Touch screens the
Standard Calibration option is sufficient. However, over time,
the Advanced Calibration option may be required. To perform
standard calibration proceed to step 3. To perform advanced calibration
skip to step 4.
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3.

To start standard calibration press on the Standard Calibration
button in the Device Calibration window. The PenMount software will
display a series of four red squares on the screen which must be pressed in
sequence. Use your finger or a stylus to press each square. After each
square is pressed calibration will complete. Skip to step 7.

Figure 101. Standard Calibration
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4.

The Advanced Calibration option can be configured to use between 4 to
25 points of calibration from the Advanced Mode box in the Device
Calibration window. Increasing this value increases the accuracy of the
calibration. From the Advanced Mode box select the number of points of
calibration to use.

5.

The Plot Calibration Data option displays a linearity comparison graph
after advanced calibration has been completed. Black lines on the graph
indicate the ideal linearity while the blue lines show the calculated
linearity. Select Plot Calibration Data to display this graph at the end of
calibration.

6.

To begin the advanced calibration select Advanced Calibration
from the Device Calibration window. The PenMount software will
display a series of red squares on the screen which must be pressed in
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sequence. Use your finger or a stylus to press each square. A stylus is
recommended for increased accuracy. After each square is pressed
calibration will complete.

Figure 102. Advanced Calibration (9 Points)

7.

4.8.2

Once calibration has been completed press OK in the Device Calibration
window. Press OK again in the PenMount Control Panel. Quickly press
twice on the TX3 Touch icon from the desktop to restart the TX3 Touch
software.

Calibrating the 22” Touch Screens
Calibration cannot be performed remotely and must be performed locally at each
terminal. This section explains how to calibrate the Touch Screen using the third
party MT 7 software.
To enter the MT 7 Software Control Panel
1.

At the Touch Screen terminal, enter 9999. The administrator password
window appears.
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2.

Enter your administrator password, and then click OK (by default, there is
no password).

3.

From the menu bar select File > Shut Down > Exit to
Windows. Press Yes to confirm.

4.

Press twice on the Desktop icon in the upper left corner of the window.

Figure 103. Desktop Icon

5.

Press twice on the 3M Touch Calibration folder.

6.

In the 3M Touch Calibration folder, press twice on the Control
Panel icon.

Figure 104. Calibration Control Panel

7.

If a message appears saying that there is a problem with the shortcut, then
follow the instructions starting at To install the MT 7 Software Control
Panel on the next page.
If the Problem with Shortcut window does not appear, then go to
To calibrate the Touch Screen on page 126.

Figure 105. Problem with Shortcut
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To install the MT 7 Software Control Panel
a.
Note:

Connect a USB mouse to the Touch Screen.
Connect a mouse because the touch functionality might stop
working during this process.

b.

Press twice on the setup icon.

Figure 106. setup icon

The MT for Windows Setup Wizard appears.

Figure 107. MT for Windows Setup Wizard
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c.

Scroll to the bottom of the agreement, select I accept the
agreement, and then click Next.

Figure 108. License Agreement

d.
Note:

Follow the instructions to install the calibration software.
Do not change any installation options.

e.

After the installation is complete, press twice on the Control
Panel icon.

f.

Go to To calibrate the Touch Screen below.

To calibrate the Touch Screen

Figure 109. MT 7 Software Control Panel
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1.

From the MT 7 Software Control Panel, click Calibrate.

2.

The MT 7 software displays a series of three green circles on the screen
which must be pressed in sequence. Use your finger or a stylus to press and
hold each circle for a second.

Figure 110. Calibration on the 22” Touch Screens

If you do nothing, calibration will time out and the system will show the
MT 7 Software Control Panel again.
3.

Once calibration is complete, press Accept.

4.

Press Close in the MT 7 Software Control Panel.

5.

Press twice on the Restart icon to restart the TX3 Touch software.

Figure 111. Restart Icon

4.9

Logging into the Touch Screen Terminal Using
Remote Desktop for Troubleshooting
Touch Screen provides you with a facility to access the application remotely
using a Windows PC. This procedure is for troubleshooting.
Using remote access requires that the Touch Screen and all TX3 system
components are networked.
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Remote Access configuration of the Touch Screen also requires that you
complete the configuration by sending the Job to the panel using the Send
command and then restarting the PC using the Restart PC command from the
menu bar.
Note:

Do not use the Send and Exit command when using Remote
Access.

To establish a remote connection
1.

Type Remote Desktop Connection in the Windows Search box,
then press Enter. The Remote Desktop Connection window appears.

Figure 112. Remote Desktop Connection
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2.

Click Show Options. The Remote Desktop Connection Options
window appears showing the General tab.

Figure 113. Remote Desktop Connection - General

3.

Provide information for the following:
Computer. Enter the Touch Screen computer’s IP address.
User name. Enter the user name, admin.
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4.

Click Display. The Display window appears.

Figure 114. Remote Desktop Connection - Display

5.

Set the remote desktop size to 1024 x 768 pixels by dragging the slider.

6.

Click Local Resources. The Local Resources window appears.

Figure 115. Remote Desktop Connection - Local Resources
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7.

Provide information for the following:
Remote audio. Click Settings, then select Play on remote
computer.
Keyboard. From the drop down list select On the remote
computer. This selection allows to use the Alt-Tab control.
Printers. Uncheck Printers. Touch Screen is not connected to a
printer.
Clipboard. Enabling this selection lets you to use the clipboard.

8.

In Local devices and resources, click More.... The Local devices and
resources window appears.

Figure 116. Remote Desktop Connection - Local Devices and
Resources

9.

Unselect the Smart cards check box.

10.

Select the Drives check box. You can now copy files from the local PC
to the remote PC.

11.

Click OK to save the information and return to the previous window, or
click Cancel to exit without saving the changes.

12.

Click General. The General window appears (Figure 113).

13.

Click Save As... to save this configuration to a file on the PC. For
convenience save the file to the desktop.
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14.

Press Connect. The remote computer login window appears.

Figure 117. Remote Desktop Connection - Log On to Windows

15.

Enter the Touch Screen administrator password and click OK.
• With Touch Screen software below version 2.9.10, the password is
blank.
• With Touch Screen software 2.9.10 and above the password is blank if
you have never changed the Touch Screen administrator password
(section 2.6 on page 32).
• If you have Touch Screen software 2.9.10 and above and you have
changed the Touch Screen administrator password (section 2.6 on
page 32), then Remote Access uses the same password.
Once connected the remote desktop Touch Screen window appears giving
you full control of the Touch Screen. In this mode Touch Screen is not
accessible by visitors.

16.

At the Touch Screen terminal, enter 9999. The Touch Screen
administrator password window appears.

17.

Enter your Touch Screen administrator password, and then click OK (by
default, there is no password). The Main Window appears. You are now
ready to begin configuration.

18.

Proceed with the configuration. Once completed click Send.

19.

Click File > Shutdown > Restart. Touch Screen restarts in user
mode and the Remote Access session ends.

To end Remote Access at any time
To exit the Remote Access user session at any time, enter the configuration mode
and click File > Shutdown > Restart.
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Configuring a Telephone Access
System Panel

The TX3 Configurator lets you access, add and modify Telephone Access
System panels. Once you connect to a building panel, you can begin
configuration.
This chapter explains
•

Configuring a Telephone Access System Panel

•

Configuring VOIP (SIP)

•

Configuring Inputs

•

Configuring Outputs

•

Establishing Correlations

•

Adding or Modifying Residents
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5.1

Configuring a Telephone Access System Panel
Configuring a Telephone Access System panel sets the entry panel system
parameters and establishes how inputs are labelled, assigned, defined and
correlated with outputs.
By default Touch Screen has one Telephone Access System panel. Additional
panels may be manually added to the network.
Note:

When adding additional panels ensure the panel model you wish to
add to the Job tree matches the panel you wish to connect to.

Configuring a Telephone Access System lets you:
•

label a panel

•

set the panel options

•

define the phone lines as ADC or NSL

•

set the resident telephone call controls

•

define and assign inputs and outputs

•

correlate events with actions

•

create a schedule

•

create passcodes

•

create hold open times

•

define a limit on postal lock usage

•

set elevator usage if elevator controls are used

•

set custom entry access codes

For information about the installation of the Telephone Access Systems, refer to
the manuals shipped with the system and on the Mircom website
(www.mircom.com).

5.1.1

Labelling a Panel
Labelling a panel lets you specify the panel name and establish its network
address.
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To label a panel
1.

Select a panel. The Panel Configuration window appears.

Figure 118. Panel Configuration

2.

Provide information for the following:
Panel label. Provide a name for the Panel.
Panel model. The application automatically retrieves the selected panel
model information. This field is read only.
RS485 Address. Select the address that matches the RS-485 address of
the Touch Screen’s Telephone Access Controller Board.

3.

5.1.2

Proceed with the rest of the configuration or click Send and Exit
from the Tool Bar to apply the settings and exit the session.

Configuring Calls
Configuring calls lets you specify the call duration, number of rings and call
scheduling.
To configure calls
1.

Select Calls from the Panel Configuration window. The Calls window
appears.

Figure 119. Panel Configuration - Calls
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2.

Provide information for each of the following:
Maximum talk time. Specify the maximum time in seconds the visitor
may communicate with the resident on a single call. After this time, the
panel disconnects.
Maximum number of rings. For NSL lines, specify the number of rings
of each call before the panel reports no answer and hangs up. For ADC
lines, this setting is not used and ring duration is determined by the
maximum talk time.
Allow calls. Use this selection to allow calls to the residents based on the
selected schedule.
Allow unlock. Use this selection to allow the resident to use their phone to
unlock doors during a set schedule.
Allow keyless entry. Use this selection to allow keyless entries during
selected schedule.
Allow postal entry. Use this selection to enable the postal lock during a
set schedule.
Speaker volume. Specify the panel speaker call volume.
Microphone volume. Specify the microphone call sensitivity.

Note:

On Touch Screens with telephone access controller board model
MD-1086, use the speaker and microphone volumes only for
telephone calls (not VOIP calls). Use the Touch Screen
Options (section 4.7 on page 117) to set the volume for
notifications, event prompts and VOIP calls.
On Touch Screens with telephone access controller board model
MD-1245, use the Touch Screen Options (section 4.7 on
page 117) to set the volume for notifications, event prompts and
VOIP calls.
To determine which model of telephone access controller board
you have, see section 12.1.2 on page 272.
Default to. (Version 2.3 and higher on Touch Screens only.) Click a
button to set the optimal call volume settings for that type of Touch Screen
unit.

3.

5.1.3

Proceed with another configuration or click Send and Exit from the
Tool Bar to apply the settings and exit the session.

Optimal Call Volume Settings
Table 2 shows the optimal call volume settings for different TX3 models.
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The speaker and microphone volumes are used only for telephone calls, not
VOIP calls. For volume for the videos, event prompts and VOIP calls see section
4.7 on page 117.
Table 2: Optimal Call Volume Settings

Model

Speaker

Microphone

TX3-TOUCH-F22
TX3-TOUCH-S22

8

7

TX3-TOUCH-F15-A
TX3-TOUCH-S15-A
with MD-986 audio mixer board

4

8

TX3-TOUCH-F15-A
TX3-TOUCH-S15-A
with MD-1105 audio mixer board

7

10

TX3-200-8C-A
TX3-1000-8C-A
TX3-2000-8C-A

9

8

5.1.4

Configuring Messaging on the Configurator
Messages is a Configurator feature that determines how messages and settings
associated with a lobby panel appear on the LCD. This feature is not used by
Touch Screen.
To configure messages
1.

Select Messages from the Panel Configuration window. The Messages
window appears.

Figure 120. Panel Configuration - Messages

2.

Provide information for each the following:
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Display messages in. Select the language to use for welcome messages. A
multiple language selection scrolls sequentially through each message.
Select language to edit. Select the welcome message to edit based on
language.
Font. Select the type of font to use when displaying welcome messages.
This option is only available for the 8-line lobby unit model. This feature
is not used by Touch Screen.
Welcome message lines. Welcome messages shows the instructions in
the specified language. Use this area to make changes to the text. This
feature is not used by Touch Screen.
The up arrow and down arrow symbols are represented in the
Configurator with the following ASCII characters:
•

Up arrow: Å (hold down the Alt key and type 0197 on the numeric
keypad)

•

Down arrow: Æ (hold down the Alt key and type 0198 on the
numeric keypad)

These two characters will appear on the TX3 screen as the correct up and
down arrow symbols.
3.

5.1.5

Proceed with another configuration or click Send and Exit from the
Tool Bar to apply the settings and exit the session.

Configuring Phone Lines and Guard Phone
The Phone Lines window lets you select the resident’s telephone line type as
either ADC or NSL. Up to five lines may be configured.
If a guard phone is installed with the system, in order to use it you must first
activate the guard phone using this window. For a description on how to install
and use the guard phone, see LT-969 TX3 Telephone Access System Installation
and Operation Manual.
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To configure phone lines
1.

Select Phone Lines from the Panel Configuration window. The Phone
Lines window appears.

Figure 121. Panel Configuration - Phone Lines

2.

Provide information for each the following:
Phone lines. Select either not used, ADC or NSL.
Guard phone is connected. Select this check box if the TX3-GPM Guard
Phone Module is installed on this panel

3.

5.1.6

Proceed with another configuration or click Send and Exit from the
Tool Bar to apply the settings and exit the session.

Configuring the Keypad
Configuring the Keypad lets you set permissions for the resident for opening
doors, using call waiting and using the panel during calls.
To configure the keypad
1.

Select Keypad from the Panel Configuration window.
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The Keypad window appears.

Figure 122. Panel Configuration - Keypad

2.

Provide information for each the following:
Open Main door by pressing. Specifies which key on the resident’s
phone unlocks the main door.

Note:

Do not select 4 (this is used to refuse entry or disconnect).
Do not use the same number for the main door, auxiliary door, and
call waiting (call waiting works on NSL systems only).
Unlock door for. Specifies the time duration to unlock the main door.
Open Aux door by pressing. Specifies on Telephone Access Systems the
key to press on the residence phone to unlock the auxiliary door.

Note:

Do not select 4 (this is used to refuse entry or disconnect).
Do not use the same number for the main door, auxiliary door, and
call waiting (call waiting works on NSL systems only).

Note:

If the Telephone Access System Panel has controller board model
MD-1245, do not select 1, 7, or * for Open Main Door by
Pressing and Open Aux Door by Pressing.
To determine which model of telephone access controller board
you have, see section 12.1.2 on page 272.
Unlock door for. Specifies the time duration to unlock the auxiliary door.
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Get call waiting by pressing. Specifies the key to press on the residence
phone to connect to the lobby phone while on an outside call. Do not select
4. This is used to refuse entry or disconnect.
Note:

Get call waiting by pressing works only on NSL
systems.
Enable front panel keypad during calls. Selecting this check box allows
the panel keypad to be used during a call.

3.

5.1.7

Proceed with another configuration or click Send and Exit from the
Tool Bar to apply the settings and exit the session.

Configuring VOIP (SIP)
With software version 2.3 or later, you can configure the TX3 Touch Screen to
make VOIP calls to residents using SIP (Session Initiation Protocol). SIP is a
protocol for controlling phone or video messaging on an IP network. The TX3
Touch Screen is a SIP client and can communicate with other SIP clients through
a SIP server.

5.1.7.1

Requirements
SIP works on the following models:
TX3-TOUCH-F15-B

TX3-TOUCH-F22

TX3-TOUCH-S15B-WR

TX3-TOUCH-F15-C

TX3-TOUCH-F22-C

TX3-TOUCH-S15S-WR

TX3-TOUCH-F15-D

TX3-TOUCH-F22-D

TX3-TOUCH-F15-E

TX3-TOUCH-F22-E

TX3-TOUCH-S15-B

TX3-TOUCH-S22

TX3-TOUCH-S15-C

TX3-TOUCH-S22-C

TX3-TOUCH-S15-D

TX3-TOUCH-S22-D

TX3-TOUCH-S15-E

TX3-TOUCH-S22-E

The TX3 Touch supports the following codecs for SIP calls. The SIP server and
other SIP clients must support one or more of these codecs to work with the TX3
Touch system:
•

Audio codecs: G.722-64k, G.722.2, G.722.1-32K, G.722.1-24K, G.711ALaw-64k

•

Video codecs: H.263, H.263plus
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SIP on the TX3 Touch is compatible with Mircom’s Unified Building Solution,
and the MiEntry mobile app.
5.1.7.2

Configure SIP
To set up SIP, you need:
•

The IP address or URL of the SIP server.

•

The proxy IP address or URL of the SIP server (also called outbound
proxy). Not all SIP servers require this.

•

The SIP username, SIP password, and authorization ID (also called
authorization username) of the Touch Screen. These are configured in the
SIP server. Not all SIP servers require an authorization ID.

•

The SIP username of each resident.

To configure SIP
1.

Select the panel in the job tree.

2.

Click VOIP from the Panel Configuration window.
The VOIP window appears.

Figure 123. VOIP

SIP server. The URL of the SIP server.
SIP username. The SIP username of the Touch Screen.
Password. The SIP password for the Touch Screen.
Proxy server. The proxy server (also called outbound proxy) required by the SIP
server. Not all SIP servers require this.
Authorization ID. The authorization ID (also called authorization username)
for the Touch Screen. Not all SIP servers require this.
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Display name. This name appears on the resident’s SIP phone when the Touch
Screen calls the resident.
Compatibility. Usually, leave this option at the default (Has application
layer gateway). This indicates that your network’s router has a SIP
Application Layer Gateway enabled.
Call sequence. If you select VOIP call first then phone line, the
Touch Screen will try to call the resident’s VOIP number first when a visitor
makes a call. If you select Selectable by caller, the Touch Screen will
prompt the visitor to select either VOIP or PSTN when the visitor makes a call.
Note:

The VOIP call first then phone line option works
only if both a VOIP account and phone line are configured for the
resident.

To set up a resident’s SIP account
1.

Click Residents in the job tree.

2.

Select the resident that you want to set up.

3.

Click Edit/Edit Residents.

4.

Click the VOIP tab.

5.

Type the SIP username of this resident in the SIP username field.

Figure 124. Resident VOIP Setup
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6.

Click OK.

To call a resident’s SIP username

5.1.8

1.

From the main Touch Screen display (see Figure 69 on page 90), select
the resident’s name, and then select Call.

2.

If Selectable by caller is selected under Call Sequence in
the VOIP window (page 149), a window appears with the buttons Voice
Call and VOIP Call. Select VOIP Call.

Configuring the Passcode
Passcodes let you define and set the code to permit panel access. There are three
levels of access. Panel passcode levels 1 and 2 are set by Touch Screen. Passcode
level 3 is read only and is initially set at the panel. All passcodes are 10 digits
long.
To configure the panel passcode
1.

Select Passcode from the Panel Configuration window. The Passcode
window appears.

Figure 125. Panel Configuration - Passcodes

2.

Provide a permission code for each the following:
Level 1. future use.
Level 2. Level 2 provides access to operations without configuration
privileges.
Level 3. Level 3 grants full panel access and is read only. It is initially set
at the panel, but can be changed afterwards using the Monitoring
provision (See section 12.1.1 on page 269). The level 3 passcode is also
the network passcode.
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3.

Note:

5.1.9

Proceed with another configuration or click Send and Exit from the
Tool Bar to apply the settings and exit the session.
At any time if you lose or forget the passcode, call Technical
Support to receive a temporary passcode. This temporary passcode
is only valid for the day it is issued.

Configuring Advanced Functions
Advanced Functions lets you set the date and time for the panel and
specify the main door unlock schedule, elevator restriction time, postal lock use,
phone line type and display scroll speed.
The elevator restriction feature limits building accessibility by granting visitor
access only to the destination floor. This prevents the visitor from accessing nondesignated floors.
The date and time option lets you set the panel clock according to the PC clock.
If installed the postal lock provides mail carriers access to the building. The
building administrator arranges for the installation of this lock with the post
office and defines its usage on a daily or indefinite basis. The “Postal Usage”
function lets you define the maximum usage for the postal lock.
To configure advanced functions
1.

Select Advanced from the Panel Configuration window. The Advanced
window appears.

Figure 126. Panel Configuration - Advanced

2.

Provide information for each the following:
Auto unlock Main Door. Use this selection to unlock the main door
based on the selected schedule.
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Elevator restriction time. Specifies the amount of time an elevator is
accessible for a visitor after the resident grants access. See Chapter 10 on
page 240.
Daily postal lock usage. Specifies the daily limit for postal access. The
range is 1 to 254 and the default is 4. For unlimited usage set the value to
255.
DTMF type. This is set to Tone and is not configurable.
DTMF sensitivity. Set the sensitivity to a level between 1 to 8. The
default is 5. Lower sensitivity levels reduce interference from nearby cell
phones
Echo Reduction. Select a setting to enhance call clarity by reducing the
echo in the room.
Text scroll speed. Specifies the scroll speed for the resident record
directory display on Telephone Access System panels. This option is not
available on Touch Screen.
Voice help. Select this check box to enable voice help for the Telephone
Access System.
Handset. Select this if a handset is connected to the Lobby Control Unit.
3.

Proceed with configuring the Date and Time or click Send and Exit
from the Tool Bar to apply the settings and exit the session.

To set the date and time
1.

Click Date and Time. The Date and Time Options window appears.

Figure 127. Date and Time Options
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2.

Provide information for the following parameters:
Set Date and Time. Selecting this option lets you set the panel clock to a
time other than the PC clock. Every time you access the Set Date and Time
window the current PC time appears.

Figure 128. Set Date and Time

Enable Daylight Savings Time. Select this check box to enable daylight
saving time. When enabled provide the daylight savings start and end time
for the local area.
Adjust panel time for. Provide a value to compensate for the daily drift
away from the true time.

5.2

3.

Click OK to save the information and return to the configuration window,
or click Cancel to exit without saving the changes.

4.

Click Send and Exit from the Tool Bar to apply the settings and exit
the session.

Configuring Inputs
Inputs 1 to 5 are assigned specific functions. Inputs 1 to 3 have pre-defined
functions and connect to specific devices. Inputs 4 and 5 are general purpose
inputs that can be manually assigned (correlated) to activate a general purpose
output.
The application automatically senses the on/off status of connected components.
In order to accurately monitor the functional state of the panel inputs, you must
first define the electrical circuit characteristics of the input.

5.2.1

Inputs 1 to 5
Inputs 1 to 5 are designated as follows:
Input 1. Input 1 connects to the Postal Lock. Activation of this input unlocks the
main door and starts the main door timer. The door locks when the timer expires
or when the door sense input is activated. Daily usage is limited according to a
pre-defined amount. Any attempt to use the postal lock beyond this point causes
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a warning message to appear and the system to return to normal operation.
Input 1 can also, when configured, activate a general purpose output to perform
any required function.
Input 2. Input 2 connects to the fire alarm panel and receives fire notification.
Activation of this input unlocks the main and auxiliary doors. These outputs are
active as long as the fire panel input is active. Input 2 can also, when configured,
activate a general purpose output to perform any required function.
Input 3. Input 3 connects to the door sense switch. Unlocking the main door
activates the main door open timer. Activation of the Main Door Sense locks the
main door and resets the main door open timer. This function is typically used to
prevent ‘tailgating’. Input 3 can also, when configured, activate a general
purpose output to perform any required function.
Input 4. Input 4 is a general purpose input that, when configured, activates a
general purpose output to perform any required function.
Input 5. Input 5 is a general purpose input that, when configured, activates a
general purpose output to perform any required function.
To configure inputs
1.

Select Inputs/Outputs. The Inputs/Outputs Configuration window
appears.

Figure 129. Input Configuration

2.

Click Inputs. A list of the panel inputs appears.

3.

Select an input and provide information for the following parameters:
Label. Use this text box to provide a label name for this panel input. This
information is not stored in the panel and reverts to the state when a Job is
retrieved from the panel.
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Assigned to. Assigned to contains a drop-down list of all assigned
inputs. This option is read only on Telephone Access System panels.
Active state. Active state specifies the state by which it is
considered active. Two selections are presented. Select one of the
following:
Open
Close
Circuit supervision. Circuit supervision specifies the circuit
type and indicates whether the input is supervised. Select one of the
following:
None
Open circuit
Short circuit
Open and short circuit
4.

5.3

Click Add to add the panel and return to the configuration window, or
click Close to exit without saving the changes.

Configuring Outputs
Outputs are programmed for specific functionality, such as specific delay and on/
off times.
The Telephone Access System has the following four panel outputs:
Output 1. Output 1 is a dedicated output that controls the relays for the AC and
DC main door lock strikes.
Output 2. Output 2 is a dedicated output that controls the relay for the auxiliary
door lock strike.
Output 3. Output 3 is a general purpose output that performs any required
function.
Output 4. Output 4 is a general purpose output that performs any required
function.
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To configure outputs
1.

Select Inputs/Outputs. The Inputs/Outputs Configuration window
appears.

Figure 130. Output Configuration

2.

Click Outputs. A list of the panel outputs appears.

3.

Select an output and provide information for the following parameters:
Label. Use this text box to provide a label name for this panel output. This
information is not stored in the panel and reverts to the default state when
a Job is retrieved from the panel.
Assigned to. Assigned to designates the panel output to the device.
From the list select a device. This option is read only on Telephone Access
System panels.
Active state. Active state specifies the state by which it is
considered active. Two selections are presented. Select one of the
following:
Energized. When the device is energized it is considered to be active.
De-energized. When the device is de-energized it is considered to be
active.

4.
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Click Add to add the panel and return to the configuration window, or
click close to exit without saving the changes.
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5.4

Establishing Correlations
Correlations let you establish specific relationships between panel inputs
(events) and outputs (actions). Use Correlations to specify the relationships
between events, actions and schedules.
Note:

All inputs, outputs and schedules must be defined before applying
correlations.

The application shows a list of correlations currently configured to the panel. A
check box appears besides each active correlation. When unchecked, the
correlation is inactive.
You can apply a correlation to a specific panel, to all the panels on the network,
or to a custom correlation target (if you are connected by TCP/IP).
To create a correlation
1.

Select Network > Panel > Correlations. The Correlations
Configuration window appears in the Right Pane.

Figure 131. Correlation Configuration

2.

Route IP Correlations. If the panel is a Touch Screen, there is a Route
IP Correlations checkbox. If the Touch Screen is a Main Node
connecting two RS-485 networks, it does not route correlations from one
network to the other by default. Select this checkbox to make the Touch
Screen share correlations between RS-485 networks.
You can have more than one Touch Screen Main Node on the same RS485 network, but only one Touch Screen Main Node can have this option
selected.

3.

Enhanced Correlation Messages. If the firmware in the job is 3.5 or
above, select this option. If the firmware is lower than version 3.5,
unselect this option.
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4.

Click Add. The Add Correlation window appears.

Figure 132. Add Correlation

5.

Enter the following parameters:
When. This parameter defines the input event that activates an output
action. Select one of the following:
Input is active. Select a panel input from 1 to 5 as defined in section
5.2 on page 153.
Input is normal. The general purpose input becomes inactive.
Call Started. A call to a resident is placed from the lobby.
Call finished. A call to a resident ends.
Call is connected. A call is established.
Access is granted. Resident grants access using their telephone
keypad.
Access is denied. Resident denies access.
Action. Action specifies the type of action to occur for a specific input.
Select one of the following:
Turn ON output
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Turn OFF output
Call Dial Code. Call the dial code 9991 or 9992. This is used for the
emergency phone. See LT-6113 TX3 Emergency Phone Installation
and Operation Manual on http://www.mircom.com.
On panel. On panel applies the action either to one of the panels on
your system or to a group of panels on your system. If, for example, you
have two panels (Panel1 and Panel2) in your TX3 system, you could select
from the following options:
Panel1 - Apply the correlation to Panel1 only.
Panel2 - Apply the correlation to Panel2 only.
All - Apply the correlation to all Telephone Access, Card Access, and
Touch Screen panels on the network.
Custom - Apply the correlation to a custom target. This option is only
available for TCP/IP network connections. When you select this
option, you can click on the Custom button to select from the
following custom targets:

Note:

•

All panels on the RS485 network of the Master Node
(select a Main Node from the list)

•

All Master Nodes only

•

All panels with RS485 address (select the address from the
list)

Correlation signals are not transmitted by Touch Screen Main
Nodes by default. If you plan on using the All or Custom
correlation options, select the Route IP Correlations
checkbox on one of the Main Nodes. See section 5.4 on page 157.
Nano - Apply the correlation to a TX3 Nano. This option is only
available for TCP/IP network connections. When you select this
option, you can click on the Nano button and enter the IP address of a
TX3 Nano. Click Find to find any TX3 Nanos on the network.
Output. Output applies the action to a specific output on the panel.
Select one of the following:
Output3
Output4
For. For represents the duration of the action in minutes and seconds up
to a maximum of 600 minutes. Uncheck the box if you want the action to
continue indefinitely.
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During schedule. This parameter lets you apply this correlation to a
schedule. The two default selections (Always and Never) and any
previously defined schedules are presented.
6.

Click OK to save the information and return to the configuration window,
or click Cancel to exit without saving the changes.

To edit a correlation
1.

Select a correlation and press Edit. The Edit Correlation window
appears.

2.

Provide the information as you would when creating a correlation.

3.

Click Ok to confirm the edit or Cancel to exit and return to the previous
window.

To delete a correlation
1.

Select a correlation and press Delete.

2.

Click Send and Exit from the Tool Bar to apply the settings and exit
the session.

To activate a correlation

5.5

1.

Click on the checkbox beside the correlation.

2.

Click Send and Exit from the Tool Bar to apply the settings and exit
the session.

Adding or Modifying Residents
The application lets you add residents and modify resident information. Adding
the first access panel to the network automatically adds the resident list to the Job
tree.
To facilitate the task of entering a large resident list you can add multiple resident
information at the same time and then edit their automatically generated default
values.
The resident list provides browsing and quick searching capabilities of resident
information and displays the complete residential list when Residents is
selected from the Job tree. Clicking the column header sorts the list by that
column in either ascending or descending order.
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Single residents can be connected to multiple lobby panel units, making it
possible for the resident to be reached from different lobbies.
Note:

All resident information is stored in the panel with the exception of
profile information, which is stored on the PC. See Figure 138.

To find a resident
1.

Select Residents from the Job tree. The Resident Configuration list
appears in the Right Pane.

Figure 133. Resident Configuration List

2.

To find a resident, enter the person's name in the Find box. The resident
list automatically sorts as you type. To refine the search, select a
parameter from the In column list.

3.

Press the Clear button to restore the list back to its full state.

To add a resident:
1.

Select Residents from the Job tree. The Resident Configuration list
appears in the Right Pane (see Figure 133).
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2.

Select Add Residents from the Menu Bar or right click on the
Resident Configuration list. The Add Residents window appears.

Figure 134. Add Residents

3.

Provide information for the following parameters:
Total number of residents to add. Specify the total number of residents
to add.
Connect to panel. Select the panel to add residents to.
Panel phone line. Select the phone line on the panel the resident(s) will
use.

Note:

Ensure that the panel phone line is specified. If the phone line is not
specified, the resident will not be added to the panel.
Resident name. Provide the resident name. If more than one resident is
added at a time, a number will be attached to the names to make them
unique.
Dial code. The dial code is set automatically for each resident based on the
initial starting value.
Keyless entry code. Enter zero to disable the keyless entry code for the
new residents(s). Enter a value other than zero to enable the keyless entry
code for the new residents(s). If enabled, each resident added gets a unique
keyless entry code starting from the value entered and then incrementing
by one for each additional resident.
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Relay code (NSL only). The NSL relay code is set automatically for each
resident based on the initial starting value.
4.

Edit each resident for specific details if multiple residents were added.

5.

Click OK to add a resident and return to the configuration window, or
click close to exit without saving the changes.

To edit a resident’s information
1.

Note:

2.

Select Residents from the Job tree. The Resident Configuration
window appears (Figure 133).
You can edit multiple residents at the same time by selecting
multiple residents then opening the Resident Details window.
Some options may be disabled if their values are resident specific.
To edit a resident’s information, click its row header on the far left or
double click elsewhere on the row. You may also right click and select
Edit Resident. The Resident Details window appears.

Figure 135. Resident Details

3.

Provide the following information:
Name. Enter the resident’s name.
Dial code. Enter the resident’s dial code.
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Apt#. Enter the apartment or suite number.
Hide from directory. Check this box to hide the resident’s name from the
panel directory.
4.

Select Phone lines and provide the following information to
determine which panels will have telephone access:
Lobby Unit. Each lobby unit is shown in a list.
Phone Line. From the list select the telephone line for each lobby unit
(NSL, ADC or not connected).
Phone number. Provide the resident’s phone number. This selection is
available for ADC lines only. Type a comma (,) for a 1 second pause, and
type a semi-colon (;) for a 3 second pause.
On the TX3 Touch Screen, press the Shift key to access the semi-colon
key.
Relay code. Enter the NSL unit relay code associated with the resident.
This selection is available for NSL lines only.
Ring pattern. Select the resident’s phone ring pattern from the list. Each
panel may have its own unique ring. This selection is available for NSL
lines only.

Note:
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If the telephone entry system is connected to a PBX system input
the telephone number as normal followed by a comma for a one
second pause with the extension afterwards. If you need to dial 9 to
obtain an outside line simply input it before the telephone number.
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5.

Select Entry. The Entry window appears.

Figure 136. Resident Details - Entry

6.

Provide the following information to enable the use of resident keyless
entry code:
Keyless entry code. Enter the resident keyless entry code using a number
from 1 to 999999.
Open Main door. Selecting this box opens the main door when the
resident enters their keyless entry code.
Open Aux door. Selecting this box opens the auxiliary door when the
resident enters their keyless entry code.

Note:

By default both the main and auxiliary doors are selected.
Open main door by pressing. Enter a series of up to 4 digits from 0 to 9
followed by pound (#). This code will replace the button set in section
5.1.6 on page 145 for opening the main door. This applies to the specific
resident.

Note:

Do not select 4 (this is used to refuse entry or disconnect).
Do not use the same number for the main door, auxiliary door, and
call waiting (call waiting works on NSL systems only).

TX3 Configuration and Administrator Manual

165

Configuring a Telephone Access System Panel

Open aux door by pressing. Enter a series of up to 4 digits from 0 to 9
followed by pound (#). This code will replace the button set in section
5.1.6 on page 145 for opening the auxiliary door. This applies to the
specific resident.
Note:

Do not select 4 (this is used to refuse entry or disconnect).
Do not use the same number for the main door, auxiliary door, and
call waiting (call waiting works on NSL systems only).

Note:

If the Telephone Access System Panel has controller board model
MD-1245, do not select 1, 7, or * for Open Main Door by
Pressing and Open Aux Door by Pressing.
To determine which model of telephone access controller board
you have, see section 12.1.2 on page 272.

7.

Select VOIP. The VOIP window appears.

8.

Type the SIP username of this resident in the SIP username field.

Figure 137. Resident VOIP Setup
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9.

Click OK.

10.

Select Elevator. For instructions on setting up elevator restriction, see
Chapter 10 on page 240.
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11.

Select Profile. The Profile window appears.

Figure 138. Resident Details - Profile

12.

Provide the following information:
Select a photo. Select the resident’s photo from a directory.
First name. Enter the resident’s first name.
Last name. Enter the resident’s last name.
Email. Enter the resident’s email.

Note:

After you get a job, residents’ email addresses will be blank. If you
want to preserve email addresses, do not use Get Job. See To get
a Job on page 46.
Mobile phone. Enter the resident’s mobile phone number.
Notes. Provide additional notes.
Profile ID. Provide a profile ID.

13.

Click OK to add a resident and return to the configuration window, or click
cancel to exit without saving the changes.
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To delete one or more residents
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1.

Right click one or more residents and then select Delete. Pressing Del
key will achieve the same purpose.

2.

Click Yes to delete a resident and return to the configuration window, or
click No to exit without saving the changes.
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Configuring a Card Access System
Panel

The TX3 Configurator lets you access, add and modify Two Door Controller and
Single Door Controller Card Access System panels. Once you connect to a
building panel, you can begin configuration.
This chapter explains
•

Configuring a Card Access System Panel

•

Custom Card Formats

•

Configuring Access Points

•

Configuring Inputs

•

Configuring Outputs

•

Establishing Correlations

•

Adding or Modifying Cards and Access Levels
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6.1

Configuring a Card Access System Panel
Configuring a Card Access System panel sets the panel system parameters and
establishes how inputs are labelled, assigned, defined and correlated with
outputs.
Note:

When adding additional panels ensure the selected panel matches
the panel you wish to connect to.

Card Access System panel configuration lets you:
•

label a panel

•

set panel options

•

define and assign inputs and outputs

•

correlate events with actions

•

create hold open timers

•

set elevator usage if elevator controls are used

For information about the installation of the Card Access Systems, refer to the
manuals shipped with the system and on the Mircom website
(www.mircom.com).

6.1.1

Labelling a Panel
Labelling a panel lets you specify the panel name and establish its network
address.
To label a panel
1.

Select a panel. The Panel Configuration window appears.

Figure 139. Panel Configuration

2.

Provide information for the following:
Panel label. Provide a name for the Panel.
Panel model. The application automatically retrieves the selected panel
model information. This field is read only.
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Address. The drop down list displays the remaining available panel
addresses. From this list select the panel address. This field is disabled if a
connection is active. Ensure that this address matches the panel address.
Master Node. If you are connected to your TX3 system through TCP/IP,
this option lets you to either configure the panel as a Main Node (select
This is a master from the list) or to specify the Main Node for your panel
(select the Main Node from the list).
Note:

In the Configurator, the terms Master and Main are equivalent.
Test Connection. If you are connected to your TX3 system through TCP/
IP, this option test the connection between your computer and a Main
Node. You can only test a connection to a Main Node panel. You must be
connected to the TX3 system in order to use Test Connection.
IP address. The IP address of your panel if it is a Main Node on a TCP/IP
network. This field only appears if you are connected to your TX3 system
through TCP/IP.

Note:

3.

6.1.2

You cannot change a Main Node’s IP address by editing the IP
address field. To change a Main Node’s IP address, use the IP
Change Tool. See section 3.2 on page 73 for more information.
Proceed with the rest of the configuration or click Send and Exit
from the Tool Bar to apply the settings and exit the session.

Setting the Card Access Panel
The application lets you set and define log reporting, facility code usage,
interlock access and daylight savings time.
See section 1.1.3 for a list of card formats supported by the Card Access System.
Interlock mode is typically used in a double door application to prevent
unauthorised access. During this mode the user presents the card at both doors.
The second door unlocks after presenting the card, if the first door is locked and
closed.
Cards contain facility code and card number information. The Card Access
System is configurable to grant access on the basis of one of the following:
•

facility code only

•

card number only

•

facility code and card number
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To set the card access panel
1.

Click Panel. The Panel Configuration window appears:

Figure 140. Panel Configuration - Card Reader

2.

Provide information for each of the following:
Card format. Select the card reader format for each access point. See
section 1.1.3 on page 14 for a list of card formats supported by the Card
Access System. Select only the formats that are being used. In addition, do
not select more than one format with the same bit length. For example,
select either 36-bit HID Simplex or 36-bit Keyscan, but do not select both.
Card discovery mode. Enable this option, then send the Job to the panel to
put the panel into card discovery mode. While the panel is in card
discovery mode and you present a card to the reader, the panel will display
the card’s raw data in the Online Events pane. To disable the feature,
uncheck Card discovery mode, then send the job to the panel again.
Custom Formats. See section 6.2 on page 174.
Report real time events to PC. Enable or disable real time event sending
to the PC. If enabled, only the real time logs are sent to the PC.
Facility code. Enter the building’s facility code with a value from 0 to
4294967294. Enabling the facility code mode lets you grant access to
cards based on facility code.
Interlock. If enabled door B cannot be unlocked until door A is locked
and closed. Door A cannot be unlocked until door B is locked and closed.
Single door mode. (TX3-CX-1 and TX3-CX-1NP only) If this option is
selected, then the panel controls only one door and both access points
represent the same door.
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If this option is unselected, then the panel operates as a Two Door
Controller and each access point is a separate door.
Date and Time. Select this option to set the date and time of the panel, set
daylight savings time, and to set the panel adjustment time.
3.

Proceed with another configuration or click Send and Exit from the
Tool Bar to apply the settings and exit the session.

To set the daylight saving time
1.

Click Date and Time. The Date and Time Options window appears.

Figure 141. Date and Time Options

2.

Provide information for the following parameters:
Set Date and Time. Selecting this option lets you set the panel clock to a
time other than the PC clock. Every time you access the Set Date and Time
window the current PC time is shown.

Figure 142. Set Date and Time
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Enable Daylight Savings Time. Select this check box to enable daylight
saving time. When enabled provide the daylight savings start and end time
for the local area.
Adjust panel time for. Provide a value to compensate for the daily drift
away from the true time.

6.2

3.

Click OK to save the information and return to the configuration window,
or click Cancel to exit without saving the changes.

4.

Click Send and Exit from the Tool Bar to apply the settings and exit
the session.

Custom Card Formats
The Custom Formats feature lets you create custom card formats.
To create a custom card format
1.

Click Custom Formats.
The Custom Card Detail window appears.

Figure 143. Custom Card Detail

2.

Provide information for each of the following:
Name. Enter a name for the new format.
Bit Length. Specify the number of bits in the format.
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Card Number. Specify the start bit and the bit length for the card number.
This must not overlap the facility code.
Facility Code. Specify the start bit and the bit length for the facility code.
This must not overlap the card number.
The Custom Card Detail window shows a visual representation of the card
code and facility code bits. Figure 144 shows a card format with a bit
length of 20, where the card number is defined by bits 2 to 7, and the
facility code is defined by bits 8 to 13.

Figure 144. Custom card format with a bit length of 20

3.

Click OK.
The new custom card format appears at the bottom of the list of formats.

To create a second custom card format
1.

Click the Add New button.

To delete a custom card format
1.

Click the Delete button.
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6.2.1

Parity
Parity is a form of error detection in data transmission. If the card format uses
parity, then you can specify even parity, odd parity, even parity 1, and odd parity
1 if necessary.
To specify even parity
1.

In the Parity section, specify the position of the even parity bit. This
must not overlap the card number, facility code, or the odd parity bit.

2.

Enter the bit mask of the even parity in hexadecimal notation.
For example, in the custom card format shown in Figure 145, the even
parity bit is 1, and the even parity bit mask is bits 2 to 7. The bit mask is
expressed as 1111110, which is read from right to left. The rightmost bit
represents bit 1, which is not part of the mask, so it is 0. The next 6 bits are
part of the mask, so they are 1. The binary number 1111110 is expressed as
7E in hexadecimal notation.

Figure 145. Custom card format with an even parity mask

To specify odd parity
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1.

Specify the position of the odd parity bit. This must not overlap the card
number, facility code, or the even parity bit.

2.

Enter the bit mask of the odd parity in hexadecimal notation.
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In the same example, the odd parity bit is 14, and the odd parity bit mask is
bits 8 to 13. The bit mask is expressed as 1111110000000, which is read
from right to left. The rightmost 7 bits are not part of the mask, so they are
0. The next 6 bits are part of the mask, so they are 1. The binary number
1111110000000 is represented as 1F80 in hexadecimal notation.
Figure 146 shows the same card format with this odd parity mask.

Figure 146. Custom card format with an odd parity mask

To specify even parity 1 and odd parity 1
1.

Click the Advanced button.
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The Custom Card Detail window shows the even parity 1 and odd parity 1.

Figure 147. Custom Card Detail - Advanced

2.

6.3

Repeat the steps under To specify even parity on page 176 and To specify
odd parity on page 176 for even parity 1 and odd parity 1.

Configuring Access Points
Card readers at access points require additional configuration to specify how
certain access requirements run on a scheduled basis. Access privileges may
have dependencies and consequently may be more suitable to run as a scheduled
task.
To apply schedules, they must be first created using the Schedule Configuration
Window (see Chapter 11).
The auto lock/unlock scheduling for door operation allows free access without
an access card, during specified times and areas.

6.3.1

Access Points on the Two Door Controller
The panel has 2 access points by default.
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•

Reader A is the reader connected to the Wiegand #1 terminal.

•

Reader B is the reader connected to the Wiegand #2 terminal.
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6.3.2

Access Points on the Single Door Controller
When you add a Single Door Controller in the Configurator, it has 2 access points
by default.
•

Reader A is the built-in reader (TX3-CX-1 only).

•

Reader B is the external reader. If you do not have an external card reader,
the system does not use Reader B.

To configure access points on all card access controllers
1.

Expand the Access Point list and click on an access point. The Access
Point Configuration window appears.

Figure 148. Access Point Configuration - Timers

2.

In the Access point label provide a name for the access point.

3.

From the tab select Timers and provide information for each the
following:
Auto-unlock schedule. The auto-unlock schedule lets you specify when
the door will be unlocked. From the list select an auto-unlock schedule.
PIN required schedule. If a card is assigned a PIN, this schedule lets you
specify when to grant access to a card with a PIN. From the list select the
schedule.
Unlock time. Specify the amount of time the door remains unlocked after
granting access.
Extended unlock time. Specify the amount of time the door remains
unlocked for a card assigned with the extended unlock time privilege.
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Door held open warning. Specify the amount of time for the door to stay
open until a warning is issued.
Door held open alarm. Specify the amount of time for the door to stay
open until an alarm is issued.
Anti-passback. Specify the time period in which the same card cannot be
used twice at this reader.
4.

From the tab select Advanced. The Advanced Configuration Window
appears:

Figure 149. Access Point Configuration - Advanced

5.

Provide information for each the following:
High security. Selecting High security grants access only to cards
assigned with the high security privilege.
PC decision required. When enabled the PC decision to grant access is
transferred from the controller to the PC with an attendant. For this option
to work the PC needs to be on all the time. Use this option when the
building has a security desk or a concierge.
Deduct usage count. Selecting this option enables a counter to deduct by
one every time a card is used at this access point. When it reaches zero, the
card is deactivated.
First person in. When enabled the door becomes unlocked by the first
valid card presented during the unlock schedule, causing the door to
remain unlocked for the duration of the unlock schedule. The 'First person
in' option must also be set on the card (see section 9.1.2 on page 232).
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Facility code mode. Enabling the Facility code mode grants access to
cards based on only their facility code. Card holders with the same facility
code are granted access, regardless of their card numbers.
Note:

If you are enabling the facility code mode ensure that the facility
code is set on the panel (see section 6.1.2 on page 171).
Inhibit ID. When enabled the card code is not sent to the PC. This feature
prevents the logging and reporting of cards at this access point.
Timed anti-passback. Selecting this option enables the anti-passback
feature in which the same card cannot be used twice at the same reader
until the anti-pass back time period expires.
Report request to exit. Selecting this option enables the panel to report
‘request to exit events’ to the PC.
Report unknown format. Selecting this option enables the panel to
report ‘unknown card format’ events to the PC.
Report door not open. Selecting this option enables the panel to log and
report ‘door not open’ events to the PC when access is granted but the door
remains closed.
Auto relock. Selecting this option locks the door as soon as the door
closes before the door open timer or extended door timer expire. Disabling
this option locks the door, but only after the expiration of door open timer
or extended door open timer.
RTE bypass DC. Enable this option if there is a mechanical egress device
installed on the door. In this situation, the door is unlocked manually, and
the TX3 system does not unlock the door. If the door is opened, the system
updates the door status and the LED on the reader turns green. The door
contact is bypassed and so there is no forced entry alarm.
Disable forced entry alarm. Selecting this option disables the forced
entry alarm.
Ignore card facility code. Selecting this option grants access to card
holders on the basis of their card numbers and not the card facility code.

6.

Proceed with another configuration or click Send and Exit from the
Tool Bar to apply the settings and exit the session.
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6.4

Configuring Inputs
In order to accurately monitor the functional state of the panel inputs, you must
first define the electrical circuit characteristics of the input (active state and
circuit supervision). For a detailed description of the circuit characteristics see
LT-980 TX3-CX Card Access System Installation and Operation Manual.

6.4.1

Two Door Controller
Each Two Door Controller has eight inputs that can be configured to
accommodate specific events for the following controller functions:
Door contact for reader A or B. An input assigned this function senses if a door
is opened or closed.
Request to exit for reader A or B. An input assigned this function sends a signal
to the controller that a request to exit has been made.
General purpose function. An input assigned this function can activate a
general purpose output to perform any required function or turn on or off the high
security mode.
General door status. An input assigned this function monitors a door for open or
closed status. This door appears in the Access Point Status (section 12.1.3 on
page 273).

6.4.2

Single Door Controller
Each Single Door Controller has 4 programmable inputs that can be configured
to accommodate specific events for the following controller functions:
Door contact. An input assigned this function senses if a door is opened or
closed.
Request to exit. An input assigned this function sends a signal to the controller
that a request to exit has been made.
General purpose. An input assigned this function activates a general purpose
output to perform any required function or turn on or off the high security mode.
General door status. An input assigned this function monitors a door for open or
closed status. This door appears in the Access Point Status (section 12.1.3 on
page 273).
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To configure inputs on all card access controllers
1.

Select Inputs/Outputs. The Input/Output Configuration window
appears.

Figure 150. Input Configuration

2.

Click Inputs. A list of the panel inputs appears.

3.

Select an input and provide information for the following parameters:
Label. Use this text box to provide a name for the input.
Assigned to. Select an input from the menu (for example, Door
contact or Request to exit). Select General door status
to make the input monitor a door for open or closed status. This door
appears in the Access Point Status (section 12.1.3 on page 273).
Active state. Active state specifies the state by which it is
considered active. Two selections are presented. Select one of the
following:
Open
Close
Circuit supervision. Circuit supervision specifies the circuit
type and indicates whether the input is supervised. Select one of the
following:
None
Open circuit
Short circuit
Open and short circuit
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Alarm delay. The Configurator shows the panel as being in an alarm state
when the input becomes active. Alarm delay specifies the amount of
time to wait before raising the alarm condition. This option is only
available to card access and Aperio Door Controller panels.
4.

6.5

When you have finished making all of the configuration changes for your
panel, connect to your panel, and then send the job to the panel.

Configuring Outputs
For a detailed description of the circuit characteristics see LT-980 TX3-CX Card
Access System Installation and Operation Manual.

6.5.1

Configuring Outputs on a Two Door Controller
By default output 1 is assigned to Reader A lock with an energized active state.
When access is granted this output unlocks the main door.
Whenever you configure an output, the active state of the output must be defined
as a function of the device it attaches. When the device is energized it is
considered to be active. When the device is de-energized it is considered to be
inactive.
Each card access controller has eight outputs that can be configured to
accommodate specific actions for the following controller functions:
Lock for reader A or B. This output is assigned to either reader A or B to unlock
the main door. When access is granted at the designated reader, this output
unlocks the door.
Handicap lock for reader A or B. This output is assigned to either reader A or
B to unlock the accessible door. When access is granted at the designated reader,
this output unlocks the door. Access is granted to cards with designated handicap
privileges.
General purpose output. An output assigned this function can perform any
required function, such as turning on a light.
Outputs 1 to 8 have the following default settings:
Output 1. Lock for reader A
Output 2. Reader A handicap
Output 3. General Purpose
Output 4. General Purpose
Output 5. Lock for reader B
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Output 6. Reader B handicap
Output 7. General Purpose
Output 8. General Purpose
To configure outputs on a Two Door Controller
1.

Select Inputs/Outputs. The Inputs/Outputs Configuration window
appears.

Figure 151. Output Configuration

2.

Click Outputs. A list of the panel outputs appears.

3.

Select an output and provide information for the following parameters:
Label. Use this text box to provide a label name for this panel input.
Assigned to. Assigned to designates the output to a specific controller
function. From the list select one of the following controller functions.
Reader A lock.
Reader B lock
Reader A handicap
Reader B handicap
General Purpose
Active state. Active state specifies the state by which it is
considered active. Two selections are presented. Select one of the
following:
Energized. When the device is energized it is considered to be active.
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De-energized. When the device is de-energized it is considered to be
active.
When you have finished making all of the configuration changes for your
panel, connect to your panel, and then send the job to the panel.

6.5.2

Configuring Outputs on a Single Door Controller
If single door mode is enabled, outputs 1, 2 and 3 are configured as follows:
Output 1: Lock. Connect this output to a door strike. By default output 1
has an energized active state. When access is granted, this output unlocks
the door.
Output 2: General purpose. An output assigned this function can
perform any required function, such as turning on a light.
Output 3: General purpose. This output can power a door strike or a
maglock.
To configure outputs on a Single Door Controller
1.

Select Inputs/Outputs. The Inputs/Outputs Configuration window
appears.

Figure 152. Output Configuration

2.

Click Outputs. A list of the panel outputs appears.

3.

Select an output and provide information for the following parameters:
Label. Use this text box to provide a label name for this panel input.
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Assigned to. Select a function from the menu (for example, Lock or
Handicap).
Note:

For output 3, select Lock if you want output 3 to power a door
strike or a maglock.
Active state. Active state specifies the state by which it is
considered active. Two selections are presented. Select one of the
following:
Energized. When the device is energized it is considered to be active.
De-energized. When the device is de-energized it is considered to be
active.

Note:
•

6.6

For output 3, select Energized for a door strike or
De-energized for a maglock.
When you have finished making all of the configuration changes for your
panel, connect to your panel, and then send the job to the panel.

Establishing Correlations
Correlations let you establish specific relationships between panel inputs
(events) and outputs (actions). Use Correlations to specify the relationships
between events, actions and schedules.
Note:

All inputs, outputs and schedules must be defined before applying
correlations.

The application shows a particular Job with a list of correlations currently
configured to a panel. A check box appears besides each correlation. When
unchecked, the correlation is inactive.
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To create a correlation
1.

Select Network > Panel > Correlations. The Correlations
Configuration window appears in the Right Pane.

Figure 153. Correlation Configuration

2.

Click Add. The Add Correlation window appears.

Figure 154. Add Correlation
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3.

Enter the following parameters:
When. This parameter defines the input event. Select one of the
following:
Access is granted. Access is granted.
Access is denied. Access is denied.
Forced entry alarm. A door is forced open.
Forced entry alarm restored. The forced entry alarm is restored.
Door held open alarm. A door did not close and the door held open
alarm was issued.
Door held open alarm restored. The door held open alarm is
restored.
Door held open warning. A door did not close and the door held open
warning was issued.
Door held open warning restored. The door held open warning was
restored.
Door not open. Access granted but the door remains closed.
Request to Exit. A request to exit has been made.
Input is active. Select a panel input from 1 to 8 as defined in section
6.4 on page 182.
Input is normal. The general purpose input becomes inactive.
Unlock mode is on. When in unlock mode the door is unlocked.
Unlock mode is off. When in lock mode the door is locked.
High security is on. When enabled only access cards with this
privilege are able to open the door.
High security is off. When disabled all access cards are able to open
the door.
Tamper detected. (TX3-CX-1 and TX3-CX-1NP) The tamper alarm
is on.
Tamper restored. (TX3-CX-1 and TX3-CX-1NP) The tamper alarm
is off.
At access point/Input label. This parameter defines the access point or
input.
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Action. Action specifies the type of action to occur for a specific input.
Select one of the following:
Turn ON output. When enabled the output assigned a specific
function performs the required action.
Turn OFF output. When disabled the output assigned this specific
function does not perform the designated action.
Turn ON high security. When enabled only access cards with this
privilege are able to open the door.
Turn OFF high security. When disabled all access cards are able to
open the door.
On panel. On panel applies the action either to one of the panels on
your system or to a group of panels on your system. If, for example, you
have two panels (Panel1 and Panel2) in your TX3 system, you could select
from the following options:
Panel1 - Apply the correlation to Panel1 only.
Panel2 - Apply the correlation to Panel2 only.
All - Apply the correlation to all Telephone Access, Card Access, and
Touch Screen panels on the network.
Custom - Apply the correlation to a custom target. This option is only
available for TCP/IP network connections. When you select this
option, you can click on the Custom button to select from the
following custom targets:

Note:

•

All panels on the RS485 network of the Master Node
(select a Main Node from the list)

•

All Master Nodes only

•

All panels with RS485 address (select the address from the
list)

Correlation signals are not transmitted by Touch Screen Main
Nodes by default. If you plan on using the All or Custom
correlation options, select the Route IP Correlations
checkbox on one of the Main Nodes. See section 5.4 on page 157.
Nano - Apply the correlation to a TX3 Nano. This option is only
available for TCP/IP network connections. When you select this
option, you can click on the Nano button and enter the IP address of a
TX3 Nano. Click Find to find any TX3 Nanos on the network.
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Output. This parameter applies the action to a specific output or access
point on the panel. For an output to appear on this list it must be designated
as a general purpose output. For a reader to appear on this list the output
must be assigned to a reader. For a Job that uses two outputs and two
readers on a Two Door Controller, select one of the following:
Output 3
Output 4
Reader A
Reader B
For. For represents the duration of the action in minutes and seconds up
to a maximum of 600 minutes. Uncheck the box if you want the action to
continue indefinitely.
During schedule. This parameter lets you apply this correlation to a predefined schedule. For a schedule to appear on this list it must be created
(see Chapter 11).
4.

When you have finished making all of the configuration changes for your
panel, connect to your panel, and then send the job to the panel.

To edit a correlation
1.

Select a correlation and press Edit. The Edit Correlation window
appears.

2.

Provide the information as you would when creating a correlation.

3.

Click Ok to save your edits.

4.

Connect to your panel, and then send the job to the panel.

To delete a correlation
1.

Select a correlation and press Delete.
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2.

Connect to your panel, and then send the job to the panel.

To activate a correlation
1.

Click on the check box beside the correlation as shown in Figure 155.

Figure 155. Correlation activation

2.

6.7

Connect to your panel, and then send the job to the panel.

Adding or Modifying Cards and Access Levels
Cards and Access Levels appear as entries in the Job tree after you have
added either a Card Access System panel or an Aperio Door Controller panel.
Cards have to be added to added to the job and given the appropriate access level
in order for access to be granted at an access point.
See Chapter 9 on page 228 for information on how to manage cards and access
levels in your job.
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Configuring an Aperio Door
Controller Panel

The TX3 Configurator lets you access, add, modify, configure, and monitor
Aperio™ Door Controller panels and wireless locksets.
This chapter explains
•

Configuring an Aperio Door Controller Panel

•

Configuring Inputs

•

Configuring Outputs

•

Establishing Correlations

•

Adding or Modifying Cards
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7.1

Configuring an Aperio Door Controller Panel
Configuring an Aperio Door Controller panel sets the panel system parameters
and establishes how inputs are labelled, assigned, defined and correlated with
outputs.
Note:

When adding additional panels ensure the selected panel matches
the panel you wish to connect to.

Aperio Door Controller panel configuration lets you:
•

label a panel

•

set panel options

•

add and configure access points (wireless locksets)

•

define and assign inputs and outputs

•

correlate events with actions

•

create hold open timers

•

set elevator usage if elevator controls are used

For information about the installation of the Aperio Door Controllers, refer to the
manuals shipped with the system and on the Mircom website
(www.mircom.com).
Note:

7.1.1

The terms “access point”, “wireless lockset”, and “lockset” all refer
to Aperio wireless locksets and sensors in this chapter. To avoid
confusion, the terms “wireless lockset” and “lockset” are used to
refer to the Aperio wireless lockset and sensor hardware (for
example, “swipe a card at the wireless lockset”) and the term
“access point” is used to refer to the software representation of an
Aperio wireless lockset in the TX3 Configurator software (for
example, “configure the timers for an access point” or “right-click
on the access point”).

Labelling a Panel
Labelling a panel lets you specify the panel name and establish its network
address.
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To label a panel
1.

Select a panel. The Panel Configuration window appears.

Figure 156. Panel Configuration

2.

Provide information for the following:
Panel label. Provide a name for the Panel.
Panel model. The application automatically retrieves the selected panel
model information. This field is read only.
Address. The drop down list displays the remaining available panel
addresses. From this list select the panel address. This field is disabled if a
connection is active. Ensure that this address matches the panel address.
Master Node. If you are connected to your TX3 system through TCP/IP,
this option lets you either configure the panel as a Main Node (select This
is a master from the list) or specify the Main Node for your panel (select
the Main Node from the list).

Note:

In the Configurator, the terms Master and Main are equivalent.
Test Connection. This option tests the connection between your
computer and a Main Node. You can only test the connection to a Main
Node panel. You must be connected to the TX3 system in order to use
Test Connection.
IP address. The IP address of your panel if it is a Main Node on a TCP/IP
network. This field only appears if you are connected to your TX3 system
through TCP/IP.

Note:

You cannot change a Main Node’s IP address by editing the IP
address field. To change a Main Node’s IP address, use the IP
Change Tool. See section 3.2 on page 73 for more information.
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3.

7.1.2

Proceed with the rest of the configuration or click Send and Exit
from the Tool Bar to apply the settings and exit the session.

Setting the Aperio Door Controller Panel
The application lets you set and define log reporting, facility code usage, and
daylight savings time.
See section 1.1.3 for a list of card formats supported by the Aperio Door
Controller.
Interlock mode is not available for Aperio Door Controllers.
Cards contain facility code and card number information. The Aperio Door
Controller is configurable to grant access on the basis of one of the following:
•

facility code only

•

card number only

•

facility code and card number

To set the Aperio Door Controller panel
1.

Click on the Aperio Door Controller panel. The Panel Configuration
window appears:

Figure 157. Panel Configuration - Card Reader
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2.

Provide information for each of the following:
Card format. Select the card reader format for each access point. See
section 1.1.3 for a list of card formats supported. Select only the formats
that are being used. In addition, do not select more than one format with
the same bit length. For example, select either 37-bit Mircom or 37-bit
HID 10304, but do not select both.
Card discovery mode. Enable this option, then send the Job to the panel
to put the panel into card discovery mode. While the panel is in card
discovery mode and you present a card to the reader, the panel will display
the card’s raw data in the Online Events pane. To disable the feature,
uncheck Card discovery mode, then send the job to the panel again.
Custom Formats. See section 6.2 on page 174.
Report real time events to PC. Enable or disable real time event sending
to the PC. If enabled, only the real time logs are sent to the PC.
Facility code. Enter the building’s facility code with a value from 0 to
4294967294. Enabling the facility code mode lets you grant access to
cards based on facility code.
Date and Time button. Select this option to set the date and time of the
panel, set daylight savings time, and to set the panel adjustment time.
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3.

Proceed with another configuration or click Send and Exit from the
Tool Bar to apply the settings and exit the session.

To set the daylight saving time
1.

Click Date and Time. The Date and Time Options window appears.

Figure 158. Date and Time Options

2.

Provide information for the following parameters:
Set Date and Time. Selecting this option lets you set the panel clock to a
time other than the PC clock. Every time you access the Set Date and Time
window the current PC time is shown.

Figure 159. Set New Date and Time

Enable Daylight Savings Time. Select this check box to enable daylight
saving time. When enabled provide the daylight savings start and end time
for the local area.
Adjust panel time for. Provide a value to compensate for the daily drift
away from the true time.
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7.1.3

3.

Click OK to save the information and return to the configuration window,
or click Cancel to exit without saving the changes.

4.

Click Send and Exit from the Tool Bar to apply the settings and exit
the session.

Adding Access Points to Aperio Door Controllers
Aperio Door Controllers can be configured with up to 8 wireless locksets (access
points). When you add a new Aperio Door Controller panel to your job, you have
to add one access point for each wireless lockset that the panel controls. For
example, if you installed an Aperio Door Controller with 2 Aperio hubs and
paired 3 locksets to each of the hubs, you will need to add 6 access points to your
panel in the TX3 Configurator.
For more information about installing Aperio Door Controllers, Aperio hubs,
and wireless locksets as well as how to pair a wireless lockset with an Aperio hub,
see LT-1160 (TX3-CX-A8 Aperio Door Controller System Installation and
Operation Manual).
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To add an access point to an Aperio Door Controller
1.

Right-click on the Aperio Door Controller panel, and then select Add
Access Point.
A new access point is added and the Access Point Configuration window
opens (see Figure 160). The Configurator automatically assigns values for
the Hub Address and the Lock Address. In the following steps you will
change these values to match the Hub and Lock Addresses programmed
into your wireless lockset.

Figure 160. The Access Point Configuration window

2.

Select the Hub Address of the Aperio hub that the new lockset is paired to.
The Hub Address is the same as the RS-485 address setting for the Aperio
hub.

3.
Note:
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Select the Lock Address for the new access point.
In order for the Aperio Door Controller panel to control the access
point, the Hub Address and the Lock Address values must match
the values programmed into the wireless lockset. If you do not
know the Hub Address and Lock Address for your lockset, use the
Aperio Programming Application to find them. See the wireless
lockset pairing instructions in LT-1160 for details on how to do this.

4.

Select the model of your wireless lockset from the Lock Type list.

5.

In the Access point label text box, enter a name for the access
point.
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7.1.4

Setting Access Point Options
Access points require additional configuration to specify how certain access
requirements run on a scheduled basis. Access privileges may have
dependencies and consequently may be more suitable to run as a scheduled task.
To apply schedules, they must be first created using the Schedule Configuration
Window (see Chapter 11).
The auto lock/unlock scheduling for door operation allows free access without
an access card during specified times and areas.
Note:

The wireless locksets must have the remote open option activated in
order for the auto unlock schedule to work. Information on how to
activate remote open can be found in the Enabling Remote Open
section of LT-1160.

To set access point options
1.

Expand the Access Point list and click on an access point. The Access
Point Configuration window appears.

Figure 161. Access Point Configuration - Timers

2.

Select Timers and provide information for each the following:
Auto-unlock schedule. The auto-unlock schedule lets you specify when
the door will be unlocked. From the list select a schedule.
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PIN required schedule. If a card is assigned a PIN, this schedule lets you
specify when to grant access to a card with a PIN. From the list select a
schedule.
Unlock time. Specify the amount of time the door remains unlocked after
granting access.
Extended unlock time. Specify the amount of time the door remains
unlocked for a card assigned with the extended unlock time privilege.
Door held open warning. Specify the amount of time for the door to stay
open until a warning is issued.
Door held open alarm. Specify the amount of time for the door to stay
open until an alarm is issued.
Anti-passback. Specify the time period in which the same card cannot be
used twice at this reader.
High Security Swipe Timer. A card with the high security privilege can
switch an access point to high security mode. To do this, the card must be
swiped four times in succession at the access point. This timer specifies
the time period in which these swipes must occur.
Lock/Unlock Swipe Timer. A card with the lock/unlock privilege can
toggle an access point between lock and unlock mode. To do this, the card
must be swiped two times in succession at the access point. This timer
specifies the time period in which these swipes must occur.
Pin Timeout. If a card is swiped during the PIN required schedule, the
card holder must enter the card’s PIN at the lockset in order to gain access.
This timer specifies the time period in which the PIN must be entered.
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3.

Select the Advanced tab. The Advanced Configuration Window
appears:

Figure 162. Access Point Configuration - Advanced

4.

Select from the following options for your access point:
High security. Selecting High security grants access only to cards
assigned with the high security privilege.
PC decision required. This option is not available for Aperio wireless
locksets.
Deduct usage count. Selecting this option enables a counter to deduct by
one every time a card is used at this access point. When it reaches zero, the
card is deactivated.
First person in. When enabled the door becomes unlocked by the first
valid card presented during the unlock schedule, causing the door to
remain unlocked for the duration of the unlock schedule. The 'First person
in' option must also be set on the card (see section 9.1.2 on page 232).
Facility code mode. Enabling the Facility code mode grants access to
cards based on only their facility code. Card holders with the same facility
code are granted access, regardless of their card numbers.

Note:

If you are enabling the facility code mode ensure that the facility
code is set on the panel (see section 7.1.2 on page 196).
Inhibit ID. When enabled the card code is not send to the PC. This feature
prevents the logging and reporting of cards at this access point.
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Timed anti-passback. Selecting this option enables the anti-passback
feature in which the same card cannot be used twice at the same reader
until the anti-pass back time period expires.
Report Not Initialized. If an Aperio wireless lockset is not initialized,
this is detected by the Aperio hub to which it is paired. Select this option to
have the TX3 Configurator log and report locksets that are not initialized.
Report request to exit. Selecting this option enables the panel to report
‘request to exit events’ to the PC.
Report unknown format. Selecting this option enables the panel to
report ‘unknown card format’ events to the PC.
Report door not open. Selecting this option enables the panel to log and
report ‘door not open’ events to the PC when access is granted but the door
remains closed.
Auto relock. This option is not available for Aperio wireless locksets.
RTE bypass DC. This option is not available for Aperio wireless
locksets.
Disable forced entry alarm. Selecting this option disables the forced
entry alarm.
Ignore card facility code. Selecting this option grants access to card
holders on the basis of their card numbers and not the card facility code.
5.

7.2

Proceed with another configuration or click Send and Exit from the
Tool Bar to apply the settings and exit the session.

Configuring Inputs
Each Aperio door controller has eight general purpose inputs. Inputs are used in
correlations (see section 7.4 on page 207) to trigger an action based on the state of
the input. For example, a correlation can be written to turn on one of the general
purpose outputs or to turn on high security mode when an input becomes active.
In order to accurately monitor the functional state of the panel inputs, you must
first define the electrical circuit characteristics of the input (active state and
circuit supervision). For a detailed description of the circuit characteristics see
LT-1160 TX3-CX-A8 Aperio Door Controller System Installation and
Operation Manual.
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To configure inputs
1.

Select Inputs/Outputs. The Input/Output Configuration window
appears.

Figure 163. Input Configuration

2.

Click Inputs. A list of the panel inputs appears.

3.

Select an input and provide information for the following parameters:
Label. Use this text box to provide a name for the input.
Assigned to. This is not configurable. All Aperio Door Controller inputs
are general purpose inputs.
Active state. Active state specifies the state by which it is
considered active. Two selections are presented. Select one of the
following:
Open
Close
Circuit supervision. Circuit supervision specifies the circuit
type and indicates whether the input is supervised. Select one of the
following:
None
Open circuit
Short circuit
Open and short circuit
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Alarm delay. The Configurator shows the panel as being in an alarm state
when the input becomes active. Alarm delay specifies the amount of
time to wait before raising the alarm condition. This option is only
available to card access and Aperio Door Controller panels.
4.

7.3

When you have finished making all of the configuration changes for your
panel, connect to your panel, and then send the job to the panel.

Configuring Outputs
Each Aperio Door Controller has eight general purpose outputs. These outputs
can be turned off or on when an event occurs suing a correlation correlations (see
section 7.4 on page 207). For example, a correlation can be written to turn on one
of the general purpose outputs when a particular input becomes active.
Whenever you configure an output, the active state of the output must be defined
as a function of the device it attaches. When the device is energized it is
considered to be active. When the device is de-energized it is considered to be
inactive.
Outputs 1 to 6 are dry relay contacts.
Outputs 7 and 8 are programmable.
Note:

If one or both of outputs 7 and 8 are used to provide power to Aperio
hubs, do not include the output(s) in any of your correlations.

To configure outputs
1.

Select Inputs/Outputs. The Inputs/Outputs Configuration window
appears.

Figure 164. Output Configuration
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2.

Click Outputs. A list of the panel outputs appears.

3.

Select an output and provide information for the following parameters:
Label. Use this text box to provide a label name for this panel input.
Assigned to. This is not configurable. All Aperio Door Controller inputs
are general purpose inputs.
Active state. Active state specifies the state by which it is
considered active. Two selections are presented. Select one of the
following:
Energized. When the device is energized it is considered to be active.
De-energized. When the device is de-energized it is considered to be
active.

4.

7.4

When you have finished making all of the configuration changes for your
panel, connect to your panel, and then send the job to the panel.

Establishing Correlations
Correlations let you establish specific relationships between panel inputs
(events) and outputs (actions). Use Correlations to specify the relationships
between events, actions and schedules.
Note:

All inputs, outputs and schedules must be defined before applying
correlations.

The application shows a particular Job with a list of correlations currently
configured to a panel. A check box appears besides each correlation. When
unchecked, the correlation is inactive.
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To create a correlation
1.

Select Network > Panel > Correlations. The Correlations
Configuration window appears in the Right Pane.

Figure 165. Correlation Configuration

2.

Click Add. The Add Correlation window appears.

Figure 166. Add Correlation
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3.

Enter the following parameters:
When. This parameter defines the input event. Select one of the
following:
Access is granted. Access is granted.
Access is denied. Access is denied.
Forced entry alarm. A door is forced open.
Forced entry alarm restored. The forced entry alarm is restored.
Door held open alarm. A door did not close.
Door held open alarm restored. The door held open alarm is
restored.
Door held open warning. A door did not close and the door held open
warning was issued.
Door held open warning restored. The door held open warning was
restored.
Door not open. Access granted but the door remains closed.
Request to Exit. A request to exit has been made.
Input is active. Select a panel input from 1 to 8 as defined in section
7.2 on page 204.
Input is normal. The general purpose input becomes inactive.
Unlock mode is on. When in unlock mode the door is unlocked.
Unlock mode is off. When in lock mode the door is locked.
High security is on. When enabled only access cards with this
privilege are able to open the door.
High security is off. When disabled all access cards are able to open
the door.
Tamper detected. The lockset is in a tamper state.
Tamper restored. The tamper state at the lockset has been cleared.
Battery is normal. The battery at the lockset has returned to a normal state.
Battery is low. The battery at the lockset is low.
Battery is flat. The battery at the lockset is flat.
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Lockset is offline. The lockset is not communicating with its Aperio
hub.
Lockset is online. The lockset has resumed communicating with its
Aperio hub.
At access point/Input label. Select the access point or input where the
event has occurred.
Action. Action specifies the type of action to take for the specific input.
Select one of the following:
Turn ON output. When enabled the output assigned a specific
function performs the required action.
Turn OFF output. When disabled the output assigned this specific
function does not perform the designated action.
Turn ON high security. When enabled only access cards with this
privilege are able to open the door.
Turn OFF high security. When disabled all access cards are able to
open the door.
On panel. On panel applies the action either to one of the panels on
your system or to a group of panels on your system. If, for example, you
have two panels (Panel1 and Panel2) in your TX3 system, you could select
from the following options:
Panel1 - Apply the correlation to Panel1 only.
Panel2 - Apply the correlation to Panel2 only.
All - Apply the correlation to all Telephone Access, Card Access,
Aperio Door Controller, and Touch Screen panels on the network.
Custom - Apply the correlation to a custom target. This option is only
available for TCP/IP network connections. When you select this
option, you can click on the Custom button to select from the
following custom targets:

Note:
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•

All panels on the RS485 network of the Master Node
(select a Main Node from the list)

•

All Master Nodes only

•

All panels with RS485 address (select the address from the
list)

Correlation signals are not transmitted by Touch Screen Main
Nodes by default. If you plan on using the All or Custom
correlation options, select the Route IP Correlations
checkbox on one of the Main Nodes. See section 5.4 on page 157.
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Nano - Apply the correlation to a TX3 Nano. This option is only
available for TCP/IP network connections. When you select this
option, you can click on the Nano button and enter the IP address of a
TX3 Nano. Click Find to find any TX3 Nanos on the network.
Output/At access point. This parameter applies the action to a specific
output or access point on the selected panel(s). For an output to appear on
this list it must be designated as a general purpose output on its panel. For
an access point to appear on this list the output must be assigned to a
reader.
Note:

If one or both of outputs 7 and 8 are used to provide power to Aperio
hubs, do not include the output(s) in any of your correlations.
For. For represents the duration of the action in minutes and seconds up
to a maximum of 600 minutes. Uncheck the box if you want the action to
continue indefinitely.
During schedule. This parameter lets you apply this correlation to a predefined schedule. For a schedule to appear on this list it must be created
(see Chapter 11).

4.

When you have finished making all of the configuration changes for your
panel, connect to your panel, and then send the job to the panel.

To edit a correlation
1.

Select a correlation and press Edit. The Edit Correlation window
appears.

2.

Provide the information as you would when creating a correlation.

3.

Click OK to save your changes.

4.

Connect to your panel, and then send the job to the panel.

To delete a correlation
1.

Select a correlation and press Delete.
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2.

Connect to your panel, and then send the job to the panel.

To activate a correlation
1.

Click on the check box beside the correlation as shown in Figure 167.

Figure 167. Correlation activation

2.

7.5

Connect to your panel, and then send the job to the panel.

Adding or Modifying Cards
Cards and Access Levels appear as entries in the Job tree after you have
added either a Card Access System panel or an Aperio Door Controller panel.
Cards have to be added to added to the job and given the appropriate access level
in order for access to be granted at an access point.
See Chapter 9 for information on how to manage cards and access levels in your
job.

212

TX3 Configuration and Administrator Manual

8

Remote Access

This chapter provides information on how to access one or more Main Nodes
over the Internet using port forwarding.
Note:

You must use the TX3 Configurator version 2.1.8 or higher for
remote access of Main Nodes using port forwarding.

This chapter explains
•

Overview

•

Get the IP Addresses, RS-485 Addresses, and MAC addresses of the Main
Nodes

•

Access one Main Node over the Internet

•

Access multiple Main Nodes over the Internet with Multiple Global IP
Addresses

•

Access one or more Main Nodes over the Internet with one Global IP
Address
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8.1

Overview
A TX3 network is connected to the Internet by a router. In order to access Main
Nodes on the TX3 network over the Internet, the router must be configured to
map IP addresses and ports correctly.
Main Node: A Main Node is a TX3 device that is connected to an IP network.
Router: A router is a device that communicates between a local area network
(like a TX3 network) and the rest of the Internet.
Local PC: Use a PC or laptop connected to the same network as the Main Node
in order to configure the router and find the IP addresses of the Main Node. You
can disconnect the local PC after the configuration is complete.
Remote PC: Use the remote PC to access the Main Node over the Internet.
IP address: An IP address is a series of four numbers separated by periods (for
instance, 10.10.8.2) which identifies a device on an IP network. IP addresses can
be local (used within the local network) or global (assigned by the Internet
service provider and used on the Internet). Each Main Node on a TX3 network
has a local IP address which is used within the TX3 network. The router maps the
local IP addresses onto global IP addresses so that the Main Nodes can be
accessed over the Internet.
Port: A port is a number associated with an IP address and used by a specific
application. Ports are like telephone extensions. Just as one telephone number
can have many extensions, one IP address can have many ports, where each port
is used by a different application. For example, the TX3 Configurator uses port
8080 to communicate with Touch Screen Main Nodes, and port 14000 to
communicate with non-Touch Screen Main Nodes.

8.2

Get the IP Addresses, RS-485 Addresses, and
MAC addresses of the Main Nodes
To configure remote access you must first get the IP addresses, RS-485
addresses, and MAC addresses of the Main Nodes.
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1.

Connect a PC or laptop (the local PC) and the TX3 Main Nodes to the
same network.

2.

On the local PC, open the TX3 Configurator.

3.

Click Tools, then IP Change Tool.
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The IP Change Tool window opens. This window shows all the Main
Nodes on the TCP/IP network and their IP addresses.

Figure 168. IP Change Tool

4.

Make a note of the IP address, RS-485 address, and MAC address of the
Main Nodes that you want to configure. You will need this information in
the next steps.

Note:
5.

Do not change any information in the IP Change Tool window.
Follow the instructions below depending on the kind of router you have
and the number of Main Nodes you have:
•

You want to access one Main Node over the Internet and you have
a router that can forward one global IP address to one local IP
address on the same port. Go to section 8.3 on page 216.

•

You want to access multiple Main Nodes over the Internet using
multiple global IP addresses and you have a router that supports
multiple external interfaces. Go to section 8.4 on page 219.

•

You want to access one or more Main Nodes over the Internet using
one global IP address and you have a router that can forward
multiple external ports to internal ports. Go to section 8.5 on
page 222.
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8.3

Access one Main Node over the Internet
Follow these instructions if you have a router that can forward one global IP
address to one local IP address on the same port.
Figure 169 shows the configuration for setting up remote access of one Main
Node.

Remote PC

Internet

Ethernet cable
Local PC
used to configure
the router

Router
global IP: 66.249.65.12
local IP: 10.10.8.1
Ethernet cable

Card Access Controller Elevator Restiction
Touch Screen
(secondary node)
Unit (secondary node) (secondary node)

TX3 Touch Screen
Main Node
10.10.8.2
RS-485 Network

Figure 169. Accessing a Main Node over the Internet

Note:
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There can only be one Main Node on an RS-485 subnetwork. That
is, you cannot connect one RS-485 subnetwork to another RS-485
subnetwork. However, if you want to connect to a Touch Screen
panel remotely over the Internet (for instance, to enable the
advertising module), the Touch Screen panel must be set as a Main
Node even if there is no Secondary panel connected to it.
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To access the Main Node remotely over the Internet, you must configure the
router to assign or map the Main Node IP address to the global IP address (the IP
address assigned by the Internet service provider).
A request for this global IP
address...

Is directed to this Main Node...

66.249.65.12

10.10.8.2

You must:
1.

Configure the router.

2.

Get the global IP address of the router.

3.

Connect to the Main Node from a remote PC.

The first two steps are performed from the local PC, and the third step is
performed from the remote PC.

8.3.1

Configure the Router
The procedure for configuring the router depends on the kind of router and how
the network is configured. Use the following information to configure the router.

8.3.2

•

The panel’s IP address and MAC address: The addresses you noted in
section 8.2 on page 214.

•

Port: 8080 for Touch Screens and 14000 for non-Touch Screens.

•

Protocol or Service Type: TCP.

Get the Global IP Address of the Router
1.

If the router has a static global IP address, go to the following site on the
local PC to find the global IP address:
http://www.myglobalip.com
If you use a DDNS service, use the domain name associated with the IP.

2.

8.3.3

Disconnected the local PC from the network. It is no longer needed.

Connect to the Main Node from the Remote PC over the Internet
Note:

1.

You must use the TX3 Configurator version 2.1.8 or higher for
remote access of Main Nodes using port forwarding.
On the remote PC, open the TX3 Configurator.

TX3 Configuration and Administrator Manual

217

Remote Access

2.

Open a new job.

3.

Click Network in the job tree, and select TCP/IP in the PC
Connection menu.

4.

Right click anywhere on the tree and select Add Panel.
The Add Panel window appears.

Figure 170. Add Panel

5.

Provide the following information:
Label. Provide a name for the panel.
Address. Select the RS-485 address of the panel you are connecting to.
Panel model. Click the drop down list and select the model of panel you
are connecting to.
IP Address. If the router at the installation site has a static global IP
address, type the static global IP address.
If you use a DDNS service, type the domain name associated with the IP.
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6.

Click Add.

7.

Click Connect.

8.

Check for a message that the panel is Online in the Online Events
pane at the bottom of the window.
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8.4

Access multiple Main Nodes over the Internet with
Multiple Global IP Addresses
Follow these instructions if you have a router that can support multiple external
interfaces (multiple global IP addresses).
To access the Main Nodes remotely over the Internet, you must configure the
router to assign or map each Main Node IP address to a global IP address.
In this example, the node 10.10.8.2 is assigned to the global IP address
66.249.65.12, and the node 10.10.8.3 is assigned to the global IP address
66.249.65.13.
A request for this global IP
address...

Is directed to this Main Node...

66.249.65.12

10.10.8.2
(Touch Screen Main Node)

66.249.65.13

10.10.8.3
(Card Access Main Node)

You must:
1.

Configure the router so that each panel is assigned to a different global IP
address.

2.

Connect to the Main Nodes from a remote PC.

Note:

8.4.1

There can only be one Main Node on an RS-485 subnetwork. That
is, you cannot connect one RS-485 subnetwork to another RS-485
subnetwork. However, if you want to connect to a Touch Screen
panel remotely over the Internet (for instance, to enable the
advertising module), the Touch Screen panel must be set as an Main
Node even if there is no Secondary panel connected to it.

Configure the Router
The procedure for configuring the router depends on the kind of router and how
the network is configured.
Use the following information to configure the router.
•

The panels’ IP addresses and MAC addresses: The addresses you
noted in section 8.2 on page 214.

•

Port: 8080 for Touch Screens and 14000 for non-Touch Screens.

•

Protocol or Service Type: TCP.
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In this example, there are two static global IP addresses that are assigned to two
Main Nodes.
A request for this global IP
address...

Is directed to this Main Node...

66.249.65.12

10.10.8.2
(Touch Screen Main Node)

66.249.65.13

10.10.8.3
(Card Access Main Node)

For global IP address 66.149.64.12:
•

Local IP Address: 10.10.8.2.

•

Internal Port: 8080 because the panel is a Touch Screen.

•

External Port: The same as the internal port.

•

Protocol or Service Type: TCP.

For global IP address 66.149.64.13:

8.4.2

•

Local IP Address: 10.10.8.3.

•

Internal Port: 14000 because the panel is not a Touch Screen.

•

External Port: The same as the internal port.

•

Protocol or Service Type: TCP.

Connect to the Main Node from the Remote PC over the Internet
Note:
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You must use the TX3 Configurator version 2.1.8 or higher for
remote access of Main Nodes using port forwarding.

1.

On the remote PC, open the TX3 Configurator.

2.

Open a new job.

3.

Click Network in the job tree, and select TCP/IP in the PC
Connection menu.

4.

Right click anywhere on the tree and select Add Panel.
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The Add Panel window appears.

Figure 171. Add Panel

5.

Provide the following information:
Label. Provide a name for the panel.
Address. Select the RS-485 address of the panel you are connecting to.
Panel model. Click the drop down list and select the model of panel you
are connecting to.
IP Address. Type the global IP address assigned to the panel you are
connecting to.

6.

Click Add.

7.

Repeat steps 4 and 5 for each panel that you want to connect to. Make sure
that you specify the correct RS-485 address and model for each panel. You
made a note of the RS-485 addresses in section 8.2 on page 214.

8.

Click Connect.

9.

Check for a message that the panel is Online in the Online Events pane at
the bottom of the window.
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8.5

Access one or more Main Nodes over the Internet
with one Global IP Address
Follow these instructions if you have a router that can forward multiple external
ports to internal ports.
Figure 172 shows an example network.

Remote PC

Internet

Ethernet cable
Local PC
used to configure
the router

Router
global IP: 66.249.65.12
local IP: 10.10.8.1
Switch
Ethernet cable

1

4

GHI

7

2

ABC

5

JKL

8

3

DEF

6

MNO

9

PQRS

TUV

WXYZ

*

0

#

TX3 Lobby Control
Main Node
10.10.8.2

Elevator Restriction Unit
(Secondary Node)

TX3 Card Access
Main Node
10.10.8.3

Lobby Control Unit
(Secondary Node)
1

4

GHI

7

RS-485 Network
Card Access Controller
(Secondary node)

2

ABC

5

JKL

8

TX3 Touch Screen
Main Node
10.10.8.4

Card Access Controller
(Secondary node)

3

DEF

6

MNO

9

PQRS

TUV

WXYZ

*

0

#

RS-485 Network
Card Access Controller
(Secondary node)

RS-485 Network
Elevator Restiction Unit
(Secondary node)

Figure 172. Accessing multiple Main Nodes over the Internet using
port forwarding
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To access the Main Nodes remotely over the Internet, you must configure the
router to assign or map each Main Node IP address and port to a global IP address
(the IP address assigned by the service provider) and port.
The mapping of the nodes in Figure 172 is shown below. Node 10.10.8.2 is
assigned to external port 15000, the node 10.10.8.3 is assigned to external port
15001, and the node 10.10.8.4 is assigned to external port 15002.
The internal port is 8080 for Touch Screens and 14000 for non-Touch Screens. In
this example, 10.10.8.4 is a Touch Screen so it has an internal port of 8080. The
other two nodes are not Touch Screens, so they have internal ports of 14000.
A remote PC accesses a Main Node by sending a request to the router’s global IP
address plus the port assigned to the Main Node.
A request for this global IP
address...

Is directed to this Main Node...

66.249.65.12:15000

10.10.8.2:14000
(Lobby Control Main Node)

66.249.65.12:15001

10.10.8.3:14000
(Card Access Main Node)

66.249.65.12:15002

10.10.8.4:8080
(Touch Screen Main Node)

You must:
1.

Configure the router so that each panel is assigned to a different port.

2.

Get the global IP address of the router.

3.

Connect to the Main Nodes from a remote PC.

The first two steps are performed from the local PC, and the third step is
performed from the remote PC.

8.5.1

Configure the Router
The procedure for configuring the router depends on the kind of router and how
the network is configured. You need the following information to configure the
router.
•

The router’s local IP address. Use the local IP address to access the router
and configure it.

•

The panels’ IP addresses and MAC addresses: The addresses you noted in
section 8.2 on page 214.

•

Internal Port: 8080 for Touch Screens and 14000 for non-Touch Screens.

•

External Ports: Any unused ports. Assign a different external port to each
panel.
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•

8.5.2

Protocol or Service Type: TCP.

Configure a Linksys Router
The following example shows how to configure a Linksys router.
Use the Command Prompt to get the router’s local IP address
1.

On the local PC, click Start, then click All Programs, then
Accessories, then Command Prompt.

2.

In the Command Prompt window, type ipconfig and then press Enter.
The Default Gateway is the router’s local IP address.

Configure the Linksys router
1.

On the local PC, type the router’s local IP address in a web browser.
The router’s configuration window appears.

2.

Click Applications & Gaming and then click Single Port
Forwarding.

3.

Provide the following information:
External Port: Any unused port. Assign a different external port to each
Main Node. Make a note of the ports. You will need this information in the
next steps.
Internal Port: 8080 for Touch Screens and 14000 for non-Touch
Screens.
Protocol: TCP.
To IP Address: The panel’s IP addresses, which you noted in section 8.2
on page 214.
Enabled: Select this checkbox.
In Figure 173, there are three Main Nodes, and they are assigned to the
ports 15000, 15001, and 15002.
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Figure 173. Configuring a Linksys router for three Main Nodes

8.5.3

Get the Global IP Address of the Router
1.

If the router has a static global IP address, go to the following site on the
local PC to find the global IP address:
http://www.myglobalip.com
If the router has a dynamic global IP address, use the domain name
associated with the IP.

2.

8.5.4

Disconnected the local PC from the network. It is no longer needed.

Connect to the Main Node from the Remote PC over the Internet
Note:

You must use the TX3 Configurator version 2.1.8 or higher for
remote access of Main Nodes using port forwarding.

1.

On the remote PC, open the TX3 Configurator.

2.

Open a new job.

3.

Click Network in the job tree, and select TCP/IP in the PC
Connection menu.

4.

Right click anywhere on the tree and select Add Panel.
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The Add Panel window appears.

Figure 174. Add Panel

5.

Provide the following information:
Label. Provide a name for the panel.
Address. Select the RS-485 address of the panel you are connecting to.
Panel model. Click the drop down list and select the model of panel you
are connecting to.
IP Address. If the router at the installation site has a static global IP
address, type the static global IP address and the external port assigned to
the panel you are connecting to, separated by a colon. For example, if the
router’s global IP address is 66.249.65.12 and the panel’s external port is
15000, type:
66.249.65.12:15000
If you have a DDNS service, type the domain name associated with the IP
and the external port assigned to the panel you are connecting to, separated
by a colon. For example, if domain name is anyip.com and the panel’s
external port is 15000, type:
anyip.com:15000

6.
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Click Add.
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7.

Repeat steps 4 and 5 for each panel that you want to connect to. Make sure
that you specify the correct RS-485 address, model, and external port for
each panel. You made a note of the RS-485 addresses in section 8.2 on
page 214. You assigned the external ports to the panels in section 8.5.1 on
page 223.

8.

Click Connect.

9.

Check for a message that the panel is Online in the Online Events
pane at the bottom of the window.
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9

Cards and Access Levels

Once you have added a Card Access Panel or an Aperio Door Controller to your
job, you can start adding cards and start configuring access levels.
This chapter explains
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•

Adding or Modifying Cards

•

Finding a Card

•

Configuring Access levels
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9.1

Adding or Modifying Cards
Cards appear in the Job tree with the addition of the first Card Access System or
Aperio Door Controller panel. Selecting Cards from the Job tree displays all
currently configured cards and their corresponding details on the Right Pane.
Clicking on an item in the column header sorts the list in either its ascending or
descending order.
Note:

All card information is stored in the panel with the exception of card
profile information, which is stored on the PC in the Job database
file. See Figure 180.

Figure 175. Card Configuration

9.1.1

Adding Cards
The application lets you easily add and modify a user’s card information. To
facilitate the task of entering a large card list you can add multiple card
information at the same time and then edit their specific values.
There are two ways to add a card: manually (you type in the card code and facility
code) and automatically (you swipe the card and the system reads the card code
and facility code).
For information on how to provide detailed configuration information for a card
see section 9.1.2.
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To add a card manually
1.

Select Add Cards from the Menu Bar or right click in the Card
Configuration window and select Add Cards. The Add Cards window
appears.

Figure 176. Add Cards

2.

Provide the following information:
Total number of cards to add. Specify the number of cards to add.
Card name. Specify a name for the card. The maximum number of
characters is 30.
Card number. Provide a unique card number. If more than one card is
added at a time, a number will be attached to the cards to make them
unique.
Access Level. Select an access level from the list. Access levels are preset
by the administrator. See Section 9.3 for information on how to create
Access Levels.
Facility code. Enter a facility code for the card with a value from 0 to
4294967294. Access is granted when this facility code matches the value
set for the Card Access Panel (see section 6.3 or section 7.1.3).

3.
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Click OK to add the card(s) and return to the configuration window or click
Detail to proceed with additional configuration as described in the next
section. You may also click Close to save the existing changes and
continue with adding another card.
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To add a card automatically
1.

Right-click in the Online Events pane, and select Add Card.

2.

Swipe a card at a reader connected to the system.
If the card is not recognized, an Add Card button appears in the Online
Events window.

3.

Click the Add Card button.
The Add Cards window appears with the card code and facility code
automatically filled in.

Figure 177. Add Cards

4.

Provide the following information:
Card name. Specify a name for the card. The maximum number of
characters is 30.
Access Level. Select an access level from the list. Access levels are preset
by the administrator. See Section 9.3 for information on how to create
Access Levels.

5.

Repeat steps 2 to 4 to add another card automatically.

6.

When you are finished adding cards, right-click in the Online Events pane,
and deselect Add Card.
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9.1.2

Editing Card Details
A card can be edited by selecting Detail from the Add Card window or by double
clicking the card.
Multiple cards can be edited at the same time by selecting and right clicking on
multiple cards. Some options may be disabled or their values may not be
assigned to multiple cards.
To edit card details
1.

Click the row header on the far left or double click anywhere on the row.
You may also right click and select Edit Cards. The Card Details
window appears.

Figure 178. Card Details

2.

Provide the following information:
Select a photo here. Click this area and select the card holder’s photo
from a directory.
Card number. Specify the card number. This number is printed on the
card.

Note:

232

For card readers with a keypad, the card number serves as the
keypad entry access code.
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PIN. Enter a Personal Identification Number. The PIN is 1 to 4 digits long
and is programmed for each card. 0 is not accepted. This is required if the
‘PIN required schedule’ feature is enabled on the card reader.
Name. Provide a name for the card holder.
Facility Code. Provide the facility code.
Notes. Provide any notes for this card.
3.

Select General and provide the following information to specify access
levels and activation dates and status:
Access level. Select up to three access levels for the card. Access
privileges to designated areas are defined by the administrator.
Activation date. Specify the activation date for the card.
De-activation date. Specify the de-activation date.
Status. Status shows the current status of this card. Select Inactive
to de-activate or Active to activate the card.
Usage counter. Usage counter is a configurable feature that uses a
counter to specify a card usage limit at a reader. Each time the card is used
this value decreases by one in the database. When it reaches zero, the card
is de-activated. Select the check box and specify the maximum usage
count for this card. When deselected the card has an unlimited use.

Note:

For the Usage counter to function enable the Deduct Usage
Count feature on the card reader (see section 6.3 or section 7.1.3).
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4.

Select Advanced. The Advanced tab appears.

Figure 179. Card Details Advanced

5.

Enable the following features to specify additional access privileges:
High security privilege. Assigns the card access rights to areas
designated as high security. A card with this privilege can toggle the high
security mode to either on or off by swiping the card four times in
succession. This option must also be set when configuring the Access
Point as described in sections 6.3 and 7.1.3.
Extended unlock time. Enables the card to be used during the extended
unlock time period. During this time the door remains unlocked. This
option is commonly given to seniors and persons with limited mobility.
Ignore anti-passback. When this option is specified the card holder is not
restricted, if set, by the timed anti-passback mode of the reader. Selecting
this option allows the same card unlimited use at the same reader. To set
anti-passback see sections 6.3 and 7.1.3.
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Handicap. Enables the card to access points designated as accessible as
well as the regular lock. The access point must be designated as a handicap
lock as described in sections 6.5 or 6.5.2.
Note:

This option does not apply to an Aperio Door Controller because all
of their outputs are general purpose outputs. However, if your job
contains any TX3-CX Two Card Access Controllers that have
outputs designated as accessible, this option will apply for those
outputs.
Lock-Unlock privilege. Enabling the lock/unlock privilege overrides
any scheduled card access restrictions. An access card with lock/unlock
privileges, if swiped twice in succession, toggles between lock and unlock
mode. The access point must be designated as a specific lock as described
in sections 6.5, 6.5.2 and 7.3.
First person in. When enabled the door becomes unlocked by the first
valid card presented during the unlock schedule, causing the door to
remain unlocked for the duration of the unlock schedule. This option must
also be set when configuring the Access Point as described in sections 6.3
and 7.1.3.

6.

Select Profile. The Profile window appears.

Figure 180. Card Details Profile

7.

Provide the following profile information:
First name. First name of the card holder.
Last name. Last name of the card holder.
Phone. Phone number.
Mobile phone. Mobile phone number.
E-mail. Email address.
Department. Provide the business department.
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Profile ID. future use.
Select Profile. future use.
8.

Select More Profile Info. The More Profile Info window appears.

Figure 181. Card Details More Profile Info

9.

Provide the following additional address information.
Address. Resident address
City. City name.
Province/state. Province or state.
Country/region. Country or region name.
Postal/zip code. Postal or zip code.
Apt#. Resident apartment number.

10.

9.2

Click OK to add the card information and return to the configuration
window, or click Cancel to exit without saving the changes.

Finding a Card
The application provides you with quick browsing and searching capabilities for
finding card information.

Figure 182. Card Search

To find a card, enter the card name in the Find box above the list. The list will
automatically refresh as you type in the criteria.
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To find by another column, say by card number, select Card Number in the In
column box. To restore the full list, press the Clear button.

9.3

Configuring Access levels
Creating an access level lets you define where and when to use a card, and how to
set elevator usage if elevator restriction units are used. Access levels are assigned
to cards to help the administrator keep track of access privileges (for instructions
on how to assign an access level to a card see section 9.1 on page 229).
You can create a maximum of 128 access levels for each controller and a
recommended maximum of 2000 access levels for the job. For each access level,
you can select a schedule for all of the access points in your job.
For example, if your job has a Card Access System panel called Panel1 with two
access points (Reader A and Reader B) and an Aperio Door Controller called
Panel2 with two access points (Lockset 1:0 and Lockset 1:1), you could define
the following access levels.
Access Level ID = 1
•

Panel1: Reader A schedule = Always

•

Panel1: Reader B schedule = Never

•

Panel2: Lockset 1:0 schedule = Never

•

Panel2: Lockset 2:0 schedule = Never

Access Level ID = 2
•

Panel1: Reader A schedule = Office hours

•

Panel1: Reader B schedule = Always

•

Panel2: Lockset 1:0 schedule = Always

•

Panel2: Lockset 2:0 schedule = Always

If a card is assigned Access Level 1, the user has access to Reader A on Panel1 at
all times but will not have access to any other access point.
If a card is assigned Access Level 2, the user has access to Reader A during the
Office Hours schedule only and will have access to all of the other access points
all of the time.
Access levels appear in the Job tree with the addition of the first Card Access
System panel or Aperio Door Controller panel. Selecting Access Levels from the
Job tree displays all currently configured access levels and their corresponding
details in the Access Level Configuration window in the Right Pane.
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To create an access level
1.

Select Access Levels from the Job tree.
The Access Level Configuration window appears.

Figure 183. Access Level Configuration

Note:

2.

By default the Admin level has access to all access points at all
times and it is not configurable.
Click Add.
A new access level appears.

3.

Supply the following information:
Label. Provide a name for this access level.

Note:

When you get a Job from a panel, access level labels are reset to
their default values.
Access Points. Select the checkbox for an access point to enable or disable
access. If an access point is unchecked, it will not allow access to cards
with this access level.
To select or clear all access points, click the Set all or Clear all
buttons.
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During Schedule. From the schedule, list select when access is granted.
You can select from Always, Never or any other user-defined schedule.
Elevators. Click this button to enable elevator access control for this
access level. See Chapter 10 on page 240.
4.

When you have finished configuring the access level, connect your
computer to your TX3 network, and then send the job.

To delete an Access Level
1.

Select Access Levels from the Job tree. The Access Level
Configuration window appears.

2.

Select the Access Level you want to delete from the Access Levels list.

3.

Press Delete.

4.

Connect to your TX3 network, and then send the job.
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Elevator Control

This chapter describes how to set up elevator control in the TX3 Configurator
software.
This chapter explains
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•

Before you begin

•

Configuring Card Access with Elevator Restriction Firmware Version
2.4.x or 3.4.x or higher

•

Configuring Card Access with Elevator Restriction Firmware Version
2.4.x or 3.4.x or higher

•

Configuring Card Access with Elevator Restriction Firmware 2.0.x, 3.0.x,
or 3.1.x

•

Configuring Residents with Elevator Restriction Firmware Version 2.4.x
or 3.4.x or higher

•

Configuring Residents with Elevator Restriction Firmware 2.0.x, 3.0.x, or
3.1.x
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10.1

Before you begin
Make sure that you are using the right firmware versions as described in section
1.7 on page 21. You must have the TX3 Configurator version of 2.12.12 or higher
to complete the instructions in this chapter.
Read LT-9940 the TX3 Elevator Restriction Installation and Operation
Manual for detailed information on elevator control.

10.2

Configuring Card Access with Elevator
Restriction Firmware Version 2.4.x or 3.4.x or
higher
To configure elevator restriction you must:
1.

Add Elevator Restriction Units to the Job Tree

2.

Configure an access point to control an elevator restriction unit

3.

Create a floor group

4.

Create an access level

5.

Assign a floor group to the access level

6.

Assign cards to the access level

Follow the instructions below to complete these steps.

10.2.1

Add Elevator Restriction Units to the Job Tree
Note:

You can add up to 6 TX3-ER-8(-A) Elevator Restriction Units
(ERU) to a job, and up to 16 TX3-ER-8-B Elevator Restriction
Units (ERU 2.0) to a job. The maximum number of Elevator
Restriction Units in a job is 16.

1.

Select Edit > Add Panel.

2.

If the panel is connected over TCP/IP, follow the instructions in section
3.1.2.1 on page 71 to add it.
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3.

Provide the following information.
Label. Enter a name for the Elevator Restriction Unit.
Address. Specify the RS-485 address of the Elevator Restriction Unit.
Panel Mode.
• ERU (Elevator Restriction Unit) for TX3-ER-8 or TX3-ER-8-A
• ERU 2.0 (Elevator Restriction Unit) for TX3-ER-8-B

Figure 184. Add ERU
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4.

Click Add.

5.

Repeat these steps for every Elevator Restriction Unit in the job.
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10.2.2

Configure an access point to control an elevator restriction unit
1.

Expand the Access Point list and select the access point that will control an
elevator restriction unit.

2.

Click the Elevator tab.

Figure 185. Access Point Configuration - Elevator Access

10.2.3

3.

Select Enable Elevator Control.

4.

Select the Elevator Restriction Units that this access point controls.

Create a floor group
Floor groups are groups of floors that are assigned to access levels.
1.

Select Floor Groups from the Job tree.

2.

Click Add.
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Floor Group0 appears.

Figure 186. Floor Groups

3.
Note:

4.

Select the floors that you want in this floor group.
With TX3-ER-8(-A) (ERU), a maximum of 24 relays can be
assigned to a floor group. With TX3-ER-8-B (ERU 2.0), a
maximum of 96 relays can be assigned to a floor group.
Provide the following information.
Activate relays for. Specify the amount of time that the ERU relays are
active. This timer starts when the access point reads the card.

Note:
5.
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The minimum is 5 seconds and the maximum is 600 seconds.
Click Add to add another floor group.
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To edit relays and schedules
1.

Click Relay Labels and Schedules.
The Edit Relay Labels and Schedules window appears.

Figure 187. Edit Relay Labels and Schedules

2.

Select a relay label, then double-click it.

3.

Type a new name for the relay.

Note:
4.

Note:
5.

Relay labels are the same for all elevator restriction units in the job.
Under Relay Activation Schedule, select when this relay should
be active. You can select Always, Never, or another user-defined
schedule. See section 11.1 on page 265 for instructions on creating
schedules.
Relay schedules work only with TX3-ER-8-B (ERU 2.0).
Click OK.
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10.2.4

Create an access level
1.

Select Access Levels from the Job tree.
The Access Level Configuration window appears.

Figure 188. Access Level Configuration

Note:

2.

The Admin level includes all access points. This cannot be
changed.
Click Add.
A new access level appears.

3.

Supply the following information:
Label. Provide a name for this access level.
Access Points. Select the checkbox for an access point to enable or disable
access. If an access point is checked, it will allow access to cards with this
access level. If an access point is unchecked, it will not allow access to
cards with this access level.
To select or clear all access points, click the Set all or Clear all
buttons.
During Schedule. From the menu, select when the access point should
grant access. You can select Always, Never, or another user-defined
schedule. See section 11.1 on page 265 for instructions on creating
schedules.
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10.2.5

Assign a floor group to the access level
1.

From the Access Level Configuration window, select the access level, and
then click the Elevators button.

Figure 189. Access Level Configuration - Elevators button

The Elevator Control window appears.

Figure 190. Elevator Control
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10.2.6

2.

Select Enable Elevator Control, and select Use floor
group.

3.

If no floor groups are defined, click Go to Floor Group screen to
define them. See section 10.2.3 on page 243.

4.

Select the floor group associated with this access level.

5.

Click OK.

Assign cards to the access level
1.

Select Cards from the Job tree.

2.

The Card Configuration window appears.

Figure 191. Card Configuration

3.

Note:
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To edit a card, click the row header on the far left or double click anywhere
on the row.
You can edit multiple cards at the same time by selecting and right
clicking on multiple cards.
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The Card Details window appears.

Figure 192. Card Details

4.

In the Access Level menu, select up to three access levels for the card.
Access privileges to designated areas are defined by the administrator.

5.

Click OK, and send the job to the panel.
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10.3

Configuring Card Access with Elevator
Restriction Firmware 2.0.x, 3.0.x, or 3.1.x
To configure elevator restriction you must:
1.

Configure an access point to control an elevator restriction unit

2.

Create an access level

3.

Assign floors to the access level

4.

Assign cards to the access level

Follow the instructions below to complete these steps.

10.3.1

Configure an access point to control an elevator restriction unit
1.

Expand the Access Point list and select the access point that will control an
elevator restriction unit.

2.

Click the Elevator tab.

Figure 193. Access Point Configuration - Elevator Access
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3.

Select Enable Elevator Control.

4.

Select Legacy elevator control.

5.

If you have Elevator Restriction Unit firmware version 3.1.0 or higher,
select the RS-485 address of the elevator restriction unit that you want this
access point to control.
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If you have an Elevator Restriction Unit firmware version lower than
3.1.0, ignore this menu.

10.3.2

Create an access level
1.

Select Access Levels from the Job tree.
The Access Level Configuration window appears.

Figure 194. Access Level Configuration

Note:

2.

You cannot change the access points assigned to the Admin level,
but you can change the elevators.
Click Add.
A new access level appears.

3.

Supply the following information:
Label. Provide a name for this access level.
Access Points. Select the checkbox for an access point to enable or disable
access. If an access point is checked, it will allow access to cards with this
access level. If an access point is unchecked, it will not allow access to
cards with this access level.
To select or clear all access points, click the Set all or Clear all
buttons.
During Schedule. From the menu, select when access is granted. You can
select Always, Never, or another user-defined schedule. See section
11.1 on page 265 for instructions on creating schedules.

TX3 Configuration and Administrator Manual

251

Elevator Control

10.3.3

Assign floors to the access level
1.

From the Access Level Configuration window, select the access level, and
then click the Elevators button.

Figure 195. Access Level Configuration - Elevators button

The Elevator Control window appears.

Figure 196. Elevator Control

2.
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Select Enable Elevator Control.
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3.

Select Legacy elevator control.

4.

Provide the following information to restrict elevator use:
Activate relays for. Specify the amount of time that the ERU relays are
active. This timer starts when the access point reads the card.

Note:

The minimum is 5 seconds and the maximum is 600 seconds.
Activate. Select the relay for each floor that requires access.

Note:

With Elevator Restriction Unit firmware version 2.0.x and 3.0.x, a
maximum of 16 relays can be assigned to an access level.
With Elevator Restriction Unit firmware version 3.1.x, a maximum
of 24 relays can be assigned to an access level.
Elevator address. If you have an Elevator Restriction Unit firmware
version lower than 3.1.0, select the RS-485 address of the elevator
restriction unit for this access level.
If you have Elevator Restriction Unit firmware version 3.1.0 or higher,
ignore the Elevator address menu.

5.

10.3.4

Click OK.

Assign cards to the access level
1.

Select Cards from the Job tree.

2.

The Card Configuration window appears.

Figure 197. Card Configuration
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3.

Note:

To edit a card, click the row header on the far left or double click anywhere
on the row.
You can edit multiple cards at the same time by selecting and right
clicking on multiple cards.
The Card Details window appears.

Figure 198. Card Details
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4.

In the Access Level menu, select up to three access levels for the card.
Access privileges to designated areas are defined by the administrator.

5.

Click OK, and send the job to the panel.
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10.4

Configuring Residents with Elevator Restriction
Firmware Version 2.4.x or 3.4.x or higher
Note:

You cannot configure residents for elevator Restriction from a
Touch Screen. You must use the PC-based Configurator.

The elevator restriction feature limits building accessibility by granting the
visitor access only to the destination floor. This prevents the visitor from
accessing non-designated floors.
To configure elevator restriction you must:
1.

Add Elevator Restriction Units to the Job Tree

2.

Create a floor group

3.

Configure residents for elevator restriction

Follow the instructions below to complete these steps.

10.4.1

Add Elevator Restriction Units to the Job Tree
Note:

You can add up to 6 TX3-ER-8(-A) Elevator Restriction Units
(ERU) to a job, and up to 16 TX3-ER-8-B Elevator Restriction
Units (ERU 2.0) to a job. The maximum number of Elevator
Restriction Units in a job is 16.

1.

Select Edit > Add Panel.

2.

Provide the following information.
Label. Enter a name for the Elevator Restriction Unit.
Address. Specify the RS-485 address of the Elevator Restriction Unit.
Panel Mode.
• ERU (Elevator Restriction Unit) for TX3-ER-8 or TX3-ER-8-A
• ERU 2.0 (Elevator Restriction Unit) for TX3-ER-8-B
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Figure 199. Add ERU
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3.

Click Add.

4.

Repeat these steps for every Elevator Restriction Unit in the job.
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10.4.2

Create a floor group
1.

Select Floor Groups from the Job tree.

2.

Click Add.
Floor Group0 appears.

Figure 200. Floor Groups

3.
Note:

4.

Select the floors that you want in this floor group.
With TX3-ER-8(-A) (ERU), a maximum of 24 relays can be
assigned to a floor group. With TX3-ER-8-B (ERU 2.0), a
maximum of 96 relays can be assigned to a floor group.
Provide the following information.
Activate relays for. Specify the amount of time that the ERU relays are
active. This timer starts when the system grants the visitor access.

Note:
5.
Note:

The minimum is 5 seconds and the maximum is 600 seconds.
Click Add to add another floor group.
The timers for the relays are set in the Floor Group Configuration.
The Elevator restriction time in the Advanced tab of Panel
Configuration is not used.
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To edit relays and schedules
1.

Click Relay Labels and Schedules.
The Edit Relay Labels and Schedules window appears.

Figure 201. Edit Relay Labels and Schedules

2.

Select a relay label, then double-click it.

3.

Type a new name for the relay.

Note:
4.

Note:
5.
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Relay labels are the same for all elevator restriction units in the job.
Under Relay Activation Schedule, select when this relay should
be active. You can select Always, Never, or another user-defined
schedule. See section 11.1 on page 265 for instructions on creating
schedules.
Relay schedules work only with TX3-ER-8-B (ERU 2.0).
Click OK.
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10.4.3

Configure residents for elevator restriction
1.

Select Residents from the Job tree.
The Resident Configuration window appears (Figure 202).

Figure 202. Resident Configuration List

2.

Click Edit > Edit Resident.
The Resident Details window appears.

Figure 203. Resident Details

3.

Click the Elevator tab.
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The Elevator window appears.

Figure 204. Resident Details - Elevator
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4.

Select Enable Elevator Control.

5.

Select Use floor group.

6.

If no floor groups are defined, click Go to Floor Group screen to
define them. See section 10.4.2 on page 257.

7.

Select the floor group for this resident.

8.

Select the Elevator Restriction Units that are allowed for this resident.

9.

Click OK, and send the job to the panel.
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10.5

Configuring Residents with Elevator Restriction
Firmware 2.0.x, 3.0.x, or 3.1.x
The elevator restriction feature limits building accessibility by granting the
visitor access only to the destination floor. This prevents the visitor from
accessing non-designated floors.
To configure elevator restriction you must:
1.

Configure a resident for elevator restriction

2.

Configure the elevator restriction time

Follow the instructions below to complete these steps.

10.5.1

Configure a resident for elevator restriction
1.

Select Residents from the Job tree.
The Resident Configuration window appears.

Figure 205. Resident Configuration List

2.

Click Edit > Edit Resident.
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The Resident Details window appears.

Figure 206. Resident Details

3.

Click Elevator.
The Elevator window appears.

Figure 207. Resident Details - Elevator
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4.

Select Enable Elevator Control, then select Legacy
elevator control.

5.

Provide the following information to restrict elevator use:
Elevator address. Type the RS-485 address of the Elevator Restriction
Unit that the resident will use.
Elevator relay code. Type the elevator relay code for the resident’s floor.

6.

10.5.2

Click OK.

Configure the elevator restriction time
The elevator restriction time determines the amount of time that an elevator is
accessible for a visitor after the resident grants access.
1.

Select a telephone access panel.
The Panel Configuration window appears.

2.

Click the Advanced tab from the Panel Configuration window.
The Advanced window appears.

Figure 208. Panel Configuration - Advanced

3.

Note:
4.

Beside Elevator restriction time, select the amount of time
that an elevator is accessible for a visitor after the resident grants access.
This timer starts when the system grants the visitor access.
The minimum is 5 seconds and the maximum is 600 seconds.
Click OK, and send the job to the panel.
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Defining Schedules and
Holidays

The TX3 Configurator lets you assign access levels for card users.
This chapter explains
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•

Defining Schedules

•

Defining Holidays
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11.1

Defining Schedules
Schedules lets you define a timetable to establish when certain panel functions
are permitted to occur, such as when calls to residents are allowed, when
residents can grant access to a visitor or when the postal lock can be used. These
schedules are designated and listed by name, and are available for selection
wherever it is necessary to invoke access permission.
Multiple periods may be used if the schedule is not continuous or does not span
to the next day.
To create a schedule
1.

Click Schedules from the Job tree. The Schedule Configuration
window appears listing the available schedules.

Figure 209. Schedule Configuration

2.

Select a schedule or click Add to create a new schedule. Provide
information for the following parameters:
Label. Provide a name for the schedule.
Start. Specify a start time.
End. Specify an end time.
Sun to Sat. Select the day or days of the week for the schedule to take
effect.
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Hol. Select this check box to apply to include holidays. Holidays are
defined on the Holiday View.
Note:

3.

If your schedule starts before midnight on one day and ends the next
day, you must define two periods (one for each day). For example,
if you have a schedule that goes from 10:00PM on Tuesday to
2:00AM on Wednesday, you need one period for Tuesday and a
second period for Wednesday. The Tuesday period starts at
10:00PM and ends at 11:59PM; the Wednesday period starts at
12:00AM and ends at 2:00AM.
Click Send and Exit from the Tool Bar to apply the settings and exit
the session.

To delete a schedule

11.2

1.

Select the schedule and click Delete.

2.

Click Send and Exit from the Tool Bar to apply the settings and exit
the session.

Defining Holidays
Holidays allow you to define a calendar of holiday periods for determining when
certain panel functions, such door access permission, are allowed. A holiday is
part of a schedule.
Holidays consist of start date and time, end date and time, and may include
holidays that re-occur on the same date every year.
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To create a holiday
1.

Click Holiday from the Job tree. The Holiday Configuration window
appears listing the available holidays.

Figure 210. Holiday Configuration

2.

Select a holiday or click Add to create a new holiday. Provide information
for the following parameters:
Name. Provide a name for the holiday.
Start. Specify a start day and time.
End. Specify an end day and time.
Repeat annually. Check this box if the same start, end date and time reoccur every year.

3.

Click Send and Exit from the Tool Bar to apply the settings and exit
the session.

To delete a holiday
1.

Select the holiday and click Delete.

2.

Click Send and Exit from the Tool Bar to apply the settings and exit
the session.
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Monitoring and Alerts

The TX3 Configurator lets you monitor the system information and status.
This chapter explains

268

•

Monitoring

•

Alerts
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12.1

Monitoring
The TX3 Configurator displays all network and access point status. Selecting
Monitoring displays all panels and their corresponding details in the Network
Status window in the Right Pane.

12.1.1

Network Status
Network status provides information about panel connectivity and shows the
existing state as ‘normal’, ‘trouble’, ‘alarm’, or ‘offline’, as well as the firmware
version number. Access to additional panel options is available.
To access network status
1.

Start the TX3 Configurator and then connect to your job.

2.

Click Monitoring in the Mode Selection section of the TX3
Configurator window.

3.

Click Network Status on the Job tree. The Network Status window
appears showing the state of each panel.

Figure 211. Network Status
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4.

Click on the panel, and then select from one of the following options:
Panel information. Panel Information shows the panel name, type,
model, firmware version, hardware version, RS-485 address, IP address,
network panel ID and the date of the last change. For Touch screens, the
window also shows the Touch software version, Touch hardware version,
Touch database version, Touch GUID, and the WAN IP address.

Figure 212. Panel Information

Set Date and Time. Selecting this option lets you set the panel clock to a
time other than the PC clock. Every time you access the Set Date and Time
window the current PC time is shown.

Figure 213. Set Date and Time
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Set Panel Passcode. Set Panel Passcode allows you to set the level 3
passcode. In order to connect to the panel, this passcode must match the
level 3 passcode on the panel.

Figure 214. Set Panel Passcode

Note:

The level 3 passcode is initially set at the panel. The default is 3333.

Note:

For Touch Screen panels, this only sets the passcode for the lobby
controller panel inside the Touch Screen. It does not change the
administrator password used to log in to the Touch Screen.
Event Logs. Event Logs lets you read the user and system logs, and save
them to the database. You may also erase the logs from the panel or from
the database.

Figure 215. Event Logs

Elevator Commands. If the panel is a TX3-ER-8-B Elevator Restriction
Unit (ERU 2.0), then select Elevator Commands to activate elevator
relays. See section 12.1.4 on page 274.
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12.1.2

To Determine the Model of Telephone Access Controller Board
To determine the model of telephone access controller board
1.

Start the TX3 Configurator and then connect to your job.

2.

Click Monitoring in the Mode Selection section of the TX3
Configurator window.

3.

Click Network Status on the Job tree. The Network Status window
appears showing the state of each panel.

Figure 216. Network Status

4.

Click on the panel, and then select Panel information.

Figure 217. Panel Information
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The Hardware line provides information about the telephone access
controller board.

12.1.3

•

0.17.127: MD-1245

•

0.0.127: MD-1086

Access Point Status
Access Point Status displays the current status of all the card reader access points
on the network and shows their status as ‘normal’, ‘trouble’, ‘alarm’, or ‘offline’,
as well as their lock/unlock and high security on/off status.
Access Point Status also lets you grant access, and turn on or off the unlock and
high security functions.
If you have assigned an input to General door status (section 6.4 on page 182),
then the door appears here, and its status (open or closed) is shown.
To view the status of access points
1.

Start the TX3 Configurator and then connect to your job.

2.

Click Monitoring in the Mode Selection section of the TX3
Configurator window.

3.

Click Access Point Status on the Job tree. The Access Point Status
window appears showing the state of each access point.

Figure 218. Access Point Status

4.

Click on an access point. The following selections appear:
Grant access. Use Grant access to admit access point entry. Typically this
unlocks the door. The Grant access option is not available for Aperio
wireless locksets.
Unlock mode ON. Turns on the unlock mode until the next scheduled
event or the panel is reset.
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Unlock mode OFF. Turns off the unlock mode until the next scheduled
event or the panel is reset.
Note:

For Aperio wireless locksets, the remote open option must be set in
order to set unlock mode on or off. Use the Aperio Programming
Application to set remote open option. For details, see Chapter 2 of
LT-1160 (Aperio Door Controller Installation Manual).
High security ON. Turns on the high security mode until the next
scheduled event or the panel is reset.
High security OFF. Turns off the high security mode until the next
scheduled event or the panel is reset.
Details. (Aperio wireless locksets only) Opens a window with the status
of the wireless lockset, including the battery status of the lockset.

5.

12.1.4

If you want to send a command to the access point (for example, Unlock
mode ON), click on the command.

Send Elevator Commands
If the job has a TX3-ER-8-B Elevator Restriction Unit (ERU 2.0), then you can
activate elevator relays and you can see the activation status of all relays.
To activate an elevator relay
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1.

Start the TX3 Configurator and then connect to your job.

2.

Click Monitoring in the Mode Selection section of the TX3
Configurator window.

3.

Click Elevators in the Monitoring job tree.
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The status window shows all TX3-ER-8-B Elevator Restriction Units
(ERU 2.0) in the job. They are labelled Elev2.

Figure 219. Elevator Status

4.

Click the icon for a TX3-ER-8-B Elevator Restriction Unit (ERU 2.0).
The Send Elevator Commands window appears.

Figure 220. Send Elevator Commands Window

Note:

5.

You can also open the Send Elevator Commands window by
right-clicking the ERU 2.0 panel in the Network Status
window. See section 12.1.1 on page 269.
Click the button
window.

in the bottom left of the window to expand the
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The window expands to show all the elevator relays.

Figure 221. Expanded Send Elevator Commands Window

Note:

Active relays are highlighted in green.

6.

Click the menu beside Send to and select which ERU2.0 panel to send
the activation command to.

7.

Select a time in the Activate relays for menu. This is the period
of time during which the elevator relays will remain active.

8.

Select Send to all ERU2.0 panels if you want to send the
activation command to all ERU2.0 panels instead of just the panel
selected in the Send to menu. If you select this option, then the
activation command is sent to the same relay on all the ERU 2.0 panels.

9.

Select the relay that you want to activate, then click the Activate
button.
The active relay is highlighted in green.

12.2

Alerts
The system can send an email message when a specific event happens.
To set up email alerts
1.
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Click Tools > Alert Setup.
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The Alert Setup Form appears.

Figure 222. Alert Setup Form
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2.

Click Email Server.
The Email Messages window appears.

Figure 223. Touch Screen Email Messages

Note:

3.

These email options do not affect the email message options in the
Touch Screen Options. See section 4.7.3 on page 121.
Provide the following information:
Enable Email Messages. Select this check box to enable email
messaging.
Server type. Select the server type: custom SMTP, Live (Hotmail), or
Gmail.
Email server. Enter the email service provider IP address.
Username. Enter the user name. Some email services require the full
email address as the username (for example, someone@gmail.com).
Password. Enter the password.
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From address. Provide the email address of the sender. This email
address tells the receiver and the ISP provider who is sending the email.
Note:

The From address is required.
To address. Enter the email address that you want to send a test message
to.

4.

To verify that all of the email service parameters are correct, send a sample
email message by pressing the Send Sample Email Now button.

5.

Click OK.

To set up email alerts
1.

In the Alert Setup form, click Add.

Figure 224. Add Alert

2.

Provide the following information:
When. Choose an event that will activate an alert. See the list of events in
section 12.2.1 on page 280.
On panel. On panel applies the action either to one of the panels on
your system or to a group of panels on your system. If, for example, you
have two panels (Panel1 and Panel2) in your TX3 system, you could select
from the following options:
Panel1 - Apply the correlation to Panel1 only.
Panel2 - Apply the correlation to Panel2 only.
All - Apply the correlation to all Telephone Access, Card Access, and
Touch Screen panels on the network.
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At access point. If the panel is a Card Access panel, select the access
point.
User email. Enter the email address that the alert should be sent to. If you
enter more than one email address, separate the addresses with commas.
3.

12.2.1

Click OK.

Event List
Access: Forced entry alarm. A door is forced open.
Access: Forced entry alarm restored. The forced entry alarm is
restored.
Access: Door held open alarm. A door did not close.
Access: Door held open alarm restored. The door held open alarm is
restored.
Access: Door held open warning. A door did not close and the door held
open warning is issued.
Access: Door held open warning restored. The door held open warning
is restored.
Access: Door not open. Access is granted but the door remains closed.
Access: Request to Exit. A request to exit is made.
Access: Input is active. The general purpose input becomes active.
Access: Input is normal. The general purpose input becomes inactive.
Access: Unlock mode is on. Unlock mode is activated, either by the Auto
unlock schedule, or manually, or by a card with the lock/unlock privilege.
Access: Unlock mode is off. Unlock mode is deactivated, either by the
Auto unlock schedule, or manually, or by a card with the lock/unlock
privilege.
Access: High security is on. High security mode is activated, either by a
card with high security privilege, or manually, or by a correlation.
Access: High security is off. High security mode is deactivated, either by
a card with high security privilege, or manually, or by a correlation.
Access: Tamper detected. The controller’s tamper alarm is on.
Access: Tamper restored. The controller’s tamper alarm is off.
Access: Battery is normal. (Aperio) The battery at the lockset has
returned to a normal state.
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Access: Battery is low. (Aperio) The battery at the lockset is low.
Access: Battery is flat. (Aperio) The battery at the lockset is flat.
Access: Lockset is offline. (Aperio) The lockset is not communicating
with its Aperio hub.
Access: Lockset is online. (Aperio) The lockset has resumed
communicating with its Aperio hub.
Access: Door is locked. (Aperio) The Unlock time has expired.
Access: Door is unlocked. (Aperio) The door is unlocked.
Access: FC not matching. Access denied. When Facility code mode is
enabled, access is denied because the facility code is invalid. See section
6.3 on page 178.
Access: PIN not matching. Access denied. During the PIN required
schedule, access is denied because the PIN is invalid. See section 6.3 on
page 178.
Access: PIN timed out. Access denied. During the PIN required
schedule, access is denied because no PIN was entered during the PIN
Timeout time. See section 6.3 on page 178.
Access: Card number not found. Access denied. Access is denied
because the card number is invalid.
Access: Temp card usage exceeded. Access denied. Access is denied
because the card’s usage counter has reached zero. See section 9.1.2 on
page 232.
Access: Card not active. Access denied. Access is denied because the
card’s Status is Inactive. See section 9.1.2 on page 232.
Access: Card expired. Access denied. Access is denied because the
card’s Deactivation date has passed. See section 9.1.2 on page 232.
Access: Schedule not matching. Access denied. The card is valid but the
schedule for the card’s access level is not active. See section 9.3 on page
237.
Access: High security right not set. Access denied. The access point is set
to high security but the card does not have high security privilege. See
section 6.3 on page 178.
Access: Anti passback. Access denied. Access is denied because the
card is used for a second time while the anti-passback timer is running. See
section 6.3 on page 178.
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Access: Anti PB list full. Access denied. The first time a card is used, it is
added to the anti-passback list. When the anti-passback timer for that card
expires, the card is removed from the list. On a card access system, the list
holds 100 cards. On an Aperio system, the list holds 10 cards. While the
list is full, access is denied.
Access: Hub is online. (Aperio) The hub is connected to the panel.
Access: Hub is offline. (Aperio) The hub is disconnected from the panel.
Access: All HISEC mode on. A correlation turns on high security on all
the access points of one panel.
Access: All HISEC mode off. A correlation turns off high security on all
the access points of one panel.
Access: Door jammed. (Aperio) The door is jammed.
Lobby: Input is active. The general purpose input becomes active.
Lobby: Input is normal. The general purpose input becomes inactive.
Lobby: Call Started. The lobby unit calls a resident.
Lobby: Call finished. A call to a resident ends.
Lobby: Call is connected. A call is established.
Lobby: Access is granted (lobby). The resident grants access using a
telephone keypad.
Lobby: Access denied (lobby). The resident denies access.
Lobby: Unlock mode is turned on (lobby). The Auto unlock Main door
schedule becomes active. See section 5.1.9 on page 151.
Lobby: Unlock mode is turned off (lobby). The Auto unlock Main door
schedule becomes inactive. See section 5.1.9 on page 151.
Lobby: Dial code not found. The dial code is invalid.
Lobby: Call and access schedule inactive. A visitor tries to call a
resident but access is denied because the Allow calls schedule is inactive.
See section 5.1.2 on page 141.
Lobby: Line not connected. The phone line is not connected.
Lobby: Line is in use. The phone line is in use.
Lobby: Guard phone connected. A successful call is made to the guard
phone.
Lobby: Calling guard phone. A resident or visitor is calling the guard
phone.
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Lobby: Disconnecting call. The resident or visitor is disconnecting the
call.
Lobby: Keyless code schedule is inactive. The resident tries to enter a
keyless code but access is denied because the Allow keyless entry
schedule is not active. See section 3 on page 145.
Lobby: Keyless code not found. The resident’s keyless entry code is
invalid. See section 5.5 on page 160.
Lobby: Main and Aux door are open. The resident opens both the main
and auxiliary door with keyless entry. See section 5.5 on page 160.
Lobby: main door is open. The resident opens the main door from the
keypad. See section 5.1.6 on page 145.
Lobby: Auxiliary door is open. The resident opens the auxiliary door
from the keypad. See section 5.1.6 on page 145.
Lobby: Called party is busy. The phone line is busy.
Lobby: Call in process. The lobby unit has placed a call and the phone is
ringing.
Lobby: Guard phone not connected or disabled. A resident or visitor
tries to call the guard phone, but the guard phone is not connected or not
enabled.
Lobby: No dial tone. The phone line is connected but there is no dial tone.
Lobby: Guard phone calling. The guard phone is calling the panel or a
resident.
Lobby: Postal lock usage exceeded the limit. The daily postal lock
usage is exceeded. See section 5.1.9 on page 151.
Lobby: Unlock schedule inactive. The resident tries to grant access by
pressing the DTMF digit, but access is denied because the Allow unlock
schedule is inactive. See section 3 on page 145.
Config: Panel offline. The Configurator is disconnected from a panel.
Config: Panel connected. The Configurator is connected to a panel.
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Reports

The Reports menu in the TX3 Configurator lets you generate reports on
events, residents and access cards, and lets you print a paper directory.
This chapter explains

284

•

Event Logs

•

Resident Report

•

Access Cards

•

Paper Directory

•

Save and Print the Report

•

Other Options in the Report Window
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13.1

Event Logs
You can generate a report of some or all of the event logs.
To generate a report of the event logs
1.

Click the Reports menu, then click Event Log.
The Event Log Report Options window appears.

Figure 225. Event Log Report Options

2.

Provide information for the following:
Show events occurred. Select During last 2 hours, Today or
Yesterday, or select a range of dates.
Most recent events first. Select this option to display the most recent
events at the top of the report.
Show system diagnostic events. Technicians can select this option to get
diagnostic information for troubleshooting.

3.

Note:

Click Update Events to retrieve all the events from all panels on the
network. This could take a few minutes.
The TX3 Configurator does not receive and store events while it is
not connected to the TX3 network. When the Configurator
reconnects to the network, it does not automatically receive the
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events that occurred while it was not connected. Click Update
Events to receive all the events that occurred while the
Configurator was not connected.
4.

Click Filters.
The Additional Event Filters window appears.

Figure 226. Additional Event Filters

5.

Provide the following information if you want to narrow down the report
results.
Search in event description. Type the percent sign (%), then type the text
to search for in the event description. The report shows only events that
contain this text in the event description.
For example, to search for events that contain the facility code 1, type %1.
Search by card number. Type a card number to search for. The report
shows only events that contain this card number.
Search by access point. The report shows only events for this access
point.
Search by panel. The report shows only events for this panel.
Search by event type. The report shows only events for this event type.

6.

286

Click Show Report.
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13.2

Resident Report
You can generate a report of some or all of the residents.
To generate a report of the residents
1.

Click the Reports menu, then click Residents.
The Resident Report Options window appears.

Figure 227. Resident Report Options

2.

Provide information for the following:
Sort. Select up to 2 criteria to sort the report by.
For example, if you select Apt# in the Sort by menu and Name in the
And menu, then the report is sorted by apartment number, and for each
apartment, the residents are sorted by name (see Figure 228).
In the Order menu, select Reversed to sort the residents in the
opposite direction.
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Figure 228. Resident Report sorted by Apt# first and Name second

Filter. Select up to 3 criteria to filter by. The report shows only entries that
begin with the criteria that you select.
For example, to show only residents whose names begin with S, select
Name in the Filter by menu, then type S in the Value field.
To search for something within a name or number, use the percent
sign (%).
For example, to show residents who have S anywhere in their names and
who have 5 anywhere in their dial codes:

3.
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a.

Select Name in the Filter by menu, then type %S in the Value
field.

b.

Select Dial Code in the And menu, then type %5 in the Value
field.

Click Show Report.
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13.3

Access Cards
You can generate a report of some or all of the access cards.
To generate a report of the access cards
1.

Click the Reports menu, then click Access Cards.
The Access Card Report Options window appears.

Figure 229. Access Card Report Options

2.

Provide information for the following:
Sort. Select up to 2 criteria to sort the report by.
For example, if you select Facility Code in the Sort by menu and
Card Number in the And menu, then the report is sorted by facility
code, and for each facility code, the cards are sorted by card number (see
Figure 230).
In the Order menu, select Reversed to sort the cards in the opposite
direction.
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Figure 230. Access Card Report sorted by Facility Code first and
Card Number second

Filter. Select up to 3 criteria to filter by. The report shows only entries that
begin with the criteria that you select.
For example, to show only the cards whose facility codes begin with 1,
select Facility Code in the Filter by menu, and then type 1 in the
Value field.
To search for something within a name or number, use the percent
sign (%).
For example, to show cards that have 1 anywhere in their facility codes
and that have 2 anywhere in their card numbers:

3.
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a.

Select Facility Code in the Filter by menu, then type %1
in the Value field.

b.

Select Card Number in the And menu, then type %2 in the
Value field.

Click Show Report.
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13.4

Paper Directory
You can a paper directory that you can display on a panel (for instance TX3120C-A). The paper directory displays two pieces of information: the
resident’s name and the dial code. It can have 1, 2, or 3 columns per page.
To generate a paper directory
1.

Click the Reports menu, then click Paper Directory Report.
The Paper Directory Report Options window appears.

Figure 231. Paper Directory Report Options

2.

Provide information for the following:
Header Text. This text will appear at the top of the report.
Panel. Select the panel that will display this paper directory.
Sort Column. Select the column, either Name or Dial Code, to sort the
directory by.
Columns in Report. Select the number of columns. The report can have1,
2, or 3 columns per page.
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3.

Click Show Report.

Figure 232. Paper Directory in a 3-column layout

13.5

Save and Print the Report
To save the report
•

Click the disk menu and select Excel or Acrobat PDF file.

Figure 233. Report format
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To print the report
•

Click the printer icon.

Figure 234. Print the report

13.6

Other Options in the Report Window
Go to the first page.
Go the previous page.
Go to the next page.
Go to the last page.
Stop generating the report.
Refresh the report, if more events have
occurred since the report window was
opened.
Displays the report in print layout.
Displays the page setup window.
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14

Configurable Touch Screen
User Interface Elements

The following tables describe the user interface elements as shown in Figures 69,
73 and 74.
Table 3: Call Button

Element

Description

Call button border color

Call button border color

Call button color

Call button color

Call button font

Font used for call button

Call button font color

Font color used for call button

Call button shade

Call button shade

Table 4: Call Reception

Element

Description

Reception button border color

Call reception button border
color

Reception button color

Call reception button color

Reception button font color

Font color used for call
reception button

Reception button font

Font used for call reception
button

Reception button shade

Call reception button shade

Table 5: General

Element
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Description

Event screen back color

Background color of the event
screen that appears when
calling a resident

Event screen button color

Color of the button on the
event screen that appears
when calling a resident
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Table 5: General (Continued)

Element

Description

Event screen font color

Color of the font that is used
in the event screen that
appears when calling a
resident

Event screen font

Font that is used in the event
screen that appears when
calling a resident

Invalid name/dial code back color

Background color of the box
that appears when an invalid
resident name or dial code is
entered

Invalid name/dial code font color

Color of the font used for the
box that appears when an
invalid resident name or dial
code is entered

Invalid name/dial code font

Font used for the box that
appears when an invalid
resident name or dial code is
entered

Keyboard back color

Background color of the
keyboard

Main screen back color

Background color of the main
screen

Table 6: Help Button

Element

Description

Help button border color

Help / Information button
border color

Help button color

Help / Information button
color

Help button font color

Font color used for help /
information button

Help button font

Font used for help /
information button

Help button shade

Help / Information button
shade
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Table 7: Keyboard Buttons

Element

Description

Letter button border color

Border color of all keyboard
letter (alphabetic) buttons

Letter button color

Color of all keyboard letter
(alphabetic) buttons

Letter button font

Font used for all keyboard
letter (alphabetic) buttons

Letter button shade

Button shade of all keyboard
letter (alphabetic) buttons

Num button border color

Border color of all keyboard
numeric buttons

Num button color

Color of all keyboard numeric
buttons

Num button font color

Font color used for all
keyboard numeric buttons

Num button font

Font used for all keyboard
numeric buttons

Num button shade

Button shade of all keyboard
numeric buttons

Letter button font color

Font color used for all
keyboard letter (alphabetic)
buttons

Table 8: Leave Message Button

Element
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Description

Msg. button border color

Leave message button border
color

Msg. button color

Leave message button color

Msg. button font color

Font color used for leave
message button

Msg. button font

Font used for leave message
button

Msg. button shade

Leave message button shade
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Table 9: Miscellaneous

Element

Description

Clock hour color

Color of the hour hand for the
analogue clock

Clock minute color

Color of the minute hand for
the analogue clock

Clock sec. color

Color of the second hand for
the analogue clock

Clock ticks color

Color of the ticks for the
analogue clock

Date font color

Color of the date font

Date font

Font used for the date label

Dial code font color

Font color used for dial code
label found in the resident
detail box

Dial code font

Font used for dial code label
found in the resident detail
box

Info box border color

Border color used for the title
of the information box

Info box font color

Font color used for the title of
the information box

Info box font

Font used for the title of the
information box

Res. box border color

Border color used for the
resident directory box,

Res. box font color

Font color used for the title of
the resident directory box

Res. detail box font

Font used for the title of the
resident detail box

Res. detail box border color

Border color used for the
resident detail box

Res. detail box color

Font color used for the title of
the resident detail box

Search box color

Search text box background
color

Search box font color

Search text box font color

Search box font

Search text box font
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Table 10: Resident Group

Element

Description

Group button border color

Border color of the group
button

Group button color

Color of the group button

Group button font

Font used in the group button

Group button font color

Color of font used in the
group button

Group button selected color

Color of button when selected

Table 11: Residents

Element
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Description

Alternate highlight color

Color of alternate rows when
selected

Back color

Background color
(Recommended: Use same
as Main Screen background
color)

Column size

Size of dial code column (The
resident name column is
adjusted automatically)

Column title back color

Background color of the
column title

Column title font color

Color of the font used in
column title

Column title font

Font used for the column title

Column title text align

Text alignment of the column
title

Font color

Color of font used for resident
names and dial codes

Font

Font used for resident names
and dial codes

Grid color

Color of grid lines separating
rows and columns

Highlight color

Color of row when selected

Highlight font color

Color of font used for resident
name and dial code when
selected
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Table 11: Residents (Continued)

Element

Description

Row size

Size of rows that hold
resident names and dial
codes

Text alignment

Text alignment for resident
names and dial codes

Alternate highlight color

Color of alternate rows when
selected

Table 12: Scroll Up Down Buttons

Element

Description

Scroll border color

Border color for scroll up and
down buttons

Scroll button color

Button color for scroll up and
down buttons

Scroll button shade

Button shade for scroll up and
down buttons

Table 13: Show Flash Button

Element

Description

Flash button border color

Show flash banner button
border color

Flash button color

Show flash banner button
color

Flash button font color

Font color used for show flash
banner button

Flash button font

Font used for show flash
banner button

Flash button shade

Show flash banner button
shade
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Warranty and Warning
Information

WARNING!
Please read this document CAREFULLY, as it contains important warnings,
life-safety, and practical information about all products manufactured by the
Mircom Group of Companies, including Mircom and Secutron branded
products, which shall include without limitation all fire alarm, nurse call,
building automation and access control and card access products (hereinafter
individually or collectively, as applicable, referred to as “Mircom System”).

NOTE TO ALL READERS:
1.

Nature of Warnings. The within warnings are communicated to the
reader out of an abundance of caution and create no legal obligation for
Mircom Group of Companies, whatsoever. Without limiting the
generality of the foregoing, this document shall NOT be construed as in
any way altering the rights and obligations of the parties, governed by the
legal documents that apply in any given circumstance.

2.

Application. The warnings contained in this document apply to all
Mircom System and shall be read in conjunction with:

4.
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a.

the product manual for the specific Mircom System that applies
in given circumstances;

b.

legal documents that apply to the purchase and sale of a Mircom
System, which may include the company’s standard terms and
conditions and warranty statements;

c.

other information about the Mircom System or the parties’ rights
and obligations as may be application to a given circumstance.

Security and Insurance. Regardless of its capabilities, no Mircom
System is a substitute for property or life insurance. Nor is the system a
substitute for property owners, renters, or other occupants to act prudently
to prevent or minimize the harmful effects of an emergency situation.
Building automation systems produced by the Mircom Group of
Companies are not to be used as a fire, alarm, or life-safety system.
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NOTE TO INSTALLERS:
All Mircom Systems have been carefully designed to be as effective as possible.
However, there are circumstances where they may not provide protection. Some
reasons for system failure include the following. As the only individual in
contact with system users, please bring each item in this warning to the attention
of the users of this Mircom System. Failure to properly inform system end-users
of the circumstances in which the system might fail may result in over-reliance
upon the system. As a result, it is imperative that you properly inform each
customer for whom you install the system of the possible forms of failure:
5.

Inadequate Installation. All Mircom Systems must be installed in
accordance with all the applicable codes and standards in order to provide
adequate protection. National standards require an inspection and
approval to be conducted by the local authority having jurisdiction
following the initial installation of the system and following any changes
to the system. Such inspections ensure installation has been carried out
properly.

6.

Inadequate Testing. Most problems that would prevent an alarm a
Mircom System from operating as intended can be discovered by regular
testing and maintenance. The complete system should be tested by the
local authority having jurisdiction immediately after a fire, storm,
earthquake, accident, or any kind of construction activity inside or outside
the premises. The testing should include all sensing devices, keypads,
consoles, alarm indicating devices and any other operational devices that
are part of the system.

NOTE TO USERS:
All Mircom Systems have been carefully designed to be as effective as possible.
However, there are circumstances where they may not provide protection. Some
reasons for system failure include the following. The end user can minimize the
occurrence of any of the following by proper training, testing and maintenance of
the Mircom Systems:
7.

Inadequate Testing and Maintenance. It is imperative that the systems
be periodically tested and subjected to preventative maintenance. Best
practices and local authority having jurisdiction determine the frequency
and type of testing that is required at a minimum. Mircom System may not
function properly, and the occurrence of other system failures identified
below may not be minimized, if the periodic testing and maintenance of
Mircom Systems is not completed with diligence and as required.

8.

Improper Operation. It is important that all system users be trained in
the correct operation of the alarm system and that they know how to
respond when the system indicates an alarm. A Mircom System may not
function as intended during an emergency situation where the user is
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unable to operate a panic or emergency switch by reason of permanent or
temporary physical disability, inability to reach the device in time,
unfamiliarity with the correct operation, or related circumstances.
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9.

Insufficient Time. There may be circumstances when a Mircom System
will operate as intended, yet the occupants will not be protected from the
emergency due to their inability to respond to the warnings in a timely
manner. If the system is monitored, the response may not occur in time
enough to protect the occupants or their belongings.

10.

Carelessness or Safety Hazards. Moreover, smoke detectors may not
provide timely warning of fires caused by carelessness or safety hazards
such as smoking in bed, violent explosions, escaping gas, improper
storage of flammable materials, overloaded electrical circuits or children
playing with matches or arson.

11.

Power Failure. Some Mircom System components require adequate
electrical power supply to operate. Examples include: smoke detectors,
beacons, HVAC, and lighting controllers. If a device operates only by AC
power, any interruption, however brief, will render that device inoperative
while it does not have power. Power interruptions of any length are often
accompanied by voltage fluctuations which may damage Mircom
Systems or other electronic equipment. After a power interruption has
occurred, immediately conduct a complete system test to ensure that the
system operates as intended.

12.

Battery Failure. If the Mircom System or any device connected to the
system operates from batteries it is possible for the batteries to fail. Even
if the batteries have not failed, they must be fully charged, in good
condition, and installed correctly. Some Mircom Systems use replaceable
batteries, which have a limited life-span. The expected battery life is
variable and in part dependent on the device environment, usage and type.
Ambient conditions such as high humidity, high or low temperatures, or
large temperature fluctuations may reduce the expected battery life.
Moreover, some Mircom Systems do not have a battery monitor that
would alert the user in the event that the battery is nearing its end of life.
Regular testing and replacements are vital for ensuring that the batteries
function as expected, whether or not a device has a low-battery monitor.

13.

Physical Obstructions. Motion sensors that are part of a Mircom System
must be kept clear of any obstacles which impede the sensors’ ability to
detect movement. Signals being communicated by a Mircom System may
not reach the receiver if an item (such as metal, water, or concrete) is
placed on or near the radio path. Deliberate jamming or other inadvertent
radio signal interference can also negatively affect system operation.

14.

Wireless Devices Placement Proximity. Moreover all wireless devices
must be a minimum and maximum distance away from large metal
objects, such as refrigerators. You are required to consult the specific
Mircom System manual and application guide for any maximum
distances required between devices and suggested placement of wireless
devices for optimal functioning.
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15.

Failure to Trigger Sensors. Moreover, Mircom Systems may fail to
operate as intended if motion, heat, or smoke sensors are not triggered.
a.

Sensors in a fire system may fail to be triggered when the fire is
in a chimney, walls, roof, or on the other side of closed doors.
Smoke and heat detectors may not detect smoke or heat from fires
on another level of the residence or building. In this situation the
control panel may not alert occupants of a fire.

b.

Sensors in a nurse call system may fail to be triggered when
movement is occurring outside of the motion sensors’ range. For
example, if movement is occurring on the other side of closed
doors or on another level of the residence or building the motion
detector may not be triggered. In this situation the central
controller may not register an alarm signal.

3.

Interference with Audible Notification Appliances. Audible
notification appliances may be interfered with by other noise sources such
as stereos, radios, televisions, air conditioners, appliances, or passing
traffic. Audible notification appliances, however loud, may not be heard
by a hearing-impaired person.

4.

Other Impairments. Alarm notification appliances such as sirens, bells,
horns, or strobes may not warn or waken a sleeping occupant if there is an
intervening wall or door. It is less likely that the occupants will be alerted
or awakened when notification appliances are located on a different level
of the residence or premise.

5.

Software Malfunction. Most Mircom Systems contain software. No
warranties are provided as to the software components of any products or
stand-alone software products within a Mircom System. For a full
statement of the warranties and exclusions and limitations of liability
please refer to the company’s standard Terms and Conditions and
Warranties.

6.

Telephone Lines Malfunction. Telephone service can cause system
failure where telephone lines are relied upon by a Mircom System. Alarms
and information coming from a Mircom System may not be transmitted if
a phone line is out of service or busy for a certain period of time. Alarms
and information may not be transmitted where telephone lines have been
compromised by criminal tampering, local construction, storms or
earthquakes.

7.

Component Failure. Although every effort has been made to make this
Mircom System as reliable as possible, the system may fail to function as
intended due to the failure of a component.

8.

Integrated Products. Mircom System might not function as intended if
it is connected to a non-Mircom product or to a Mircom product that is
deemed non-compatible with a particular Mircom System. A list of
compatible products can be requested and obtained.
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Warranty
Purchase of all Mircom products is governed by:
https://www.mircom.com/product-warranty
https://www.mircom.com/purchase-terms-and-conditions
https://www.mircom.com/software-license-terms-and-conditions
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